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1Welcome to EverWeb

Welcome to EverWeb! 

In this chapter we introduce you to EverWeb and how to 
purchase the right product to suit your needs.

Welcome

New In This EverWeb User Manual

EverWeb Software Only

EverWeb+Hosting

EverWeb Site Shield Addon

Contact Forms Enhanced Addon

EverWeb SEO Power Up

EverWeb Membership Sites

Custom Designed Professional Website

Purchasing EverWeb
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Welcome To EverWeb! 

EverWeb is a complete drag and drop website building tool, letting you create 
professional, fast loading websites without any technical knowledge or coding 
skills. 

EverWeb not only makes it easy to create a website, but it also allows you to 
enhance your website with advanced widgets. You can use a widget to add E-
commerce features, Google Maps, Contact Forms, Facebook Like buttons and 
much more. 

EverWeb includes one click publishing to get your website online as fast as 
possible. 

To find out what’s new in this release of EverWeb, just use the Help-> New 
Features Tour… menu option! 

www.everwebapp.com	 ￼  of ￼11 322

Figure 1.1: EverWeb’s User Interface is clean and simple, taking advantage of your computer’s macOS 
features. In the foreground, EverWeb’s User Interface for macOS Big Sur or later. In the background, 

EverWeb’s User Interface if you are running a macOS version prior to Big Sur.
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New In The EverWeb 4.3 User Manual… 
The EverWeb version 4.3 User Manual has been updated to includes the 
following new, and updated features,.  

• [NEW] EverWeb for Mac is certified for use with macOS Sequoia 
(macOS 15.) 

• [NEW] You can choose to use mini layout buttons in EverWeb-> 
Settings-> General in EverWeb. 

• [NEW] Justify Text option in the Text Inspector. 

• [NEW] Option to Block AI Bots in the -> File, Edit Publishing Settings 
menu option. 

• [NEW] Customization options are available for the Block AI Bots feature. 

• [NEW] You can now drag and drop stock photos to Inspector-> Shape 
Options-> Slide Show. 

• [NEW] New option under Inspector->Text -> Export Options -> 
Scrollable Text will  now export a TextBox that can scroll the text rather 
than auto size to the length of the text. 
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EverWeb for macOS and Windows 
EverWeb is available for use on both Microsoft Windows and Apple macOS 
Operating Systems. The following Operating Systems are supported: 

• EverWeb for macOS supports MacOS 10.13 (High Sierra) or later.  

• For macOS 10.10-10.12 users, EverWeb 3.4.2 is supported.  

• For macOS 10.7-10.9 users, EverWeb 2.9.1 is supported. 

• EverWeb for Windows supports Windows 10 and 11. 

This User Manual is for use with the latest version of EverWeb for macOS.  

If you are using an older version of EverWeb, some of the features described in 
this manual may not be available to you, or may be functionally different. 
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EverWeb Software Only & EverWeb + 
Hosting 
EverWeb runs natively on Apple Silicon Macs, Apple Intel Macs and PC’s 
running supported versions of Microsoft Windows. EverWeb is is available as 
either: 

EverWeb Software Only (Standalone) or 

EverWeb Software + Hosting 

Important! 
EverWeb is NOT a subscription service. 

No matter which version you choose to buy you will never lose access to the 
license you purchase, even if you do not renew your account. 
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EverWeb Software Only 
EverWeb Software Only includes EverWeb for macOS or Windows software 
and one year of product updates and support.  

If you do not wish to purchase another year of upgrades and support, you can 
still use the version of EverWeb that you have already purchased. 

With EverWeb Software Only you will have to purchase web hosting separately. 

EverWeb Software only costs $89.95 per license. 

Multi-Platform License 
If you want to use EverWeb Software Only on both macOS and Windows, you 
can purchase a one time only $24.95 USD Multi-Platform License. To purchase 
your Multi-Platform License: 

1. Login to your EverWeb Client Area 

2. Go to Services-> My Services and select 'Manage Product' 

3. From the left hand side select 'Upgrade/Downgrade Options' 

4. Select the option for 'Windows' or 'Multi Platform License' 

5. Go to the EverWeb-> Settings menu option. Log out then log back in to 
your account, or just quit and re-launch EverWeb 
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EverWeb + Hosting - starting at $99.95 
USD/year 
EverWeb + Hosting includes both EverWeb for macOS and Windows. It also 
comes with the benefit of improved support and organization because 
everything related to your website goes through one company. EverWeb + 
Hosting also comes with these exclusive features: 

1. Lightning Publish: Publish up to 20x faster than with other web 
hosting providers 

2. Password protection of your entire, or parts, of your website 

3. 404 Page Not Found redirects so your visitors won’t see 404 error 
pages if they visit an outdated link 

4. 301 redirects to redirect old web pages to your new EverWeb website 
and retain your search engine rankings 

5. Free software updates with an active account 

6. 24/7 Phone & Email Support with an active account 

7. Free Website Stats 

8. Faster Website previews and publishing 

9. One-Click SSL Certificate for HTTPS Secure URLs with EverWeb Site 
Shield (Free with an EverWeb + Hosting 10GB plan). 

10. Includes both macOS and Windows versions of EverWeb! 

The EverWeb + Hosting version also lets us more efficiently help you should 
problems arise because we have access to the server that your website is on. 
You only have to deal with one company for any of your website issues. 

EverWeb + Hosting starts at $99.95 USD / Year. 
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Purchasing EverWeb 
Quickly and easily purchase EverWeb by following the link below. Licenses are 
immediately delivered so there’s no wait in getting your website online! 

Purchase an EverWeb License 

You can also expand the capabilities of EverWeb even further with these great 
Addon Products and Services: 

• Site Shield Addon 

• Contact Forms Enhanced Addon 

• EverWeb SEO PowerUp 

• EverWeb Membership Sites 

• Custom Designed, Professional Website Service and  

• EverWeb Professional Coaching Services 
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EverWeb Site Shield Addon 

EverWeb Site Shield Addon helps protect your website and improves its 
ranking on Search Engine Results Pages (SERP). Google and other search 
engines give a SERP boost to websites that use HTTPS instead of just HTTP. 
Websites using HTTPS display a secure padlock symbol in the web browser’s 
path bar. 

Why HTTPS is Important 
Using HTTPS is important for your website as: 

• All data is ‘End to End’ encrypted from your visitors computer to your 
website 

• Your website is safer for your visitors 

• Your website’s credibility is improved with a "secure lock" notice 

• Google and other search engines place HTTPS websites higher in their 
rankings than HTTP websites 

Usually, changing your website from HTTP to HTTPS is a difficult process. 
However, EverWeb Site Shield Addon makes this change very easy - just tick 
one checkbox to change your website from HTTP to an HTTPS secure website! 

Your HTTPS website will be highly optimized for search engines and helps 
better protect your website visitors at the same time. 

You can further enhance your site’s security by using EverWeb Site Shield 
Addon’s Enhanced Security Settings. Make the time consuming, complex task 
of securing your website with advanced protection features a simple one with 
just a few mouse clicks! EverWeb’s Enhanced Security features include: 

• Preventing 3rd party sites from embedding your website.  

• Preventing content type interpretations. 

• Enabling XSS Protection.  

• Enabling Secure referrer policy. 
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Who Can Use EverWeb Site Shield? 
EverWeb Site Shield Addon is available to: 

• All EverWeb Users*.  

• Free if you have an EverWeb + Hosting 10GB or higher plan.  

• Available for just $39.95 USD / Year if you have an EverWeb + Hosting 
2GB plan. 

* Note: EverWeb Standalone users need to ensure that their Hosting Server has a valid SSL 
Certificate in order to use EverWeb Site Shield Addon. 

Adding EverWeb Site Shield Addon 
To add EverWeb Site Shield Addon follow these steps or click this direct link; 

1. Login to your Client Area 

2. Select ‘Services’ from the menu and click on ‘View Available Addons’ 
from the navigation bar 

3. You will see the available ‘Add Ons’ on the next page in the ‘Product 
Addons’ section of ‘Categories’. 

4. Select the ‘Addon’ and follow the purchasing steps. 

Enabling HTTPS Websites in EverWeb 
To use EverWeb Site Shield Addon for your website: 

1. Go to the Site Publishing Settings of your website project file using the 
File -> Edit Publishing Settings menu option. 

2. Tick the ‘Use HTTPS Secure URLs’ box. 

3. To enable EverWeb Site Shield Addon’s Advanced Security Settings, 
click on the ‘Advanced…’ button and tick the settings you want to use. 

4. Publish your website.  
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It is recommended that you publish your entire website (using the File -> 
Publish Entire Site menu option) so that all necessary link structures in your 
website are properly re-published. 
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Contact Forms Enhanced Addon 
EverWeb’s Contact Forms Enhanced is an addon for the Contact Form 
Advanced widget. Contact Forms Enhanced has the following features: 

• A login area to review all form submissions 

• Search and manage all form submissions online 

• Select the data you want to use quickly and easily 

• Export form submission data in CSV file format 

• Website visitors can upload files in Contact Forms to a safe, secure area 
in your Client Area 

• Download files that your visitors have sent you from your Contact 
Forms 

• Send mass, personalized emails to anyone who has submitted a form 
to you 

• New form controls including Date & Time, Dividers and Column 
controls 

The Contact Forms Enhanced Advantage 
You can use the Contact Forms Enhanced Addon to collect form submissions 
that can be used for creating email address lists for electronic newsletters, 
track responses to your events, promotions and surveys, keep your existing 
client base regularly updated with your current business activities and keep 
track of potential new customers.  

The Contact Forms Enhanced Addon can help you retain existing customers 
while growing your business with potential new customers. 

The Contact Forms Enhanced Addon makes it easy for you to download the 
data from your form submissions. In addition, you can also receive file uploads 
from your website visitors that you can then download from your EverWeb 
Client Area, safely and securely. 
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Purchasing Contact Forms Enhanced 
Addon 
You can purchase the Contact Forms Enhanced Addon safely and securely 
from our Secure Online Store. 

You can always upgrade/downgrade between packages if you need more, or 
less, form submissions or file upload space. 

Contact Forms Enhanced Addon Pricing 
Contact Forms Enhanced is available in the following configurations: 

1,000 Form Submissions + 1GB File Upload Space 

• Only $29.95 USD /Year 

• Only $54.95. USD / 2 Years (8% discount) 

• Only $79.95. USD / 3 Years (20% discount) 

10,000 Form Submissions + 10GB File Upload Space + Mass Emailing 

• Only $49.95 USD / Year 

• Only $94.95. USD / 2 Years (5% discount) 

• Only $139.95. USD / 3 Years (14% discount) 

100,000 Form Submissions + 50GB File Upload Space + Mass 
Emailing 

• Only $99.95 USD / Year 

• Only $189.95. USD / 2 Years (5% discount) 

• Only $279.95. USD / 3 Years (7% discount) 
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EverWeb SEO Power Up Addon 
EverWeb SEO Power Up Addon automatically optimizes your website for 
search engines and submits it Google, Yahoo, Bing and Alexa search engines.  

EverWeb SEO Power Up Addon: 

• Provides detailed and step by step recommendations for each page in 
your website with the ‘Check Page’ button then suggests how you can 
improve the web page’s search engine ranking 

• Optimizes your website for search engines 

• Enables GZip Compression on the server, for EverWeb+Hosting 
customers, so that you get faster loading websites 

• Automatically creates an XML Sitemap file which speeds up your web 
site's inclusion in search engines 

• Allows you to assign priority and frequency to your website’s pages 
according to the sitemap protocol 

• Automatically creates the robots.txt file 

• Submits your site to Google, Yahoo, Bing and Alexa notifying them of 
the updated site each time you publish something new. 

EverWeb SEO Power Up Addon is: 

• Available to all EverWeb customers, whether you host with us or with 
your own hosting provider 

• EverWeb SEO Power Up is FREE if you have an EverWeb + Hosting 
10GB or higher plan 

• Available for just $29.95 USD / Year if you have an EverWeb + Hosting 
2GB plan or EverWeb Standalone 

You can purchase EverWeb SEO Power Up Addon safely and securely from our 
Secure Online Store. 

www.everwebapp.com	 ￼  of ￼25 322

https://billing.ragesw.com/link.php?id=74
http://www.everwebapp.com


EverWeb User Manual	 Welcome To EverWeb

EverWeb Membership Sites 
The easiest way to monetize your website and create a membership, or 
subscription section in your website is by using EverWeb Membership Sites.  

You can build a Membership Site for FREE on either Windows or macOS. You 
do not need to host with EverWeb either to build the membership site you 
always wanted! 

A Membership Site lets you password protect your website content and allows 
your visitors to subscribe to your website content with ease. Membership sites 
take care of payments, member management, secure areas on your site and 
more. 

It is easy to add a robust Membership section to your website, complete with 
member sign ups, profiles, restricted content and more.  

Why EverWeb Membership Sites? 
Using the EverWeb Membership Sites gives you a way to easily build a front 
end membership site within EverWeb itself. That means your visitors can 
subscribe, log in and access restricted areas of your website. 

At the backend of the Membership Sites is a powerful, robust management 
and configuration system, where you can manage your subscribers from 
anywhere. 

EverWeb Membership Sites Levels 
There are three Membership Sites Levels available: 

• Membership Starter 

• Membership Plus 

• Membership Deluxe  
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For more detailed information, please refer to the chapter EverWeb 
Membership Sites. 
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Custom Designed, Professional 
Websites 
If you are having trouble designing your website, or want a custom designed, 
professional website designed for you, we can help! 

Get a professionally designed website that you have the ability to update and 
change whenever you need. 

We provide three levels of design services to fit your budget which include: 

1. Converting an existing website design to EverWeb 
This option is a low cost solution to take a pre-existing design and 
turning into an EverWeb website that you can then update and 
modify. 

2. Creating a completely unique, custom design that fits your needs 
This option is great if you need a low cost, professionally designed 
website that you can edit and modify in EverWeb and you already 
know what style you want. 

3. Providing a minimum of 10 unique website designs that you can 
choose from 
This option is great if you are not sure what you are currently looking 
for in your website design and want at least 10 unique designs to 
choose from. Once you choose a design we have created for you, we 
turn it into an EverWeb project you can then modify and enhance to 
your needs. 

Every package above comes with a professionally created EverWeb project file 
that you can then take and modify for yourself. 

For more details and pricing for these designs, please visit our custom design 
website or contact customer support for more details. 
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EverWeb Professional Coaching 
Services 
EverWeb is designed to be easy to learn and use, but if you ever want some 
coaching to learn more or tackle a problem you have with your design, we are 
here for you! 

EverWeb Coaching - 10 Minutes or 55 Minutes 

Get 1 on 1 live EverWeb coaching with our experts with a 10 minute or 55 
minute session. Multiple sessions can be ordered at once. 

Our Advanced Coaching offers enhanced help including website design 
assistance, Search Engine Optimization questions with a live, screen 
sharing session.  

EverWeb Priority Phone Support 
EverWeb Priority Phone Support is available for EverWeb Standalone or 
Hosting subscribers who want priority phone support with our EverWeb 
experts. 

This is a yearly service that can be cancelled anytime but it ensures you can call 
our support specialists 24/7 while you have an active account. 

For more details and pricing for EverWeb Coaching and Priority Phone 
Support, please visit our Customer Support Options page or contact customer 
support directly. 
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More Information About EverWeb 
There are additional ways to find out more about EverWeb… 

The EverWeb Website 
Visit our website at www.everwebapp.com to find out general information 
about EverWeb, its features, pricing, support and third party resources. 

EverWeb Video Tutorials 
EverWeb includes hundreds of video tutorials on every aspect of its features 
and how to use them in your website. To access EverWeb video tutorials either: 

• Use the ‘Learn how to use EverWeb’ button on the Projects Window 

• Use the Help-> Video Tutorials menu 

• Click on the Video Help ‘?’ button next to the EverWeb feature in the 
product itself 

• Go to the 

•  EverWeb YouTube channel 

If You Have a Question… 
If you cannot find the help you need, or have a question about EverWeb that is 
not covered in this manual or the video tutorials, please use one of the 
following resources: 

• The EverWeb Knowledgeable at http://billing.ragesw.com/
knowledgebase.php 

• The EverWeb Discussion Forum at http://billing.ragesw.com/forum.php 

If you have a valid support plan you can also call, email or chat with an 
EverWeb Expert, live, 24 hours a day, seven days a week, 365 days a year at; 

North America: 1-888-500-2901 
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Europe: +44 808 164 0982 
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2Getting Started

In this chapter you will learn about the Projects Window, 
create your first website project and find out how to get 
help at any time if you need it.

The Projects Window

Creating a New Website Project

Selecting Your Website Project Page Style

Creating Your First Page

Getting Help
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Getting Started 
The Projects Window 

The Projects Window is the first screen you see when you launch EverWeb (see 
Figure 2.1). The Projects Window is where you: 

• Create new website projects 

• Open an existing website project by double clicking on its name in the 
Recent Projects list or by using the File-> Open or File-> Open Recent… 
command. 

• Perform administration tasks relating to your website project files. 

To access the Projects Window when you are in a project, just use the File-> 
Projects Window... menu command. 
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Creating a New Website Project 
You can use the Projects Window to create a new website. The Projects 
Window has two buttons on left hand side (see Figure 2.1): 

• ‘Create a new website’: Click this button to create a new website 
project in EverWeb; 

• ‘Learn How to use EverWeb’: Takes you to the EverWeb Video Tutorial 
Library. 

The right hand side of the Projects Window lists the website project(s) you 
have already created in the ‘Recent Projects’ list. If you do not have any saved 
projects, this list will be empty. For now, double click on the ‘Create a new 
website’ button to create a new EverWeb Project file. 

Creating Your First Page 
When you create a new website project, the first page of the project is created 
at the same time. Whenever you add new pages (or directories) to your project, 
the Theme Template Chooser will appear (See Figure 2.2). 

Selecting Your Website Project Page Style 
EverWeb’s Theme Template Chooser lets you add pages to your website 
project that are either:  

• Fixed Width or 

• Responsive 

A Fixed Width website design is one where the width of the web page is fixed 
at a specific value. Desktop and tablets typically use a page width of about 
1000 pixels, whilst mobile devices typically use a page width of about 320 
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pixels. Therefore you will need to design one page for desktop/tablet devices, 
and a corresponding page for mobile devices. 

A Responsive page layout automatically adjusts the page width to that of the 
device it is being browsed upon. As the page design automatically scales to 
suit the device it is being used upon, only one web page design is needed. 

There are advantages and disadvantages to either style and these are 
discussed in the Responsive Websites in EverWeb chapter. 

This manual explores EverWeb’s features using a Fixed Width website layout as 
it makes exploring EverWeb’s features and web design concepts easier if you 
are new to EverWeb. The features explored in the following chapters can also 
be used in responsive website designs, except where noted.. 

For more information about creating responsive websites in EverWeb please 
refer to the chapter Responsive Websites in EverWeb.. 
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Selecting a Theme Template and Page Style 

EverWeb’s Theme Template Chooser lets you select the style of your website 
project from over 200 professionally designed Theme Templates. Themes are 
listed in the left hand column with their corresponding page styles displayed 
on the right.  

To add a new page to your Project file: 

1. If this is the first page you are adding to your Project file, go to the next 
step. If you already have one, or more, pages in your Project and want 
to add a new page, click on the Add Page button in the Toolbar. 

2. You can filter the type of Theme Template that you want to see using 
the ‘Filter’ drop down menu in the top left corner of the Theme 
Template Chooser (see Figure 2.3 above). You can select to view either 
Fixed Width, Responsive, New or All of the themes.  

3. Scroll down the list of themes in the left hand column and click on the 
theme that you want to use.  
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4. If you already know the name of the Theme Template that you want to 
use, just start typing its name e.g. ‘Wedding’. Alternatively use the 
search box at the bottom of the list of Theme Templates. As you type, 
EverWeb will use predictive search to take you to the theme as you 
type. 

5. If building your website from scratch, use the Blank Theme Template 
for Fixed Width websites. This is the first theme in the list. Use the 
Blank Responsive Theme Template for blank responsive page styles. 

6. When you click on the Theme Template to select it, the right hand side 
of the Theme Template Chooser will display the page styles associated 
with the theme. 

7. Click on the page style you want, then click on the ‘Select’ button.  

8. The Theme Template will be downloaded to your computer if it is the 
first time that you have selected the theme.  

9. Some Theme Templates use Google Fonts e.g. the ‘Apollo’ theme. 
When the Theme Template downloads, you will be asked if you want to 
use the Google Font(s) that belong to the theme. It is recommended 
to do so. 

10. Your new page will be added to the website project and displayed on 
screen. The page is also added to the list of pages in the Web Page List. 

Adding New Theme Templates 
New Theme Templates are regularly added to EverWeb. To check if any new 
Theme Templates are available use the EverWeb -> Check for New Templates 
menu option.  

Alternatively, when you add a page to your project file, you can use the ‘Check 
for New Templates…’ button in the top right hand corner of the Theme 
Template Chooser (see Figure 2.3).  

EverWeb will check for new Theme Templates to install. A dialog box will 
appear listing any new Theme Templates that are available (see Figure 2.4). By 
default, all new Theme Templates are checked for downloading. Uncheck the 
box to the left of any Theme Template that you do not want to download. Use 
the Settings Cog/Button to select ‘All’ available Theme Templates or select 
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‘None’ to deselect all Theme Templates. To help refine your download selection, 
use the ‘Preview’ button view a preview of the Theme Template’s Home page.  

When you have chosen your Theme Templates to download, press the 
‘Download’ button. Note that if you have a large number of Theme Templates 
to download, the process may take some time to complete. 

Any new Theme Templates added to EverWeb since the last update are 
marked with a ‘New’ indicator in the Theme Templates list (see Figure 2.2). 

Congratulations! You have now created your website project file and its first 
page! 
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Setting Up Default Styles 
Once you have created the first page of your website, it’s then a good time to 
set up some defaults for your website project file. Setting up defaults before 
you embark on creating your website has the advantage that if you want to 
make changes to your site later on, it will be easier to do. Setting up defaults 
also means that you will be working more effectively on your website. 

Default Styles… 
Use the Format-> Default Styles… menu option to setup the default fonts and 
colors you want to use for your website project and the fonts that you would 
like displayed in the Styled Text Editor.  
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You can set up predefined styles and colors for use in your site. If you change a 
predefined style later on, your whole website will automatically update with 
the change. 

Default Styles is also where you set up the fonts that you want to substitute if 
the font you have chosen for your website is not available on your visitor’s 
browser. 

Default Settings 
The Default Settings section is where you define the following: 

Default Body Text Font, Font Size and Color: Use these settings to define the 
body text styling of your website. The updated settings will be applied to any 
new TextBoxes that you create. To change the settings, just click on the setting 
you want to change. 

Link Colors and Underlines: You can set up default color and underling options 
for Hyperlinks using the Link Color and Link Underline settings. Choose the 
settings that you want for each hyperlink state: Normal, Mouse Over and 
Visited.  

Shape Color and Shape Stroke Color: Use these settings to change the default 
color, and shape border color, when you create a new shape using the Shapes 
button in the Toolbar or the Insert-> Shapes… menu option. 

Preferred Fonts:  
This is a list of the fonts that you see in the dropdown menu of the Styled Text 
Editor. You can add the fonts that you want to use in your website by selecting 
the font family and font style from the dropdown menu, then clicking on the 
‘Add’ button.  

To remove a font from the Preferred Fonts list, click on the font in the list your 
want to remove then press the backspace key. You can also change the order 
of the listed fonts just by dragging the font you want to move to its new 
location then dropping it in place. 
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Document Colors 
The default colors section defines the colors that you want to use in your 
website. Document colors appear when you click on a color swatch e.g. when 
you select a background color for a page, or when selecting a color for your 
text. 

You can change the default color swatch colors in the Document Colors 
section of Default Styles by clicking on the colour you want to change then 
using the color picker to alter the color. 

If you have already used a document color in your website and then change 
the color the Document Colors section of Default Styles, the change will 
update the color wherever it is used in your website.  

Paragraph Styles 
The Paragraph Styles section is where you create, manage and delete the 
Paragraph Styles used in your website.  

For more information about using Paragraph Styles in your website, please 
refer to Paragraph Styles in the Text Inspector section of this manual. 

Creating a Paragraph Style 

Click on the ‘+’ icon below the Paragraph Styles to create a new style. Enter the 
name that you want to call the Paragraph Style then press Enter to finish.  

As the Paragraph Style is still selected, you can now change the features of the 
style using the options immediately to the right of the Paragraph Styles. You 
can also apply backup fonts to your Paragraph Style so that if your visitor’s 
browser cannot display the Paragraph Styles font, it will use a substitute of your 
choosing. 

Changing a Paragraph Style 

To change a Paragraph Style, simply click on the Paragraph Style you want to 
change and use the options to the right of the Paragraph Styles.  
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Renaming a Paragraph Style 

To rename a paragraph style, double click on the name you want to change in 
the Paragraph Styles list, enter the new name then press Enter to finish. 

Deleting a Paragraph Style 

To delete a Paragraph Style, highlight the Paragraph Style you want to remove 
then press the ‘-‘ button. When you do this, EverWeb will ask you to substitute 
another Paragraph Style in its place. 

Saving Your Changes 
Once you have made the changes you want to make to your Default Styles, 
click on the ‘Save’ button to save your changes. This will also then update your 
website with your changes where appropriate. 
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Getting Help 
Help is available at any time in EverWeb.  

Video Tutorials 
To access EverWeb video tutorials either use the ‘Learn how to use EverWeb’ 
button on the Projects Window, or the Help-> Video Tutorials menu.  

Video tutorials relating to specific EverWeb features are shown by the 
Video Help ‘?’ button next to the feature. Click on the button to access 
the feature you want help with. 

EverWeb User Manual 
To access the User Manual at any time, click on the ‘EverWeb Manual’ link in 
the Projects Window, or use the Help-> EverWeb Manual menu option. 

Knowledgeable & Discussion Forum 
If you cannot find the help you need, or have a question about EverWeb that is 
not covered in this manual or the video tutorials, please use one of the 
following resources: 

• The EverWeb website at www.everwebapp.com. 

• The EverWeb Knowledgeable at http://billing.ragesw.com/
knowledgebase.php 

• The EverWeb Discussion Forum at http://billing.ragesw.com/forum.php 

Phone & Email Support 
If you have a valid support plan you can also call, email or chat with an 
EverWeb Expert, live, 24 hours a day, seven days a week, 365 days a year at 

North America: 1-888-500-2901 

Europe: +44 808 164 0982  
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3The EverWeb User 
Interface

In this chapter you will find out all about the Project 
Window which has four sections that make up EverWeb’s 
User Interface.

The EverWeb User Interface
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The EverWeb User Interface 

In Chapter 2 we showed you how to create your first project file and the first 
page of your website. 

Before starting to build your website, it is important to become familiar with 
EverWeb’s User Interface, known as the Project Window (see Figure 3.1) which 
should not be confused with the Projects Window (Figure 2.1 above). 
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There are four main areas of the Project Window: 

• The Web Page List (see Figure 3.1 - Section A), is where all of your 
website's pages are listed. You can adjust the width of this area by 
hovering your cursor over the divider, and then clicking and dragging 
to the left or right. 

• The Toolbar (see Figure 3.1 - Section B) at the top of the Project 
Window allows you to quickly access to often performed tasks such as 
adding a new page, shape, or TextBox to the Editor Window. 

• The Inspector Window (see Figure 3.1 - Section C) on the right hand 
side of the Project Window consists of three tabs containing all of the 
features to modifying elements of your website: 

• The Inspector tab shown in Figure 3.1 allows you to control Page 
Settings, Shape Options, Object Metrics, Text properties, 
Hyperlinks and Widget Settings. 

• The Assets tab is used for managing your website's images and 
media files. 

• The Widgets tab contains mini apps known as ‘Widgets’ for easily 
adding extra features you may want to your website.  

• The Editor Window (see Figure 3.1 - Section D) is the area in the middle 
which is your design canvas where you create or modify your web 
pages. 
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4The Editor Window

This chapter explores the Editor Window which is your work 
canvas, and how you add, edit and delete objects on your 
page.

The Page Layout

Adding Objects To The Editor Window

Moving Objects

Aligning and Distributing Objects

Finding the Distance Between Objects

Deleting Objects
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The Editor Window 
The Page Layout 
You can design your entire website just by dragging and dropping text, 
images, shapes, audio, video and widgets on to its design canvas which is 
known as the Editor Window. 

The Editor Window works in the same way regardless of whether you are 
designing a regular page or a Master page. 

The text, images, media, widgets and other content that you add to your page 
are known as objects, and we will explain how you can manipulate them later 
on in the chapter.  

First, let’s look at the Editor Window which has the following main sections: 

• The Header (Fixed Width layouts only) 

• The main body (content) area 

• The Footer. 

The sections of a page are much like those in a book. The Header usually 
contains relatively static content that you always want displayed at the top of 
most, if not all, of your pages, for example a company logo, social media icons 
and a navigation menu.  

Note: Responsive websites do not have a Header section but Fixed Width page layouts 
do. 

The main body, or content area, is where you place objects specific to the page 
itself e.g. on an ‘About Us’ page, you might include text about your company’s 
mission statement, a company video, image slideshow etc. 

The Footer is like the Header in that it usually contains relatively static content. 
However, Footer content often provides your visitor with further help such as a 
directory of the contents of your website, social media buttons and contact 
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information. The Footer is also, for example, where copyright information and 
any legally required text is often placed. 

By default, the page layout of the Editor Window shows each section with blue 
borders separating each section. You can toggle the page layout display on or 
off using the Window ->Show Layout menu option.  

The default height of the Header, main body and Footer are set in the Page 
Layout section of the Page Settings tab of the Inspector tab (see Figure 3.1 - 
Section C). When you add objects in to a section, the height of the section will 
automatically adjust as necessary to accommodate the object.  

This approach allows you to design each section of your page while making 
sure enough room is provided for the Header, content and Footer. It also 
means that you do not have to rearrange objects every time you want to 
modify a section.  

If the content of your Header and/or Footer will be the same on many, or all, of 
your pages consider using a Master Page instead. , 

Note: The remainder of this chapter explains how to work with objects in the Editor Window. 
Objects in Responsive websites are manipulated differently due to the nature of responsive 
design. Please refer to the Chapter Responsive Websites in EverWeb for more information. 
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Adding Objects To The Editor Window 
You can start working on your web page by, for example, adding a TextBox or 
Shape from the Toolbar. We will discuss other objects such as images and 
other media in later chapters.  

The TextBox or shape will be created in the main body of the Editor Window. 
You can move the object to another location in the main body area by clicking 
and dragging it to where you want to place it, then releasing the mouse 
button. 

As you move the object around the main body area, notice that it may bump 
up against the bottom of the header area and that when you move the object 
the area towards the footer, the main body area’s height automatically adjusts 
the main body space to accommodate. 

Adding Objects To The Editor Window From Other 
Projects 
If you have more than one EverWeb project file, you may want to copy objects 
from one to the other. To do this, select the object you want then copy it to the 
Clipboard. Next, go to the page in your target project where you want the 
copied object to be placed. Paste the object in from the Clipboard.  

Selecting and Resizing Objects 
When you click on an object, such as a TextBox, shape or image, you will see 
that it will have an outline around it with small square boxes at each corner 
and at the center of each edge. These squares are called selection, or grab, 
handles.  

As well as showing that the object is selected, you can use the grab handles to 
resize the object. Click and hold the mouse pointer on the grab handle you 
want to use and then move the mouse cursor to increase or decrease the size 
of the object. 

www.everwebapp.com	 ￼  of ￼50 322

http://www.everwebapp.com


EverWeb User Manual	 The Editor Window

Moving Objects Between Editor Window Sections 
As you may have noticed, when moving an object around the Editor Window, 
you cannot move the object between sections. To move an object from one 
section to another, hold down the COMMAND key on your keyboard as you 
drag the object into another section. Release the COMMAND key when the 
object is in the next section. 

If you don’t want an object to be able to affect the height of a section go to 
Inspector->Metrics and select the ‘Allow free dragging’ option. Note that this 
option only applies to Fixed Width Page Layouts, such as the Center Aligned 
Page Layout. 

The object can now be dragged anywhere on the Editor Window without 
affecting the height of each section. 

Moving Objects Obscured by Other Objects 
As you design your web pages, you may sometimes have one or more objects 
overlapping other objects. To easily move an object that is covered without 
affecting covering objects: 

1. Select the object you want to move.  

2. If you have difficulty selecting the object you want, secondary click on 
the object that covers the object you want to select. 

3. A sub menu appears. Scroll down to the Pick Layer option. This will 
show you all of the objects that are positioned at the location you 
clicked on. 

4. Select the object you want from the list. Your object is now selected. 

5. Next, hold down the Command+Option keys and drag the object you 
want to its new location. 

Moving Objects Whilst Retaining the Page Layout 
There may be times where you want to insert an object, such as an image, in to 
your page but you need to create the space on the page in order to drop the 
image in place.  
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To make the space for your image on the page, you may need to move existing 
content down the page in order to drop the image in to the right place  

EverWeb allows you to easily move the objects below where you want the 
image down all at the same time, so preserving the page layout.  

1. Select the first object that is directly below where you want to insert 
the image. 

2. Hold the Shift+Command keys down and drag the object down the 
page. 

3. The selected object, and all objects below it, will move down the page 
at the same time preserving the page layout. 

4. Once you have created enough space, release the keys and mouse 
then drag and drop the image in to the space you have just created. 

If you use the Shift+Command keys whilst resizing an object, the objects below 
the selected object will move down. 

Aligning Objects 
When building your website, it is important to position text, shapes and 
images exactly where you want them to be. There are different ways in which 
you can position these ‘objects’. For example, to center an object on the page, 
first select the object. Next, go to the Arrange > Align Objects menu option and 
then select Center. The object is centered. 

Likewise, you can do the same if you want the object to be left aligned, or right 
aligned. You can also specify if you want the object to be placed at the top of 
the page, the bottom of the page, or directly in the middle of the page. 

Distributing Objects 
Let's say you have multiple objects beside one another and you want to space 
them evenly. Select all the objects either by using your mouse, or by selecting 
each object while holding down the Command key on your keyboard. Then go 
to Arrange > Distribute Objects > Horizontally. 

If the objects were placed vertically, repeat the above steps but but select 
‘Vertically’ instead. 
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Finding The Distance Between Objects 
When designing your web page, sometimes it is useful to find the distance 
between objects on the page. To do this 

1. Select the source object 

2. Hold the Option (Alt) key down. 

3. Mouse over the target object(s) to see the distance in pixels between it 
and the source object. 

Deleting an Object 
If you want to delete an object from the Editor Window, first select the object 
so that you see the grab handles around it, then press the backspace key on 
your keyboard to delete the selected object. 

If you have deleted the object by mistake, press Cmd+Z immediately to undo 
the deletion. 

Customizing The Editor Window 
The Editor Window’s appearance can be customized using the options on the 
Window menu. Hiding the Toolbar and/or the Inspector will give you more 
screen space for the Editor Window.  

Options specific to the Editor Window itself include Hide/Show Layout which 
toggles the display of the blue guide lines on and off.  

The Hide/Show Rulers option toggles the display of the Editor Window’s 
horizontal and vertical rulers guides (measured in pixels) on and off.  

Hide/Show Breakpoints toggles the display of the vertical line guides denoting 
the maximum width of mobile, tablet, desktop and large desktop on and off.  

The Hide/Show Hidden Objects toggles the display of objects that have been 
hidden using the Metrics Inspector on and off. 
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5The Web Page List

The Web Page List is where you organize your pages, It is 
also the place where you create Master Pages and 
Directories that can be used to create Navigation Menus. 

The Web Page List

Naming Your Project, Directories and Pages

Adding Pages and Directories to Your Website Project

Creating a Navigation Menu

Creating a Simple Navigation

Creating a Dropdown Navigation

Creating a Responsive Navigation

Formatting & Styling the Navigation
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The Web Page List 

On the left hand side of EverWeb’s User Interface, is the Web Page List where 
you will see the name of your website project and any directories and web 
pages you have created listed beneath it (Figure 5.1). 

Each page or directory you create has an icon next to it: 

• A white icon (or light grey icon if your computer is using Dark Mode) 
indicates that the page, or directory, has not been modified since the 
last time you published the site. 

• A red icon indicates that the page, or directory. has been modified since 
the last publish and will need to be published again for the changes to 
be reflected online. 

• A grey icon indicates that the page is in draft mode and so will not be 
published when the site is published. If the page has already been 
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Figure 5.1: The Web Page List is located on the left hand side of the application. A red icon indicates a modified 
page  whilst a grey icon indicates that no modifications to the page have been made.
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published, it will not be published again until you uncheck the ‘Do Not 
Publish’ option. 

Naming Your Website Project, Directories 
and Pages 
You can change the name of your website, its directories and web pages in a 
number of different ways: 

• Double clicking with Mouse or Trackpad 

Double click on the website name, directory or page name in the 
Web Page List. Edit the name and press enter to finish. You can 
also use double click to rename blog post names and assets in the 
Assets List. 

• Using The Menu Options 

You can use the File-> Rename Website menu option to rename 
your website. 

Use the File-> Rename menu option to rename the currently 
selected directory or web page. You can also use this menu option 
to rename assets and blog posts. 

• The Inspector Tab 

Web pages and directories can also be renamed by clicking on the 
Page Settings button in the Inspector tab, then changing the page 
name using the ‘File Name’ option. 
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Adding Pages To Your Website Project 

Duplicating Pages 
If you want to add a page that looks identical to one of your pages, secondary 
click on the page name in the Web Page List that you want to copy, and select 
‘Duplicate’ from the menu.  

Duplicating a page is essentially copying an entire page.  

If most of your pages are going to use a similar design, it’s best to use 
EverWeb’s Master Pages feature as this will save you time and effort. 

Deleting Pages 
To delete a page from your Project, select the page in the Web Page List then 
press the backspace key on your keyboard to delete the page.  

Alternatively, secondary click on the page name in the Web Page List. From 
the submenu select the ‘Delete Page’ option.  

In both cases you will be warned that you are about to delete the page before 
the deletion unless you have previously turned this warning message off. 

Note:You always have to have at least one page in your website project. If you only have 
one page in your website, you will not be able to delete it. To delete the page, you must 
add a second page before you can delete the first page. 
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Copying Pages Between Project Files 
EverWeb allows you to easily copy regular pages from one project file to 
another. Simply drag the page that you want to copy from the Web Page List 
of your source project file into the Web Page List of the target project file. You 
can also copy a regular page in to another project’s Master Page section. 

When copying pages, open both project files and place them side by side. In 
this way, it is easier to drag and drop the page you want from one to the other. 

Adding Directories To Your Website 
Project  

To add a new directory to the Web Page List: 

1. Click on the ‘Add Directory’ button in the Toolbar. 

2. Select the Theme Template you want to use from the left hand 
column. 

3. Select the page style you want to use from the right hand side of the 
Theme Template Chooser.  

4. Click ’Select’ to add the directory page to the Web Page List.. 

The new page has a folder (directory) icon instead of the page icon. 
Remember, the directory page is still a page on your site, so you can treat it like 
any other page. 

To add pages within the directory, select the directory in the Web Page List, 
and click on the ‘Add Page’ button. A page is created within the directory and 
is displayed below, and a little to the right of, the directory, 
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Directories are also used as the basis for Dropdown Navigation 
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Moving Pages In and Out of Directories 
To move a page into a directory, click and drag the page you want to move on 
the directory folder. When you see a line with circle at the left hand end 
positioned just below and to the right of the folder, drop the page in place. 

If the folder is closed, you will not see the page placed in the folder. To open 
the folder to see its contents, click on the arrow to the left of the folder name. 

When the folder is open you can move pages out of the folder. Just click and 
drag the page you want out of the folder and to its new location and drop in 
place. 

Using ‘Do Not Publish’ 
When creating the pages of your website, there may be times where you want 
to publish some, but not all, of your pages. In this case, you can use EverWeb’s 
‘Do Not Publish’ option to not publish particular pages in your website.  

To select this option, secondary, or right click on the page you do not want to 
publish in the Web Page List. From the dropdown menu, select the ‘Do Not 
Publish’ option. The page icon and page title color in the Web Page List will 
become grey.  

When you publish your website, any pages using the ‘Do Not Publish’ option 
will not be published. If you have already published a page before using the 
‘Do Not Publish’ option on that particular page, the page will remain but will 
not be republished until you toggle the ‘Do Not Publish’ option off. 

You can use ‘Do Not Publish’ on all pages except the home page of your 
website. In this case, ‘Do Not Publish’ is not available.  

To stop using ‘Do Not Publish’ simply secondary, or right click, on the page and 
toggle ‘Do Not Publish’ off. 

You can also find Do Not Publish at the bottom of the Advanced Options 
section of the Page Settings tab in the Inspector Window. 

Caution: Be careful when using ‘Do Not Publish’ on hyperlinked pages, or in 
widgets, such as the Navigation Menu Widget, as you will not want to link to a 
page you have not published yet. 
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Searching and Navigating the Web Page List 
You can easily search for a particular page in the Web Page List using the 
search box at the bottom of the Web Page List. This is useful when you have a 
project file containing a large number of pages. 

To the left of the Search box are ‘previous’ and ‘next’ arrows keys. Use these 
keys to go backwards and forwards through the pages that you have visited 
during your current EverWeb project file session. 
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Creating a Navigation Menu 
EverWeb’s Web Page List is used as the basis for your website’s Navigation 
Menu.  

The order of the pages in the Web Page List from top to the bottom 
determines the order that your Navigation Menu items are displayed from left 
to right. 

You have three different styles of Navigation Menu styles to choose from for 
your website: 

• A Simple Navigation Menu 

• A Dropdown Navigation Menu 

• A Responsive Navigation Menu 

Note: When we mention ‘Navigation Menu’ we are referring to EverWeb’s built in 
Navigation Menu widget. The Navigation Menu widget itself is discussed in detail later 
on. 

Only pages that have ‘include page in navigation menu’ ticked in the Page 
Settings of the Inspector Window are included in the Navigation Menu. 

Adding the Navigation Widget To Your Page 
To add the Navigation Menu widget to your page select the Widgets Tab and 
drag and drop the Navigation Menu widget on to the page. Usually the widget 
is placed in the Header section of your Master page. Please refer to the Master 
Pages section for more information about how to create ‘template’ Master 
Pages for your website. 
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Creating a Simple Navigation Menu 
When you add the Navigation Menu widget to your page you will see that it 
includes all the pages from the Web Page List that have ‘include page in 
navigation menu’ ticked. 

The above example is a Simple Navigation Menu as all the menu options are 
on one line only. As you can see, this menu style may have too many items in it 
to be easy for your visitors to use (see Figure 5.2).  

It may be better to simplify the Navigation Menu by structuring the menu so 
that it includes dropdown items instead. 
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Creating a Dropdown Navigation Menu 
A Dropdown Navigation style keeps the Navigation Menu easy for your visitors 
to navigate 

The directory structure is also used to generate dropdown Navigation Menus 
(see Figure 5.3). 

. 
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Figure 5.3: Dropdown navigation menu in EverWeb. The “For Sale”  & “For Rent” links are now in a dropdown menu.
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Creating a Responsive Navigation Menu 
Both Simple and Dropdown Navigation Menu 
styles can be incorporated in to a Responsive style 
Navigation Menu. 

A Responsive Navigation Menu will adapt to the 
width of the device you are using e.g on a desktop 
you may want to see a Simple or Dropdown 
Navigation Menu. On a mobile device where space 
is limited you may want to use a ‘Hamburger’ style 
Navigation Menu instead. 

To make your navigation responsive:  

1. Add the Navigation Menu widget to your 
page. 

2. With the widget selected, go to the 
Widget Settings tab in the Inspector 
Window. (see Figure 5.4) 

3. Scroll down to the Responsive Options 
section. 

4. Tick the box for ‘Responsive Navigation 
Bar’. 

Beneath the ‘Responsive Navigation Bar’ option is 
the ‘Appear at Width’ option which is set to 700 by 
default. When the screen width is less than 700 
pixels, the Navigation Menu will become a 
Hamburger style menu. 

You can test this out by resizing the width of the 
EverWeb application. Click and drag the right 
hand edges of the EverWeb UI to the left. At 700 
pixels wide, you will see the Navigation Menu 
change to a Hamburger style menu. 

Note: Responsive Navigation Menus can be used in 
both Fixed Width and Responsive website designs. 
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Responsive Options.
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Formatting The Navigation Menu 
By default, the Navigation Menu label for each page is its ‘File Name’ as shown 
in the Web Page List and in the Page Settings tab of the Inspector Window. 

As file names can only consist of letters and/or numbers, use the Navigation 
Display Name field in the Page Settings tab of the Inspector Window to 
override the File Name label in the Navigation Menu. You can use any label you 
want for the Navigation Menu. 

There are many ways in which to customize the Navigation Menu. First select 
the widget before using the following options: 

• Changing the Navigation Menu Font and Style: Use the Text tab in the 
Inspector Window or by using the Fonts button in the Toolbar. 

• Change the background appearance of the top level menu items: Use 
the ‘Fill’ section of the Shape Options tab in the Inspector Window. 

• Background Color of Dropdown Menu Items: Use the Widget Settings 
tab to change the background color.  

• Navigation Menu and Hamburger Menus: You can set the navigation 
so that at a particular page width, the it will change from a 
conventional navigation to a Hamburger style navigation. You can use 
this option on both fixed width and responsive page layouts. First go to 
the Widget Settings and check the ‘Responsive Navigation Bar’ option. 
You can now set when you want the Hamburger menu icon to be 
displayed. The default value is at a width of 700 pixels. Change this and 
the other Responsive Options, and Hamburger Button options, as 
desired. 
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6Master Pages

Master Pages are template pages you create yourself to 
use on some, or all, of the pages in your website project.  

Add features such as a navigation menu, social media 
icons, a logo etc. just once to a Master Page. Any pages 
using the Master Page will inherit its features 
automatically so updating pages in the future is quick and 
easy!

Master Pages

Creating a Master Page

Designing a Master Page

Using Master Pages
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Master Pages 
Master Pages are template pages that you create that can be used on one, or 
more, of the pages in your website project.  

When you create the pages of your website, you may notice that you are 
adding the same objects to each of your pages e.g. a navigation menu, social 
media buttons, company logos and so on. In addition, you are probably also 
adding the same Page Layout settings to each page that you create. 

This approach to page design will take you more time and effort than is 
necessary. There is also a greater chance of mistakes creeping in to your page 
design and updating your website in the future will become more of a chore 
than it should be. 

Using Master Pages in your site is the best way to to save you time and effort, 
whilst ensuring that your page design is consistent across all your pages. Using 
Master Pages also means that updating your page design in the future is faster 
and easier as you only need to update your Master Page designs rather than 
every page in your site. 

Master Page Features 
Master Pages include the following features: 

1. Master Pages are templates that you can create and edit yourself 

2. You can create as many Master Pages as you need e.g. you could create 
a Master Page for each department of your company. You may want to 
have one Master Page for desktop pages and one for mobile device 
pages if you are using a Fixed Width Page Layout. 

3. Master Pages are attached to the regular pages of your site.  

4. Master Pages can be used for both Fixed Width and Responsive 
websites and for any device type such as Desktop or Mobile. 

5. You create and edit your Master Pages in the same way as you would 
for regular pages in your website. 

6. Objects and other settings, such as Page Layout settings, that are used 
in a Master Page can only be edited in the Master Page itself. 
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7. You cannot create a Master Page from the ‘blog’ Theme Template. 

8. You cannot create directories in the Master Page section of the Web 
Page List. 

9. You can copy regular pages in to the Master Page section. 

10. You can copy Master Pages in to the regular page section of the Web 
Page List. 
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Creating a Master Page 

To create a Master Page: 

1. Click on the ‘New Master Page’ button (highlighted in Figure 6.1). 

2. If the Master Pages List is not visible, drag the splitter bar at the top of 
the Web Page List down to reveal the section. 

3. The Theme Template Chooser appears. Select the page style that you 
want to use as a Master Page in the same way as you would for a 
regular page. 

4. Click ‘Select’ to add the page to the Master Page section. 

You can now design the Master Page in the same way as you would a regular 
page. 
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Figure 6.1: Quickly add a Master Page to your website using the ‘New Master Page’ button.

http://www.everwebapp.com


EverWeb User Manual	 Master Pages

Designing a Master Page 
When designing your Master Page(s), think about the objects and settings 
that you want on every page, or group of pages, in your site. These objects and 
settings could be, for example: 

1. Your company name and/or logo. Usually these are placed at the top of 
every page of your website. If you are using a Fixed Width page layout, 
these objects are typically placed in the page Header. In a responsive 
website, you could place these objects at the top of the page in a 
Responsive Row widget as Responsive websites do not use Headers. 

2. Widgets, such as the Navigation Menu widget. This widget will typically 
appear near the top of every page in your site. The navigation is usually 
included in the Header section of a Fixed Width page layout, or 
towards the top of the page in a Responsive page layout. 

3. Other Objects: For example, you could place copyright information, or 
a site map in the Footer section of your Master Page. Social media 
buttons are also a perfect example of objects that you typically will 
want to see on every page of your website. 

4. Page Settings: Master Pages are great for setting Page Layout defaults, 
starting with the page layout type: Centered Layout or Responsive. You 
can also set, for example, a default Content Width or Minimum Footer 
Height. When setting height values for your Master Page, remember 
that these are minimum height values e.g. if you have a Minimum 
Footer Height of 100 pixels and add a shape with a height of 125 pixels 
to the section, the Footer with automatically expand to accommodate 
the shape. 

5. For your Master Page, you can set a small Minimum Content Height 
(e.g. 100 pixels) in the Page Layout section of the Page Settings tab of 
the Inspector window. On your actual pages, any content you add will 
push the height the content area down. In this way, you can fit any 
amount of content in to your page. 

6. You cannot explicitly set the Minimum Content Height of each page 
that uses a Master Page. As you add objects to the content area of your 
actual pages, the content area will expand in size to accommodate 
them. 

7. The Master Page is also ideal for setting the Page and Browser 
Background colors of your site. 
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8. You can attach a Master Page to the blog main, posts and archive 
pages. For blog posts you can also use the Blog Posts Preview 
Window as a ‘live’ Master Page. 

9. When editing a regular page which has a Master Page attached to it, 
use the Window-> Show Layout menu to see which objects are from 
your Master Page. Master Page objects have a small, black file icon in 
their top right corners. Edit the Master Page to adjust any of these 
objects. 

10. Remember that you cannot change the Page Settings of a regular 
page that has a Master Page attached to it. You have to change the 
Page Settings of the Master Page itself. Note that changing the 
Master Page may affect other regular pages that use the Master 
Page. 
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Using Master Pages 
Once you have created your Master Page, select the page you want to attach it 
to in the Web Page List.  

In the Inspector Tab on the right hand side, select the Master Page you want to 
use for that page from the dropdown menu (Figure 6.2). 

The page will now include the Master Page objects. These are shown with a 
black page symbol in the top right hand corner of the object. You can only edit 
these objects by editing the Master page itself. If you click on a Master Page 
object in your regular page, EverWeb will ask you if you want to go to the 
Master Page to edit the object you clicked upon.  

If you do not see the black page icons in your regular page once you have 
applied the Master Page, use the Window-> Show Layout menu option to see 
them on the page. 
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Figure 6.2: To use a Master Page on a regular page, use the Master Page dropdown in the Inspector 
Window. To see which pages the Master Page is attached to click on the Master Page name in the Master 

Page List. The highlighted pages in the Web Page List are attached to the selected Master Page.
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Any objects that were already on the regular page may have moved, so you 
may need to relocate these objects within your page design. Continue to 
design your regular page as desired. 

Finding Pages Attached to a Master Page 
You can easily find out which regular pages are attached to any particular 
Master Page by selecting the Master Page itself in the Master Page section of 
the Web Page List. 

When you select the Master Page, all regular pages attached to it will be 
highlighted in the Web Page List (see Figure 6.2). 

To remove the highlight, click on a regular page in the Web Page List. 

Moving Master Pages and Regular Pages 
If you have created a Master Page when you actually wanted to create a 
regular page, just drag and drop the Master Page into the grey section of the 
Web Page List. A copy of the Master Page will be created as a regular page. 

Once the Master Page has been created as a regular page in the Web Page 
List, you can delete the Master Page that you created in the Master Page 
section if you do not need it. 

Conversely, if you have a regular page that you would like to use as a Master 
Page, just drag and drop it from the grey area of the Web Page List in to the 
Master Page section. A copy of the regular page will be created as a Master 
Page. Delete the regular page if it no longer needed. 
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7The Toolbar

The Toolbar at the top of the EverWeb User Interface gives 
you quick access to many commonly used EverWeb 
features.

The Toolbar
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The Toolbar 

The Toolbar (see Figure 7.1) lets you quickly access common tasks such as 
adding new pages, shapes or text, changing the text font and more.  

• Add Page: Opens the Theme Template Chooser and lets you add a 
new page, or Master page, to your website based on a theme template 
or using a blank page style. 

• Add Directory: Directories are folders containing web pages. They are 
used to organize your website and for dropdown navigation menus. 

• Preview: Preview your website to any of the web browsers installed on 
your local computer. 

• Publish: Publishes your website to the Internet or to a folder location. 
Please refer to the Publishing chapter for more information. 

• Check Page: Checks your page’s SEO settings and advises how you 
can improve the page’s SEO. Requires EverWeb SEO Power Up Addon. 

• TextBox: The button lets you add text to your page. Text can be 
formatted and positioned anywhere on your web page. 

• Shapes: EverWeb’s built in Shapes help you design your website. 
Shapes can have solid colors, gradients or images. See the Shape 
Options section for more information about customization options. 

• Scroll Position: Easily set up ‘anchors’ so you can hyperlink from any 
object to a specific location on any page in your website. See the 
section on the Hyperlinks Inspector for more information. 

• Rotate: This option rotates the selected shape 90 degrees clockwise. 
Hold down the Option (Alt) key to rotate the shape counter clockwise. 
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Figure 7.1: EverWeb’s Toolbar gives quick access to frequently used features. The Toolbar shown is for EverWeb 
with macOS Big Sur or later . If you an earlier macOS version, you will see a different style Toolbar.
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• Mask: Quickly display only the part of the selected image you want to 
see. Masking is like cropping but not destructive to the image itself. 

• Fonts: The Fonts button opens the Font Panel and lets you modify the 
selected fonts of any selected TextBox. 

• Colors: The Colors button opens the Color Picker and lets you change 
the text color of any selected text and the color of any selected shape. 

• Media: Allows you to access EverWeb’s Free Stock Photos library and 
the Media Browser. 
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8The Inspector 
Window

The Inspector Window has six tabs that are used to set 
various parameters and defaults for your page and the 
objects on your pages.

Page Settings

Shape Options

Metrics Inspector

Text Inspector

Hyperlinks Inspector

Widget Settings
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The Inspector Window 
Page Settings 
Page Details 
The first tab in the Inspector Window is 
the Page Settings tab. Here is where 
adjustments to the settings for each 
page on the website are made. 

File Name 
The File Name (see Figure 8.1) is what 
you see in your web browser's address 
field. e.g. you may want to name the 
page after its function, such as Home, 
About Us, Contact Us, Services, Products, 
etc.  

If you change the File Name, the the 
page name the Web Page List will also 
update.  

The page File Name is also discussed in the SEO For EverWeb Video Course. 

If Search Engine Optimization is important for your website, please checkout 
our tutorials on the EverWeb website before assigning your web page's file 
names. 

Include page in navigation menu 
You have the option of including each page of your site in the navigation 
menu. By default, each page is included in the navigation menu, If you do not 
want this, uncheck the ‘Include page in navigation menu’ option. 
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Figure 8.1: The Page Details section on the Page 
Settings tab.
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Navigation Menu Display Name 
The ‘Navigation Menu Display Name’ is the text that appears in your navigation 
menu if you use EverWeb's built in Navigation Menu Widget.  

The Navigation Menu Display Name is another element to optimize for search 
engines as shown in the SEO For EverWeb Video Course. 

The Navigation Menu is discussed in more detail later on in the User Manual 
and in EverWeb’s Video Tutorials which can be accessed from the Help-> Video 
Tutorials menu. 

Language 
The ‘Language’ drop down is used for Search Engine Optimisation (SEO) 
purposes. For example, if your website is designed for Canadian visitors only, 
you may have most of your pages in English but some in French to cater for 
both types of visitor you want to attract.  

In this example, use the ‘Language’ drop down menu to select ‘English 
Canada’ for your English language pages and ‘French Canada’ for your French 
language pages.  

Google and other search engines will use this information to serve the 
appropriate content when a person performs a relevant search.  

If you only use one language in your website, use the File-> Edit Publishing 
Settings menu to globally set the ‘Language’ to the one you are using. 

Web Page Title 
The ‘Web Page Title’ appears at the top of your page in the web browser. The 
Web Page Title is another element to optimize for search engines. The video 
tutorials, again, has extensive information making a good page title. Web page 
title’s should include a description of your page’s function but should not be 
more than about 160 characters long. 
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Page Layout 
The Page Layout section (see 
Figure 8.2) is where you define 
the specifications of your 
page.  

You can choose to have either 
a Left Aligned page, a 
Centered page or a 
Responsive page.  

Specifying a value greater 
than zero in the ‘Top Margin’ 
field creates a space between 
your website and the highest 
point of the browser window.  

For example, if you add a shape 
to a page and move it to the top of the Header section, you will see that there 
is a white space between the top of the page and where the page begins. This 
white space can be made something different, and we will get to that in just a 
moment.  

‘Content Width’ determines how wide your page will be. There is no set rule for 
how wide your website should be, but remember that most visitors to your site 
will not like scrolling horizontally. A good value to use is about 980 pixels, but 
that is not a hard limit. 

Note: Content Width is not used in Responsive website design so is unavailable if your 
page uses a Responsive Page Layout. 

The ‘Minimum Content Height’ determines the minimum length of the body 
of the page. This rarely needs to be changed as the height automatically 
adjusts based on where you place objects on the page. For example, dragging 
an object down on the page will increase the page height automatically. The 
value does not increase in the Minimum Content Height field though as this 
value is the minimum page content height. 

The ‘Minimum Header Height’ determines how minimum height of the 
Header section. As with ‘Minimum Content Height’, ‘Minimum Header Height’ 
also adjusts automatically based on the objects in the Header.  
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Note: Minimum Header Height is not used in Responsive website design so is 
unavailable if your page uses a Responsive Page Layout.  

Finally, the ‘Minimum Footer Height’ determines the minimum height of the 
Footer. As with the Minimum Header and Content Height, the Footer adjusts 
automatically based on where objects are placed within it. 

The Page Layout Section and Master Pages 
If you attach a Master page attached to a regular page, the fields in the Page 
Layout section of the regular page will be greyed out, as the page takes these 
settings from the attached Master page. In this instance, the only way to 
change Page Layout settings is to edit the Master Page itself.  

Note:Changing the settings of the Master page will affect any regular page that the 
Master page is attached to. 
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Page Background 
The Page Background appears behind 
your page content (see Figure 8.3). 
There are four options: 

• None: Leaves the background 
as white 

• Color Fill: Allows you to set the 
background as a solid color 
using either the color swatch 
(where you can select a color 
from your own document 
colors) or from the Color Picker. 

• Gradient Fill: Allows you to use 
two colors to create a Page 
Background which transitions smoothly from one color to the other.  

Choose each color by clicking on the color swatch, or color picker, next 
to the color you want to change. Once you have selected the two 
colors, you can modify the angle of the gradient. For example, you can 
flip the two colors vertically and horizontally using the ‘Up’ and ‘Right’ 
arrow buttons.  

Use the wheel to rotate the gradient around the center of the page 
form 0 to 360 degrees, You can also type in the gradient you want in 
the gradient value field. 

• Image Fill: The Image Fill option allows you to place an image as the 
page background. Select the image you want by using the ‘Choose…’ 
button. You can either use an image from the list, or from another 
location, such as your hard drive, by selecting the Choose option at the 
top of the list. This will open the Finder window where you can 
navigate to the image file that you want to use.  

Once the image has been set as the Page Background, you can either 
have it set to Scale to Fit, Scale to Fill, Stretch, Original Size, Tile, Tile 
Horizontally or Tile Vertically. The option you choose will depend on 
the image you want as your page background. 
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In addition, you can set the vertical and horizontal alignment of the 
image using the Alignment buttons. If you prefer, you can also keep 
the image in a fixed position by checking the ‘Fixed Position’ checkbox. 

If you want, you can add a background shadow to your page by 
clicking the Shadow option. You can select the color for your shadow, 
and how big you want the shadow to be. The shadow option works 
with any type of page background. 

Browser Background 
In addition to a Page Background, you can also add a Browser Background to 
your site. The browser background is the background styling for your browser 
window on top of which is your website’s page content. The Browser 
Background has the following options.  

• Color Fill: This option allows you to choose a solid color for your browser 
background, similar to the page background. If you want this left as 
white, then you do not need to select anything. 

• Image Fill: This option uses an image as the Browser Background. 
Select the image you want by using the ‘Choose…’ button. You can 
either use an image from the list, or from another location, such as 
your hard drive, by selecting the Choose option at the top of the list. 
This will open the Finder window where you can navigate to the image 
file that you want to use.  

When your Browser Background image has been set, you can set it to 
Tile, Original Size, Stretch or Scale To Fill. The option you choose will be 
dependent on the image you have selected to use for your browser 
background.  

Additional options are also available: Alignment buttons let you align 
the image horizontally or vertically, Fixed Position fixes the image in its 
current location, and the Scale option lets you scale your image, either 
using the slider, or the input field. You can input values from 10 to 500. 

• Video: This option allows you to set a video as the Browser Background. 
You can choose either an External Video URL, a Local Video File, a 
YouTube Video or a Vimeo Video File. The video can be set to loop and 
to be set in a fixed position in the Browser Background. You can set a 
Scroll Speed for the video using a value between 0 and 100. 
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Additionally, you can add a Thumbnail to the video which will display if 
the video needs time to load, and you can set the video to play or not 
on Tablet and Mobile devices  
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Search Engine Optimization 
The Search Engine Optimization section of the Page Settings tab allows you to 
apply SEO directly to your page.  

Some options in this section are available only if you have purchased EverWeb 
SEO Power Up addon. Options that require SEO Power Up will be indicated in 
the text below.  

Check the ‘Include page in search engines’ checkbox to activate the EverWeb 
Search Engine Power Up Addon settings. 

The ‘Social Media Image’ field is used to add a Social Media image to a page 
for Facebook shares. Use the ‘Choose…' button to select the image you want to 
use in Facebook. When you are in Facebook and add a link to your website, the 
Social Media Icon will be displayed. 

The ‘Web Page Description’ allows you to add a description of the page. The 
description often appears when your page appears in search engine results. 
The SEO For EverWeb video course has more details about how to use Web 
Page Description for SEO. 

The ‘Keywords’ section (available only with EverWeb SEO Power Up) allows you 
to enter your own Keywords, or Keyword terms, that relate specifically to the 
page. 

The ‘Include in XML Sitemap’ checkbox (available only with EverWeb SEO 
Power Up) when checked, allows you to set the importance of the page using 
the ‘Priority’ field and the frequency in which the page is usually updated. 
These options are discussed in detail in the Chapter 'EverWeb SEO Power Up'. 

Publishing Your Website 
When you have completed your Search Engine Optimization and are ready to 
publish your website, go to the Site Publishing Settings using either the File-> 
Edit Publishing Settings menu option or by clicking on your website’s name in 
the Web Page List.  

Inthe EverWeb Location section, check the box for ‘Optimize and Submit 
Website to Search Engines’ if it is not already checked. When you publish your 
website, it will be submitted to all the major search engines. 
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If you have not purchased EverWeb SEO Power Up, you will be prompted to 
purchase or ‘remind me later’ when checking the ‘Optimize and Submit 
Website to Search Engines’ checkbox. 

Site Search 
The Site Search section of the Page Settings tab allows you to set whether the 
current page is to be included or not in site wide searches when using 
EverWeb’s Search Field widget. 
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Mobile Settings 
EverWeb allows you to create a 
mobile version of your website. If 
you are creating a Responsive 
website, this is usually not 
necessary. 

Most of EverWeb’s Fixed Width 
Theme Templates include one 
‘Mobile’ page design. Use this as 
the basis for your ‘Mobile’ pages 
which will usually correspond to the desktop style pages you have created for 
your site. 

To add a mobile page design to your website: 

1. Click on the ‘Add Page’ button in the Toolbar.  

2. Use the Filter dropdown menu in the Theme Template Chooser to view 
only Fixed Width Theme Templates.  

3. Select the Fixed Width theme you want.  

4. Select the ‘Mobile’ page style, then click ‘Select’. 

5. Your Mobile page is added to the Web Page List and is displayed in the 
Editor Window. 

6. Repeat this process to create other mobile pages that correspond to 
those you have created for Desktop use. 

You can also create your own mobile pages that correspond to your desktop 
designed pages. To do this, set the Content Width of the page to (a 
recommended value of) 480 pixels in the Page Layout section of the Page 
Settings tab in the Inspector Window. This pixel width fits well with iOS and 
most mobile devices. 

When your mobile page is finished, assign it to its corresponding regular page. 
EverWeb will automatically display the Mobile page when a visitor browses the 
page on a mobile device and the desktop page when the page is viewed on a 
desktop device. To set up this ‘redirect’: 
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1. Select the page from the Web Page List that you want to redirect to a 
mobile page e.g. the Home, or default page.  

2. In the Page Settings tab in the Inspector window, scroll down to the 
Mobile Settings section (see Figure 8.4).  

3. In the Mobile Page drop down menu, select ‘One of My Pages’.  

4. Select the mobile page you want to link to from the ‘Page’ drop down 
menu.  

5. Repeat the above steps for other pages that you want to redirect. 

When you publish your website, the mobile redirect will be enabled. You can 
test the redirect by visiting your website on your mobile device. 

Head/Footer Code 
The ‘Head/Footer Code’ sections allow you to inject programming code, or 
script, in to your web page. The Head/Footer Code section is, therefore, of use 
to advanced EverWeb users. Typically, you will not need to enter anything in to 
this section. 

Just like the other settings in the Page Settings tab, any code or script entered 
into either fields will be applied to the respective page only, and not the entire 
site.  

Any code placed in the Head Code section will be placed within the <head> 
tag in your HTML code.  

Any code placed in the Footer Code section will be placed right before the 
closing </body> tag. 
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Password Protection 
The Password Protection section consists of two buttons: 

• Memberships and 

• Simple Password 

 

Memberships 
The Memberships button (See Figure 8.5) is 
used when you have an active EverWeb 
Memberships Sites license. Use the 
‘Memberships’ options to select which 
membership levels apply to the page you are 
currently on.  

To use this section, you will need to sign up for  
EverWeb Membership Sites and have set up 
membership levels within the Membership 
Sites section of your EverWeb Client Area. 
Please refer to the section on EverWeb 
Membership Sites for more information. 

To set the Membership Levels for the page 
you are currently on, first select the 
Membership Site that you want to use for the 
page from the dropdown menu. The default 
setting is ‘No Selection’.  

Once you have selected your Membership 
Site, you see the membership levels for the 
Membership Site displayed. Click on the box to the left of the name of the 
Membership Level to toggle the level on or off.  

For example for my membership site I have set up four membership levels: 
Free Bronze, Silver and Gold. For my Gold members page I would want my 
Gold members to access all content so I would check mark all membership 
levels. 

If I now go to my Free Content page, I would only check the Free membership 
level as the Bronze, Silver and Gold levels are all paid for membership levels. 
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If you click on the Membership Level name, you will see further details 
displayed about that membership level in the box below i.e. Set Up Price, 
Recurring Price, Tax and Schedule. 

If you want to edit your membership levels at any time, click on the ’Edit 
Membership Levels…’ button which will take you to your EverWeb Client Area 
where you can make the changes you want. 

If you make changes to your membership levels in your EverWeb Client Area, 
for example adding or removing a Membership Level, you may find that these 
changes are not reflected in EverWeb. Use the ‘Refresh’ button to the right of 
your Membership Site selection to refresh the Membership Levels list. 

In addition, the Memberships options also allow you to setup, or edit, your 
Membership Site Settings using the ‘Membership Site Settings…’ button.   

Simple Password 
EverWeb lets you easily password protect the whole, or certain parts, of your 
website. Click on the ‘Simple Password’ button to access Password settings.  

For example, you could create a members only section on your website, or 
restrict access to certain individuals. 

Note: Password protection will only work on EverWeb’s Hosting platform. In addition, it can 
only be applied to Directories added to the Web Page list. 

To use Password Protection, use the ‘Add Directory’ button in the Toolbar. 

Click on the ‘Add’ button in the ‘Password Protection’ section. 

You can have unlimited passwords but all usernames must be unique. Also, 
you cannot use single quotes in the username or password field. 
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Advanced Options  
Redirects 
Redirects are a powerful, but advanced, feature. For example, if you have an 
existing, but old, iWeb website, you may have high search engine rankings for 
this site, or you may have provided these links to other people. 

EverWeb lets you automatically redirect individual pages from your old site to 
your new site using a special type of redirect known as a 301 redirect. These 
redirects have the benefit of maintaining your search engine rankings. 

To use this feature, enter the full URL of your old page in the field. You can find 
the old URL by simply visiting your old site in your browser and copying and 
pasting the URL in the Path bar at the top of your browser window into this 
field. 

Remember: this feature is for individual pages. Each page on your old website 
should redirect to a unique page on your new EverWeb website. DO NOT 
enter your main website’s URL for each page. Every redirect page in 
EverWeb should have a unique URL. 

Page Extension 
You can set the extension of the page as either HTML, HTM, PHP or ASP, When 
you publish your site, the page will be published in your chosen format to your 
server. The default Page Extension is HTML. 
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Shape Options 
All About Shapes & Images 
Add a shape to your website by clicking on the Shapes button 
in the Toolbar, then select the shape you want to use (Figure 
8.6). Shapes can be made larger, or smaller, and can be moved 
around the Editor Window to a desired location. 

Use the Shape Options tab in the Inspector Window to modify 
a shape (Figure 8.7). 

You can change the type of shape you are using by clicking in 
the drop down menu and selecting the shape you want.  

For each shape, there are three settings that you can make Fill 
modifications for: 

• Normal: How the shape will appear when no mouse 
cursor is over it. 

• Mouse Over: How the shape will appear when the 
mouse cursor is hovering over it. 

• Mouse Down: How the shape will appear when the 
shape has been clicked on. 

Tip: Any shape can have text on top of it. Just double click on the shape 
and begin typing. 

To change the default shape color and shape border color, use the Format-> 
Default Styles… menu option. 
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For the shape’s appearance, you have six options 
to choose from: 

• None: Makes the shape transparent - 
essentially this is what a TextBox is. 

• Color Fill: Allows your shape to have a 
color. Click on the color icon to change 
the color of the shape.  

• Gradient Fill: Allows the shape to be two 
different colors that transition smoothly. 

• Advanced Gradient Fill: Similar to the 
Gradient Fill but allows you to include 
more than two colors. 

• Image Fill: Select the image you want to 
fill the shape with. Images can be scaled 
when using Original Size or Tiled 
Options. 

Use the Lazy Load Image option to only 
load the image when it is needed. Using 
this option helps speed up the time it 
takes the page to download from there 
server to your visitor’s browser. 

Parallax Scrolling is available to images 
depending on the type of image fill used. 

To view the effect, click on the Preview button in the Toolbar. 

Full Width widgets such as the FlexBox widget can also use the Shape Options 
color and image fill options to add a background color or image to the widget. 
 
All images can have an overlay color applied to them.  
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• Slide Show: A TextBox, image, rectangle Shape or Responsive Row 
widget can be filled with a Slide Show as described below: 

Using Fill: Slide Show with a TextBox 

Use this option when you want to have text displayed on top of a background 
slide show: 

1. Start by adding a TextBox to the page if you have not done so already. 
Replace the default text with your own and style the TextBox as 
desired. Note that you can add a slide show to a TextBox even if it 
contains no text. 

2. If you already have a TextBox on the page that you want to add a 
background slide show to, select it. 

3. Next, go to the Shape Options tab and select ‘Slide Show’ from the Fill 
dropdown menu. 

4. Use the ‘Choose…’ button to select the images that you want to use for 
the background slide show of the text. 

5. Select the Transition and Navigation Options as desired. 

Viewing Slides When Using the Fill: Slide Show Feature 
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Once you have added your images to the slide show, the slide show object will 
be displayed with Pervious and Next navigation arrows. Click on these arrows 
to to see the previous or next slide. Two examples are shown in Figures 8.8 and 
8.9 below. 

Tip: The Previous and Next navigation arrows are only available in the Editor Window when 
the ‘Show Arrows’ option set to ‘Always’ or ‘Mouse Over’. If you want to display the slide show 
without arrows, it is recommended that you keep the arrows visible in the Edit Window until 
you have completed your slide show. Once complete, set the ‘Show Arrows’ option to ‘Never’ to 
hide the arrows. 

 

Using Fill: Slide Show with a Rectangle Shape 

This option can be used when you want to have a simple slideshow. The slide 
show background can only be used with a rectangle shape. If you select the 
‘Slide Show’ option with another shape type (including the rounded rectangle 
shape), the shape will revert to rectangle. 
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http://www.everwebapp.com


EverWeb User Manual	 The Inspector Window

Once you have selected the rectangle shape, you can add the images you 
want to the shape in the same way as you would for the slide show for a 
TextBox. 

Using Fill: Slide Show with an Image 

This option works in the same way as it does for adding a slide show to a shape. 
Just select the image that you want to become a slide show then add the 
images that you want as the background slide show in the same way as 
described above. Note that when you select the ‘Slide Show’ option you will 
need to add the original image in to the slide show list. 

Using Fill: Slide Show with a Responsive Row Widget 

If you have a Responsive Row widget on your page, you can add a background 
slide show to the Responsive Row itself. As a Responsive Row can include 
TextBoxes, Images and Rectangle shapes, you also have the ability to add a 
slideshow on top of a background slideshow making this a very powerful 
feature. 

To add a background slide show to a Responsive Row widget: 

1. First add a Responsive Row widget to the page, or select one that is 
already on your page.  

2. Add the objects that you want to include in to the Responsive Row if 
you have not done so already. 

3. To add a background slideshow to the Responsive Row, make sure that 
the Responsive Row is selected.  

4. Next, go to the Shape Options tab and select the ‘Slide Show’ option 
from the Fill dropdown menu. 

5. Add the images you want to use for the background slides and adjust 
the Transition and Navigation Options as desired. 

Adding Objects to the Responsive Row Slide Show 
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You can add objects to any slide in the Responsive Row.  

1. Use the navigation arrows (see Figure 8.9) to select the slide that you 
want to add an object to. 

2. Once the background slide is visible, click on the Responsive Row to 
select it. 

3. Add the objects that you want to the currently visible Responsive Row 
slide e.g. TextBoxes, images, shapes, other widgets and so on. 

4. If you have added an object to the wrong Responsive Row slide, you 
can easily move it to another slide. First select the object you want to 
move then secondary click. Select the submenu option ‘Embed In’ 
then choose the slide in the Responsive Row that you want to move 
the object in to (See Figure 8.10). 

For more information about objects in the Responsive Row widget please see 
the chapter on the Responsive Websites in EverWeb. 
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• Video: Use this option when you want to fill a shape object with a 
Video, or if you drag and drop a video on to your page from an other 
sources such as your desktop or Cloud location. For example: 

•

1. Add a rectangle shape, using the Shape button in the Toolbar, to 
your page. 

2. Select the rectangle shape, then go to the Shape Options tab and 
change the Fill to ‘Video’. 

3. In the dropdown menu below the Fill dropdown menu, select the 
video source: External Video URL, Local Video File, YouTube Video 
or Vimeo Video. 

4. Enter the location of the Video source in the Video Location field 
below the Video Source dropdown. If you are using a Local Video 
File, click on the Choose… button and select the video file that you 
want from the Assets List. 

5. Once you have selected your video, set the other Video Fill options 
as desired. 

• Map: You can fill an object with a Google Map using Map Fill. This 
feature offers you more flexibility than using the Google Maps widget. 
For example, you can add a map as the background of a Responsive 
Row widget. Map Fill includes three options: 

• Simple Map (Deprecated) 

• Basic Map (Free) 

• Advanced Map  

The Simple Map (Deprecated) offers the same features as you would 
find if you were using the Google Maps widget. 
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The Basic (Free) and Advanced Map Fill options give you expanded 
map options including: 

• Roadmap or Satellite view 

• Ability to Zoom 

• Show Terrain and 

• Show Labels 

In addition, if you are using the Advanced Map option you can also use 
the following features: 

• Show Controls 

• Ignore Mouse Gestures 

• Always Show Label on Marker 

• Ability to add your own Label 

About Google Maps Platform 

In order to use the features found in the Basic (Free) and Map 
Advanced Map, you will need to use a Google Maps API Key. EverWeb 
will help you to generate the necessary Key.  

Once you have generated the necessary Key you will then enter it in to 
the Map Fill ‘Google Maps API Key’ field. 

Generating the Google Maps API Key is easy because when you select 
the Basic or Advanced Map option, EverWeb will display a dialog box 
with an option to ‘Get Google Maps API Key’.  
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When you click on this option, you will be taken in to Google Cloud 
Platform which will then step you through generating a Maps API Key 
that you can use in EverWeb. 

In order to generate a Google Maps API Key, you will required to 
complete the following steps: 

• Create a Google account if you do not already have one, then add 
Google Cloud Platform to your account. 

• If you already have a Google account, you may be asked to log in. 
Once logged in you may be asked to add Google Cloud Platform 
to your account. 

• You may be asked to supply billing details to Google. If you are 
using the Basic (Free) option in EverWeb, you will not be billed. If 
you are using the Advanced Maps option, you will be charged by 
Google for using the Advanced Map features. 

• You will need to create a Google Could Platform Project, if you have 
not already created one. 

• You will need to make sure that you enable Google Maps Platform 
APIs and SDKs for your Google Cloud Platform project. 

Once you have completed the steps required by Google to generate a 
Google Maps API Key, copy the API Key to the Clipboard and paste it in 
to the Google Maps API Key field in the Map Fill section in EverWeb. 

•

Stroke Options 
You can apply the following Stroke options to your shape (See Figure 8.11): 
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None 
No options are applied to the shape. 

Line 
Shapes can have a line stroke surrounding 
them. Select ‘Line’ from the Stroke drop 
down menu.  

You can choose between a solid line, a 
dashed line and a dotted line.  

To set the color of the line use the color 
swatch or color wheel. 

To set the thickness of the line by entering a 
number in the box, or by using the up/down 
arrows. 

Picture Frame 
To add a picture frame to your shape: 

1. Select ‘Picture Frame’ from the Stroke drop down menu. 

2. Click on the picture frame thumbnail and select the frame you want to 
use.  

3. Modify the thickness of the picture frame by adjusting the slider. 

Shadow Options 
To add a Shadow to your shape click on the Shadow option. 

Choose the shadow color you want by clicking on the color swatch 
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The direction of the shadow can be altered by rotating the wheel icon or by 
entering a number from zero to 360 degrees in the box to the right of the 
wheel icon. 

Use ‘Offset’ to set how far the shadow is away from the shape 

Use ‘Blur’ to alter the sharpness of the object 

The 'Opacity’ option is used to alter the opaqueness of the shape i.e. how see 
through or solid the shadow appears. 

Reflection Options 
You can also add a reflection to your shape, and specify how large you would 
like the reflection to be using the slider. 

Opacity Options 
To adjust the opacity of a shape, use the slider or the up/down arrows or enter  
the value in the box. 
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Animation Options 
You can animate objects to produce some amazing effects on your web page. 

1. Start by select the object you want to animate. Select multiple objects 
if you want to apply the same effect to many objects at the same time. 

2. In the Shape Options tab, tick the checkbox next to the word 
‘Animation’. The animation options are now displayed. 

3. A number of different animation styles are available in the first drop 
down list. Click on the animation effect you want to use. If you select 
‘Other’, a second list of animation styles will become available in the 
second drop down menu, 

4. Once you have selected an animation effect from the first drop down 
menu, use the second drop down menu for further styling options e.g. 
if you selected the ‘Flip’ animation effect from the first drop down 
menu, you have the styling options of ‘In Place’, ‘Horizontal’ or ‘Vertical’ 
available from the second drop down menu. 

5. If you selected ‘Other’ from the first drop down menu, you will see 
more animation effects listed in the second drop down list. These 
animation effects do not have any additional styling options. 

6. When you select your animation effect and styling options, you can see 
a preview of the effect in the preview window at the bottom of the 
‘Animation’ settings. 

7. Once you have chosen your animation effect use: 

• Duration: To specify how long the effect will last for (in seconds 
and milliseconds;) 

• Delay: To delay the start of the animation effect (in seconds and 
milliseconds) 

• Repeat: To replay the animation effect the number of times 
specified. 

8. Use the Preview button in the Toolbar to see the animation effect 
working on your page before publishing your website. 
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Dividers 
Dividers are SVG files that are used to add visual impact and styling to objects 
in the pages of your site. A SVG file Is a Scalable Vector Graphic file, so you can 
add the file to objects and know that the SVG file will always scale correctly on 
whatever device it is being displayed upon. 

Dividers can be used to add styling effects to the top and bottom of most 
objects on the page or to visually ‘separate’ different sections of the page. 

 
To use dividers on objects on your page: 

1. First select the object you want to add a 
divider to, for example, a Responsive 
Row. 

2. Next go to the Shape Options tab and 
open the Dividers section (See Figure 
8.12) if it is not already open. 

3. Click on the top, or bottom, divider 
button to select the divider type you 
want. 

4. Check the ‘Use Top/Bottom Divider' 
checkbox to activate the settings for the 
divider.  

5. Click on the ‘Select’ button. Scroll the list 
of dividers until you find the one you 
want to use, then double click on it to 
select it. 

6. You will see the ‘Select’ button replaced by a representation of the 
divider you have chosen. You will also see the divider at the top or 
bottom of the object you have selected in the Editor Window. 

7. You can now customize the divider using the customization options. 

8. To replace a divider with a different one, simply double click on the 
image of the divider you have chosen and select a different divider. The 
previous settings that you used will be carried over to your new 
selection. 
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9. To remove a divider, simply uncheck the ‘Use Top/Bottom Divider’ 
checkbox.  

Scroll Position 
You can create a Scroll Position by either using the Scroll Position Toolbar 
button, the Insert-> Insert Fixed Scroll Position menu option, the Insert-> Set 
Selected Shape as Scroll Position… menu option, or by selecting an object and 
using the Scroll Position field in the Shape Options tab. 

When using the Scroll Position field in the Shape Options tab, you must give 
the Scroll Position a unique name. Once you have created the name, you can 
edit it later if desired. 

Use the Hyperlinks tab to link to a Scroll Position. For more information, please 
refer to the section of this manual on Scroll Position. 

Advanced Options 
CSS Class 
The CSS Class field is used to apply one, or more, CSS (Cascading Style Sheets) 
classes to an object. CSS allows you to control the layout and style of objects on 
your page. This is an advanced option for users who have knowledge of CSS. 
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Metrics Inspector 
The Metrics Inspector (Figure 8.13) is where you 
can fine tune the size and position of objects as 
well as set other parameters relating to the 
selected object(s). 

Size 
This Size section of the Metrics Inspector is where 
you can adjust the pixel width and height of the 
selected object, set the object to scale as you 
resize it, set the object to the full width of the 
page and adjust Full Width object’s margins.  

Constrain Proportions 
When resizing an object you may want to keep 
its proportions whilst doing so. Tick the Constrain 
Proportions box if you want to the object width to 
scale proportionally as you adjust the object 
height and vice versa. 

Full Width 
If you want an object to dynamically resize its width as you resize the browser 
window tick the ‘Full Width’ option. When you use this option, the selected 
object expands to the size of your browser. 

Remember that not all objects can be full width. For example, the Facebook 
Timeline Widget cannot be full width. For objects that cannot be full width the 
setting cannot be ticked. 

A full width navigation bar, or background object is a great example of when to 
use full width objects. 
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Margin 
When an object is set as ‘Full Width’ you can add a left and right margin to it. 
This is useful if, for example, you are using a full width TextBox and do not want 
the text to appear right up against the left or right margins of the page. 

Maximum Width 
By default, full width objects will display to the full width of the page. In some 
instances this is not useful as objects may appear too spaced apart from each 
other or you may not want an object to expand to the entire length of a wide 
screen.  

Use the ‘Maximum Width’ field to set a maximum limit to the width of the full 
width object. If you leave the value at zero, the full width object will always 
scale to the full page width. 

Position 
Use the X and Y position fields to fine tune the position of the selected object. 
Modify the X (Horizontal) and Y (Vertical) values in the Position section as 
required. The object will move to the specified coordinates.  

You can also click on the up and down arrows of the X and Y position fields to 
change the Position values. 

Allow Free Dragging 
You’ll notice when dragging objects around the EverWeb design canvas that 
you may be prevented from dragging the objects outside of the Header, main 
body area or Footer.  

These three sections help you organize your web page design so that anything 
added in the Header section can actually move the content in the main body 
area and the Footer area down so that you don’t always have to adjust your 
design every time you want to change your header. 

www.everwebapp.com	 ￼  of ￼107 322

http://www.everwebapp.com


EverWeb User Manual	 The Inspector Window

The same applies to the main body area, where objects moved downwards 
here will adjust the top position of the objects in the footer. 

The ‘Allow free dragging' option is used only in Fixed Width Page Layouts, such 
as the Centered Aligned Page Layout, and lets an object ignore these 
boundaries and lets you drag it anywhere on the design canvas. The position of 
a ‘free dragging’ object does not effect any of the objects in any other section. 

Fixed Positioned Objects 
EverWeb lets you include fixed positioned objects in your page so that as you 
scroll your page, the object’s position remains the same. This lets you add 
features such as a navigation menu that always stays fixed in place as the page 
is scrolled. 

Use the ‘Fixed Position’ checkbox and the ‘Relative to browser left’ option 
underneath it to fix the position of an object. 

The ‘Fixed Position’ option displays the object exactly where you placed it on 
the Editor Window as your page is scrolled vertically or horizontally. However, 
for a ‘Centered Aligned’ page layout (which is the default Page Layout in 
EverWeb) the object will be anchored to the left margin of the page. This 
means the object’s left position will move as you resize your browser window. 
This creates an effect of a centered, fixed positioned object. 

Select the ‘Relative to browser left’ option so that the object will not adjust its 
left position as you resize your browser. Instead, the object stays in the exact 
same position, no matter if you scroll or resize your browser. 

‘Relative to browser left’ is only relevant when using the ‘Centered Aligned’ 
page under Inspector-> Page Settings-> Page Layout section. 

Always On Top 
When you add objects to the Editor Window, they can appear stacked on top 
of each other. Usually you can use the Arrange menu’s Bring Forward/Send 
Backwards or Bring to Front/Send to Back options to layer objects as you wish 
on top of each other.  

In some instances, e.g. with Master Page objects, you may need to force 
objects to the top of the stack so they are never obscured. Check the ‘Always 
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On Top’ box or use the Arrange-> Always On Top menu option to force an 
object to the top of the stack so that it is always visible. 

Rotation 
Use the ‘Rotation’ wheel to rotate the selected object from 0 through 360 
degrees or use the Flip Horizontal or Flip Vertical buttons to flip the object 
vertically or horizontally. 

Responsive 
Show on Device 
You can choose on which devices objects are to be displayed upon by using 
the Responsive options. Select the object you want and then check or uncheck 
the ‘Show on…’ ‘Mobile,’, ‘Tablet’, Desktop’ and ‘Wide Desktop’ options as 
desired.  

As you change the the width of the Editor Window, you may notice that 
objects you unchecked disappear as they become hidden. You can view these 
hidden objects by using the Window-> Show Hidden Objects menu. Objects 
that are hidden will be displayed as placeholders boxes with a grey 
background with an ‘X’ cross through the object. 

Hidden objects can also be selected by secondary clicking on the page. From 
the menu that appears scroll to the ‘Hidden Objects’ menu item and select the 
object you want.  

Breakpoints 
You can set how wide the Editor Window canvas is for each device type: 
mobile, tablet, desktop and wide desktop. These values are used in responsive 
web pages and are known as ‘breakpoints’. The responsive page will respond 
to appropriately at each breakpoint so the the page always renders correctly 
on each device type. 
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Use the ‘Breakpoints’ button to change the value of the breakpoints, or use the 
Insert-> Breakpoints… menu option. To reset the values back to their original 
defaults click on the ‘Set Default’ button. 
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Text Inspector 

Editing Text 
There are two ways to edit your text: 

If you want to change the text font, click on the Fonts button, then select the 
font you want to use from the Fonts Panel. You can also change the font size 
by adjusting the size scroller, or by typing in the font size that you want 

Accessing the Text Inspector 
To access the Text Inspector’s settings, click on the Inspector Tab then click on 
the Text Inspector icon. 
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􀅶
To add text to your website, simply click on the TextBox 
button in the Toolbar. A TextBox will appear in the Editor 
Window. You can edit the text by double clicking inside the 
TextBox. If you already have TextBoxes on your page, e.g. from 
a Theme Template you have used, again, just double click 

1. If you want to edit some of the text in the TextBox, 
highlight the text that you want to edit.  

2. If you want to edit all of the text in the TextBox, select 
the TextBox on its own.

􀅒
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The Fonts Section 
The Fonts section of the Text Inspector is located 
directly below the Paragraph Style (See Figure 8.14). 
Use this section to change the attributes of the text 
you have selected.  

For example, to change the font and font style use 
the Font and Font Style dropdown menus.  

Adjust the size of the font either by using the up/
down arrows to the right of the Font Size box, or by 
over typing the number in the box with the value 
you require. 

Use the Bold/Italic/Underline/Strikethrough buttons 
in the combination you want for your selected text.  

To the right of the font styling buttons is the text 

color swatch.  

Use this to set the color of your text. Click on the color swatch itself to see a 
selection of predefined colors and recently used colors. For more color options 
use the Color Wheel instead. 

To set the background fill of your text, click on the checkbox to the left of 
‘Background Fill’ then use the Color Swatch or Color Wheel to select the 
background color that you want to use. 
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Paragraph Styles 
At the top of the Text Inspector you will see a Paragraph Style displayed (See 
Figure 8.15). A Paragraph Style is a collection of attributes that can be applied 
to the text in your page. Such attributes include the font itself, the font weight 
such as bold, light etc, the font size, font color and font style such as bold, italic 
or underline.  

When you create a new website project, a default set of paragraph styles will 
be available for use in the project. In the example in Figure 18,15 the paragraph 
style is set to ‘body’. The default Paragraph Styles can be modified or deleted. 
You can also add your own paragraph styles. 

Click on the down arrow to the right of the currently displayed Paragraph Style, 
to see a list of the paragraph styles currently available in your project (see 
figure 18.15). 

You can apply any Paragraph Style from the list to your text. Simply highlight 
the text your want to apply the paragraph styling to, then select the paragraph 
style you want to apply from the drop-down menu. 
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Paragraph Styles and Default Styles… 
Adding, modify and deleting Paragraph Styles can be done in two places in 
EverWeb: Directly in the Text Inspector (See Figure 8.16), or by using the 
Format-> Default Styles… menu option.  

We recommend that you set up your Paragraph Styles when you create your 
project file. If you need to modify them later, you can easily do so either the 
Text Inspector or from the Default Styles dialog box. In addition, if you use 
Paragraph Styles right from the start of your project, it will be easier, and much 
quicker, to make project wide paragraph styling changes if you need to. 

The following describes Paragraph Style features in relation to its use in the 
Text Inspector. Please refer to the Default Styles… section of the manual for 
information on adding, modifying and deleting paragraph styles using the 
Default Styles… dialog box.  

Applying a Paragraph Style to Your Text 
You can easily apply a Paragraph Style to your text: 

Highlight the text that you want to apply the Paragraph Style to. 

Click in the Paragraph Styles section of the Text Inspector and choose the 
Paragraph Style that you want to use. 

If you decide that you want to use a different Paragraph Style rather than the 
one you have chosen, simply reselect the text and then click on a different 
Paragraph Style. 

Modifying a Paragraph Style 
You can easily modify Paragraph Styles to suit your project file’s own style. You 
can use either the Format-> Default Styles… menu option or the Text Inspector 
to change a Paragraph Style in situ. To modify a Paragraph Style using the Text 
Inspector: 

1. First highlight some text in your page that has an existing Paragraph 
Style that you want to modify e.g. a page title that currently uses the 
default Heading 1 Paragraph Style. 
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2. By default the font for the Heading 1 Paragraph is Ariel but I want it to 
be Arial Black instead. 

3. With the text using the Heading 1 Paragraph Style still highlighted 
change the font in the Text Inspector to Arial Black. The highlighted 
text in the Editor Window will change to the Arial Black.  

4. To the right of the Paragraph Style in the Text Inspector there is now a 
blue ‘Update’ button. Click on the button to update the Paragraph 
Style. 

5. If you do not want to update the style, just ignore the Update button.  

6. Important! Note that any text using the Heading 1 paragraph style will 
also be updated with the change of font. If you have updated the 
Paragraph Style by mistake, use Cmd+Z to undo the action. 

You can update any of the paragraph style attributes listed in the Font section 
of the Text Inspector. 
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You can also modify a paragraph style from the Format-> Default Styles… menu 
option.  

Adding a New Paragraph Style 
To create a new Paragraph Style using the Text Inspector: 

1. Click on the down arrow to the right of the current Paragraph Style. 

2. Next Click on the ‘+’ button, again on the right hand side of the words 
‘Paragraph Styles’.  

3. At the bottom of the Paragraph Styles dialog box, you will see the words 
‘New Style’. Type over this text with the name of the Paragraph Style 
that you want e.g. ‘Heading 4’.  

4. The Paragraph Style has now been created. Use the Font section to 
change the font family, font size etc. to match the attributes that you 
want the new style to have. 

5. Once finished, use the Update button to save the changes you have 
made to your new Paragraph Style.  

Renaming a Paragraph Style 
To rename a Paragraph Style: 

1. First, click on the down arrow next to the current Paragraph Style. 

2. Mouse down to the Paragraph Style that you want to change. 

3. Click on the ellipses in a circle icon to the right of the Paragraph Style. 

4. From the dropdown menu, choose ‘Rename Style…’.  

5. Enter the new Paragraph Style name then press Enter to finish. 
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Deleting a Paragraph Style 
To delete a Paragraph Style,  

1. First click on the down arrow next to the current Paragraph Style. 

2. Mouse down to the Paragraph Style that you want to change. 

3. Click on the ellipses in a circle icon to the right of the Paragraph Style. 

4. From the dropdown menu, choose ‘Delete Style…’.  

5. Select the Paragraph Style to replace the Paragraph Style you want to 
delete. 

6. Click on ‘Delete’ to delete the Paragraph Style or click on ‘Cancel’ to 
abandon the deletion. 

Redefining a Paragraph Style from 
Selection 
A Paragraph Style can also be modified based on the current text’s attributes. 
For example, I have added some text and styled it. This text would be prefect as 
a Heading 1 Paragraph Style.  

To apply the current text’s attributes to replace my current Heading 1 attributes 
with those of my currently selected text… 

1. Keep the current text selected 

2. Click on the down arrow to the right of the Heading 1 paragraph style 

3. Click on the ellipses in a circle symbol to the right of Heading 1.  

4. Select ‘Redefine Style from Selection’. 

5. The new styling will be applied to all text using the Heading 1 Paragraph 
Style. 
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Minimum Font Size 
Use the ‘Minimum Font Size’ setting to set the minimum size that you want 
the text to be displayed as. For example, you may have set the font size for your 
text to be 24 point in the Font Size box. This is fine for desktop computers but 
on a mobile phone you would like the text to appear as 18 point. Set the value 
to 18 in the Minimum Font Size box. As you reduce the width of your page, you 
will notice that the text smoothly adjusts up and down between 18 and 24 
point as you increase and decrease the browser width.. 

Alignment 
The Alignment section of the Text Inspector lets you align the selected text in a 
TextBox to either the left, center, right or as justified text. You can also align the 
text to be at the top, middle, or at the bottom of the TextBox. 

Spacing Options 
Use this section to set the spacing of each character, the spacing between 
each line and the text margins. 

Character and Line Spacing 
You can alter the space between each character by adjusting the character 
spacing. To alter line spacing adjust the line height of the text. You can also set 
the before and after paragraph spacing. For example, if you want there to be a 
larger gap between two paragraphs, you can either click after the paragraph 
and then increase the After Paragraph value, or you can click before the 
paragraph and then increase the Before Paragraph value. 

Setting a Margin 
The Inset Margin option applies vertical and horizontal padding to the text 
within the TextBox and is useful to use for formatting text spacing within the 
TextBox. 
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Export Options 
Use this section to set how the text will be presented to search engines and 
your visitors when your site is published. 

HTML Tag 
Use the HTML Tag option on your selected text to help search engines 
categorize your website for search purposes. Using an HTML Tag is optional as 
EverWeb will determine which tags to use when you publish your site. You can 
however, manually set the tags yourself if you prefer. The h1-h6 tags are usually 
referred to as Heading Tags. 

For example: 

• Use an h1 tag for the heading or title text of your page. It is 
recommended to use only one h1 tag per page. 

• Use an h2 tag for any sub-heading text on your page. You can have 
more than one h2 tag per page. 

• Use an h3 tag for any sub sub-headings you may have on the page. 
Again, you can use more than one h3 tag on the page. 

• If you have paragraphs that you want search engines to be aware of, 
e.g. a text summary of you page’s content, use the p tag. 

It is not usually recommended to use h4-h6 tags in your page and you do not 
have to use HTML tags on pages in your site that do not require them. 

Please refer to the chapter on SEO in EverWeb for more information about 
using HTML tags and SEO. 

Scrollable Text 
The Scrollable Text option will export a TextBox that can scroll the text rather 
than auto size to the length of the text. 
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Export Text as Image 
There may be times when you do not want your text to be displayed as text on 
your page, for example, when you do not want anyone to be able to copy and 
paste the text or have your text crawled by web spiders for SEO purposes. In 
these instances, you can covert the selected text to image at the time of 
publishing by checking the ‘Export Text as Image’ option. 
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Font Substitution and External Fonts 
EverWeb makes it easy to work with different fonts and styles. To change the 
font, size and styling of your text you can use the ‘Fonts’ button in the Toolbar, 
or apply a Paragraph Style in the Text Inspector. 

Working with fonts can get problematic if you use a font in your website that 
your website visitor does not have installed on their computer. In this case your 
visitor’s web browser will substitute the missing font with an alternative, that 
tries to matching the missing font as best as possible. 

This font ‘substitution’ can cause formatting issues for your website visitors, 
especially when using a mobile device or an operating system that is different 
to your operating system. 

The font issue can be further complicated as some fonts are subject to 
licensing terms. To use these such fonts in your website may require you to 
purchase the appropriate license or to gain permission to use the font from its 
creator. Also bear in mind that even if you use have a license to use a font on 
your own computer, you may not be licensed to use it on your website. 

There are five ways around the problem with fonts that each have benefits and 
drawbacks; 

1. Use only web safe fonts. 

2. Use Google Fonts. 

3. Convert your text to an image. 

4. Use a custom font. 

5. Set up Backup Fonts in EverWeb’s Default Styles. 

It is recommended that you either use Web Safe fonts and/or Google Fonts. In 
addition, set up Backup Fonts in the Format-> Default Styles… section in 
EverWeb. See the section on Default Styles for more information. 

EverWeb makes working with Google Fonts very easy and is explained in the 
next section. 
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The other solution is to use the option ‘Export Text as Image’ in the Text 
Inspector’s Export Options section. For this to work select the TextBox you 
want to convert to an image and check the ‘Export Text as Image’ option in the 
Inspector. 

Important: The 'Export Text as Image' option will not work with full width 
TextBoxes or widgets. 

Keep in mind that this option will prevent your website visitors from being able 
to copy and paste the text and prevents search engines from being able to 
‘read’ the text that has been converted to an image. It is not recommended to 
use this option for text except for logos or critical text that needs to be 
displayed exactly the same in all browsers and all devices. 

The fourth option can get technical and also requires that you obtain the 
proper license for the font you want to use. You can actually include the font 
file in your website by following this third party tutorial on how to include 
custom fonts on your EverWeb website. 

Remember, custom fonts, even if they are included on your computer for your 
use, may not be allowed to be used on your website. Every font has different 
licensing restrictions so check with the creator of the Font if you are allowed to 
use your intended font on your website. You can usually find the creator of the 
font by Googling the font name in your web browser. 

The last option id to set up Preferred and Backup Fonts to be used when the 
font you want to use needs to be substituted. Please refer to the section on 
Default Styles for more information. 
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Using Google Fonts With EverWeb 
Google Fonts are a free and great way to include custom fonts on your website. 
EverWeb makes it really easy to work with Google Fonts. 

Google provides over 900 free fonts that you can use on your website and that 
are guaranteed to work across virtually all browsers and devices. It is your best 
option to provide unique fonts for your visitors. 

EverWeb makes it very easy to use Google Fonts on your website. All you have 
to do is follow these steps: 

1. Visit the Google Fonts web site to find the font you want to use. 

2. Once you have found the font (or fonts) you want to use, click the ‘Add 
to Collection’ button next to each font. 

3. Once you have collected all the fonts you want to use, click the down 
arrow in the top right corner to download the fonts to your computer. 

4. The fonts will be downloaded to your computer and you can simply 
double click them to install them. You may need to close and re-open 
the Fonts panel in EverWeb (or even quit and relaunch EverWeb in 
some cases) to see them in the Fonts Panel. 

5. Then just use the fonts as you normally would and EverWeb takes care 
of the rest when you publish your website. 

A detailed tutorial on using Google Fonts in EverWeb can be found here. 
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Hyperlinks Inspector 
Linking any object, such as a piece of text, 
image or shape, is very easy to do in EverWeb.  

1. Start by selecting the object you want 
to link to, for example, if you wanted to 
hyperlink a piece of text in a TextBox, 
just select (highlight) the text you want 
to link to. 

2. With the object, or text, selected, click 
on the Hyperlinks Inspector tab in the 
Inspector Window (Figure 8.17).  

3. To activate the Hyperlinks settings, 
check the box ‘Enable as Hyperlink’. 
You will now be able to select where 
the object will be linked to. You will also 
be able to use a variety of other useful 
customization options which are 
described below. 

‘Link To’ Options 
There are four ways in which an object can 
be linked: 

One of My Pages 
To link your selected object to one of your website’s Project pages select ‘One 
of My Pages’ from the dropdown menu. Next, choose the page in your Project 
file that you want to link to from the ‘Page’ drop down menu. 

Additional Options 
There are addition options that can be applied when using the ‘One of my 
Pages’ option: 
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• Behavior: You can choose to have the result of clicking on the link 
appear in the default browser window, a new browser window, or in a 
popup window. 

• You can hyperlink to a specific location on the page you are linking to 
using the Position option. Please see the section on Scroll Position for 
more information. 

• The three different hyperlink states can be styled using the Hyperlink 
Formatting options. 

• The ‘Nofollow link’ option can be applied by checking the box in the 
Additional Settings section. 

An External Page 
To ‘Link To’ a page in another website, select the ‘An External Page’ option then 
type in the URL you would like to link to in the ‘URL' field. 

Additional Options 
There are addition options that can be applied when using the ‘An External 
Page’ option: 

• Behavior: You can choose to have the result of clicking on the link 
appear in the default browser window, a new browser window, or in a 
popup window. 

• The three different hyperlink states can be styled using the Hyperlink 
Formatting options. 

• The ‘Nofollow link’ option can be applied by checking the box in the 
Additional Settings section. 

A File 
You can choose to link an object to a file, which can come from your hard drive, 
external drive, network drive or from your Cloud drive. When you select this 
option, the file will be added as an External File in your Project’s Assets List. By 
default, when clicked upon, the link file will open on screen. You can also use 
the following options 
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Additional Options 
There are two addition options that can be used when using the ‘An External 
Page’ option: 

• Behavior: You can choose to have the result of clicking on the link 
appear in the default browser window, a new browser window, or in a 
popup window. 

• Check the ‘Force Download’ option in the ‘Additional Settings’ section 
of the Hyperlinks Inspector, if you want the linked file to be 
downloaded to the visitors default download location when they click 
on the link. 

An Email Message 
You can also choose to link to an email message by entering the destination 
email address in to the ‘To’ field and the subject of your email in the ‘Subject’ 
field. When a user clicks on the link, their default email client will open with the 
email address and subject already filled in.  

Behavior Options 
Except for the Link To: Email option, you can apply a behavior to any Link To 
option. Three options are available: 

• Default: When the link is clicked upon, the result of the action will 
appear in the current browser window. 

• Open in New Window: When the link is clicked upon, the result of the 
action will appear in a new browser window. 

• Open in Popup Window: When the link is clicked upon, the result of 
the action will appear in a popup window. 

www.everwebapp.com	 ￼  of ￼126 322

http://www.everwebapp.com


EverWeb User Manual	 The Inspector Window

Formatting Hyperlinks 
If you are hyperlinking a piece of text, you can change the color of the text for 
its Normal, Mouse Down and Mouse Over states in the Hyperlink Formatting 
section. Use either the Color Swatch or Color Wheel to choose the color that 
you want for each mouse state. You can also use underlining for each mouse 
state by clicking on the underlined ‘U’ button which toggles the underline on 
and off. 
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Scroll Position 

EverWeb’s Scroll Position feature lets you easily set up ‘anchors’ on your pages 
that can be hyperlinked to a piece of text, shape or any other object that can 
be hyperlinked to. In this way, you can hyperlink to any position, on any page, 
within your website. 

There are two ways to create a Scroll Position: 

1. Insert Fixed Scroll Position: This option creates a Scroll Position line 
across the page. You can use this option only in Fixed Width websites, 
i.e. where your page use a Centered Layout; 

2. Set Shape as Scroll Position: This option allows you to add a Scroll 
Position to the currently selected shape. When you do so, an anchor 
symbol appears in the shape’s top right hand corner to indicate that it 
has a Scroll Position attached to it. Use this option for either Fixed 
Width or Responsive websites. 

These two ways of creating a Scroll Position can be found by clicking on the 
Scroll Position button in the Toolbar, or from the Insert menu. 
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How to Use Scroll Position 
As an example, you may want a button at the top of the page that, when 
clicked upon, takes your visitor to a specific paragraph further down the page 
(see Figure 8.18). 

1. First create a button, for example, by adding a rectangle shape from 
the Shapes button in the Toolbar. Position the button at the top of your 
page.  

2. Click inside the button and add the button text you want.  

3. Use the Text Inspector Alignment options to position the text in the 
center of the button.  

4. Set the ‘After Paragraph’ field to zero. 

Once you have created your button, you can link it to a Scroll Position.  

Scroll Position for Fixed Width Websites Only 

1. Once you have set up your button, click on the Scroll Position button in 
the Toolbar and select ‘Insert Fixed Scroll Position’, or use the Insert -> 
Fixed Scroll Position menu option. 

2. A light blue horizontal line appears across the width of the page near 
the the top of the body section of the page. The blue line acts as an 
‘anchor’. 

3. The Widget Settings for the Scroll Position displays in the Inspector 
Window. You can rename the default Scroll Position Name with your 
own unique name if you want. In this example, rename the Scroll 
Position as ‘Testimonials’. 

4. Click and drag the blue line ‘anchor’ to where you want it on the page 
e.g. the top of a paragraph further down the page. Notice that the line 
does not have any selection handles and is dark blue when not 
selected. 

5. If you want to delete the Scroll Position, select the blue line then press 
the backspace key to delete it. 
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Scroll Position for Responsive or Fixed Width Websites 

1. Once you have set up your button, select the object that you want to 
use as the Scroll Position. In this example, this is the FlexBox widget for 
‘Testimonials’ (see Figure 8.19). 

2. Click on the Scroll Position button in the Toolbar and select ‘Set 
Selected Shape as Scroll Position…’, or use the Insert -> Set Selected 
Shape as Scroll Position… menu option. 

3. In the dialog box that appears, enter the unique name for the Scroll 
Position. In this example, this is ‘Testimonials’. Press ‘OK’ to finish. 

4. To change or remove the Scroll Position, go to the Shape Options tab. 
Expand the Scroll Position section if it is not already expanded and edit 
the Scroll Position Name as desired. Delete the name if you want to 
remove the Scroll Position. 

5. An Anchor symbol will appear in the top right hand corner of the 
FlexBox widget indicating that the widget is now also a Scroll Position.. 
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Hyperlinking To Your Scroll Position 
Once you have set your Scroll Position line or Scroll Position Object, you will 
want to link it the button that you added earlier. The following instructions 
apply to Fixed Width and Responsive websites: 

1. Click on the text in the button you created earlier to select it. 

2. Go to the Hyperlinks Inspector and tick the checkbox ‘Enable 
Hyperlink’. 

3. Make the ‘Link To’ option ‘One of My Pages’. 

4. In the ‘Page’ section select the current page as this is where your Scroll 
Position anchor is located. 

5. The ‘Position’ field shows ‘Top of Page’. Click in the drop down and 
select ‘Testimonials’. 

6. The button and the scroll position are now linked. 

7. From the Toolbar select Preview to test that the button and scroll 
position are set up correctly before publishing. Click on the hyperlinked 
button. You should automatically scroll down to the paragraph where 
you set the scroll position at. 
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Linking to PDF files or Other Files for 
Download 
You can easily link any file, including PDF files, so that your website visitors can 
click on the link to view or download the file. 

From the ‘Link To:’ drop down menu select ‘A File’. Then from the ‘Choose…’ 
button select the the file from your computer that you would like user’s to 
download. This can be a file such as a PDF file, word document, image etc. 

The linked file will appear in the ‘External Files’ section of the ‘Assets List’. The 
file is copied into your Project’s folder and then to your server when publishing 
your website.  

Linked files are not downloaded from your actual computer, they are 
downloaded from the copy that EverWeb has published to your website. 
Additional Settings 

See also Force Download below. 

Force Download 
The ‘Force Download’ option, when checked, will initiate a file download of the 
linked file to the default download location of the device your visitor is using.  

For example, you may want to add a link to your site that lets your visitors 
download a PDF file. By default, ‘Force Download’ option is not checked so the 
PDF file will open in the visitor’s browser window. If ‘Force Download’ is 
checked, the PDF file will be downloaded locally to the default file download 
location. 

Note that the use of Force Download depends on whether the web browser your visitor uses 
respects this setting or not. 
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Nofollow Link 
When you link to page. you are implicitly telling your visitors. or search engines, 
that this is a recommended page by you. Sometimes this may not always be 
the case e.g. linking to a competitor website or page. 

For your actual visitors, the context of your link could indicate that this isn’t 
actually something you recommend. However, search engines will still believe 
you are vouching for this linked page.  

By selecting ‘Nofollow link’ you are essentially telling search engines that you 
don't actually vouch for this page and that you don’t want to pass your 
website’s reputation to this page.  

This is important because if you link to a page with a bad reputation according 
to search engines, it can negatively affect your page’s reputation and in turn 
lower your search engine rankings. 

Select this option when linking to a page you don’t particularly trust or 
recommend. 
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Widget Settings 
The last tab of the Inspector Window is the Widget Settings tab. The settings 
that this tab contains will depend on the object that is currently selected. 

Widget Settings can apply to objects such as widgets, some shape objects 
such as the star shape and blog posts. 
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9The Assets Tab

The Assets Tab is where image and other media files, 
such as audio, video and PDF files, are listed and 
available for use in your website project.

The Assets List

Asset List Organization

The Media Browser

Free Stock Photos
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The Assets Tab 
The Assets List 
Images files and other media such as audio, video and 
PDF files, that are added to your website appear as 
‘assets’ in the Assets List of the Assets Tab (Figure 9.1).  

You can add any type. of image file to the Assets List. First 
click on the Assets tab if it is not already selected, then 
drag and drop the image(s) you want added from its file 
location in to the Assets List. 

There are many ways to add images to your website. For 
example, you can drag the image from your desktop onto 
the Editor Window, you can drag the image from the 
macOS Finder window on to the Editor Window or you 
can use the Insert-> Choose menu option and select the 
image you want to add.  

You can also add an image by adding a TextBox or shape: 

1. Add a TextBox or shape to your page (any shape 
will do). 

2. Click on the Shape Options tab in the Inspector 
Window 

3. Select ‘Image Fill’ from the drop down menu.  

4. Click on the ‘Choose…’ button. A list of image files 
will appear. If the image file is not yet in the 
Project file, select the ‘Choose…’ option which will 

open the Finder window so that you can select the image that you 
want to use.  

Note that the same method can be applied for adding an image to the Page 
and/or Browser Background. 
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Any image in the Assets List can be used on any page of your website just by 
dragging it from the Assets List and dropping it on the Editor Window. The 
same image can be used multiple times throughout your site. You do not 
need to add the image again to your website every time you want to use it. 
When you add an image to a page, it remains in the Assets List so is available 
for use on any page in your website. 

Assets can be organized conveniently into folders making it quicker and easier 
to group, and find, the images and assets you want to use. 

Image files can be previewed using the ‘eye’ icon, or by selecting the image 
asset and pressing the spacebar, where you can preview, share and even edit 
the image without having to leave EverWeb to do so. 

Assets List Organization 

Image files and other media assets, such as audio, video, PDF files etc., can be 
conveniently organised in to folders. Organising assets is especially useful 
when you have a website with a large number of assets, or if you want to 
organize your assets based on the pages you have created in your website. 

Use the Asset List Organizer (see Figure 9.2), located at the top of the Assets 
List, to search for assets, add and delete Assets List folders and to access Assets 
List related options using the Settings Cog/Button. 

In addition to the search box, the Assets List Organizer has thee buttons: 

• The ‘+’ button allows you to add a new folder to the Assets List 

• The ‘-‘ button allows you to delete a folder, or one or more assets, from 
the Assets List 
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• The Settings Cog/Button displays a menu of actions specific to the 
Assets List: 

• Sorting the Assets List contents 

• Finding unused assets 

• Displaying detailed information about individual assets. 

Creating an Assets List Folder 
To create a new Assets List folder: 

1. Click on the Assets tab in the Inspector Window if the Assets List is not 
currently displayed. 

2. To create a folder in the ‘Images’ section of the Assets List, either select 
the title ‘Images’, an existing folder in the Images section, or one of the 
image assets in the Images list. 

3. To create a folder in the ‘External Files’ section of the Assets List, either 
select the title ‘External Files’, an existing folder in the the External Files 
section, or one of the files in the External Files list.  

4. Click on the ‘+’ button to create a new folder. 

5. Enter the name of the folder. You can use letters, numbers and a 
variety of special characters. If you enter characters that are not 
allowed, these will be ignored. Click on the ‘OK’ button to finish. The 
folder will be created and located. 

6. The folder will be created at the top of the Assets List unless you have 
created a subfolder. In this case, the new folder will be inside the 
patent folder. To create a subfolder highlight a folder in the Assets List, 
then click on the ‘+’ button. Name the folder as in the above step. 

7. You can also create a new folder by secondary clicking in the Images or 
External Files section. A menu will appear. Click on the 'Add Folder' 
option and continue with step 5 above. 
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Renaming a Folder 
To rename a folder, double click on its name. Edit the name and press 'Enter' to 
finish. 

Moving Assets List Subfolders 
You can move subfolders out of their parent folder, or into other folders, just by 
dragging and dropping the folder to its new location. 

Adding and Moving Assets 
Assets can be added to, moved, and removed from, a folder by drag and 
dropping the asset file to its new location. You can also drag and drop multiple 
asset files at one time. 

To add an asset in to a folder, drag it from its current location in the Assets List 
and drop it on top of the folder. The file will be added to the folder. If you 
already have files within the folder and the folder itself is open, you can drag 
and drop the file on top of the files that are within the folder. 

To move an asset from a folder, drag it to the left of the triangle symbol. The file 
will be relocated one level up. To move a file back in to the main Asset List, 
make sure that you move it left of the left most triangle symbol. 

To move a group of assets that are listed one after each other in the Assets List, 
click on the first asset in the list, then Shift+Click on the last asset you want to 
move in the list. Drag and drop the highlighted assets to their new location. 

To move files that are in different locations in the Assets List, click on the first 
asset you want to move, then press Command+Click on each of the other 
assets in the list that you want to move. When you have finished selecting the 
assets, drag and drop the highlighted assets in to the folder where want you 
them.  

Creating a Folder for Assets on the Current Page 
EverWeb lets you easily and automatically add all of the image assets on a 
page in to a folder. 
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1. Start by selecting the page you want to create an Assets List folder for. 

2. Click on the Assets Tab.  

3. Click on the Settings Cog/Button and choose the option ‘Select All 
Assets On Current Page’.  

4. You will notice that all of the image assets on the current page will be 
highlighted in the Assets List. 

5. Now click on the ‘+’ button to add a new Assets List folder. 

6. Name the folder as required e.g. the name of the current page. 

7. The selected assets will now be added in to your new folder. 

Deleting an Assets List Folder 

You can delete a folder from the Assets List in a number of ways. First highlight 
the folder you want to delete in the Assets List then either: 

• Click on the ‘-‘ button in the Assets List Organizer.  

• Press the backspace key or 

• Secondary click on the folder and select the ‘Delete Folder’ option.  
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In all cases, a dialog box will be appear with options to ‘Delete Folders & 
Contents’, ‘Delete Folders Only’ or ‘Cancel’. Select the option of your choice 
(See Figure 9.3). 

If you select ‘Delete Folders Only’, any assets the folder contains will be moved 
to the next folder level up in the Assets List.  

Displaying Assets List Folders 
When you add a new folder to the Assets List, it will be empty and the folder 
will be displayed as closed, which is shown by the triangle symbol pointing to 
the right, towards the folder name. You can toggle the folder open or closed at 
any time by clicking on the triangle. When the folder is open (see Figure 9.1), 
the triangle points downwards and the folder contents are displayed. 

Previewing Image Files 
Clicking on EverWeb’s Assets List Preview ‘eye’ icon allows you to: 

1. Preview the selected image file. 

2. Access Apple’s Preview app where you can edit the image directly 
without having to leave EverWeb. 

3. Share the image file using the Share Sheet icon. 

4. Display the image preview at full screen or at a size you want by 
dragging the corners of the Asset Preview window. 

The Assets List Settings Cog/Button 
The Assets List Settings Cog/Button allows you to 

1. Set the sort order of the Assets List 

2. Display detailed file information about image file assets such as file size 
and image dimensions 

3. Locate any any assets that are not used in your website project so that 
you can delete unwanted assets if desired. 
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Replacing an Asset 
You can replace an image asset with a different image using the Assets List. 
This  action will replace the image file with the new one of your choice whilst 
keeping the original asset’s settings in tact (e.g. size, position and location). To 
access the Replace Assets feature: 

1. Go to the Assets Tab 

2. Secondary click on the image asset you want to replace. 

3. A contextual menu will appear. Click on ‘Replace Asset’. 

4. Choose the new image file that you want to replace the existing file. 

5. The original image will be replaced throughout your site with the new 
image. The settings used for the original image will remain intact. 
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The Media Browser 

• The Media Browser (see Figure 9.4) 

• The free Stock Photos library. 

You can add images to your website from media 
locations such as Apple Photos. You can drag and 
drop additional folders onto the Media Browser so 
you can access images from any accessible folder 
location.  

Whenever you want to add an image from the 
Media Browser simply drag and drop the image 
either on the Editor Window or in to the Assets List.  
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􀣵
In addition to the Assets List, the Media Browser in EverWeb’s 
Toolbar can be used to access images and other media.  

If you click on the ‘Media’ button, you will see a sub menu 
displayed with a choice of two options:
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Free Stock Photos 
EverWeb allows you to easily access over half a million free to use stock photos 
that can be included in your website. To add a Stock Photo to your page: 

1. Go to  the Window-> Stock Photos… menu option or click on the Media 
button in the Toolbar and select ‘Free Stock Photos’.  

2. The Image Search window will open with a search bar at the top. 

3. Enter the word(s) that you are searching for e.g. ‘Cat’ and press Enter to 
perform the search.  

4. Images that match your search criteria will be displayed below the 
search bar. If no results are found, the Image Search window displays 
the text ‘No Results Found’. 

5. Drag and drop the image that you want to use onto the Editor 
Window.  

6. To add a Stock Photo in a blog post, first make sure the blog post you 
want is selected, then drag and drop the image from the Image Search 
box onto the Blog Post Editor Window or Blog Post Preview Window. 

7. To add a Stock Photo to the Assets List, first select the Assets tab, then 
drag and drop the Image you want from the Image Search box into 
the Assets List. The saved image can then be used later. 

8. Images in the Assets List are named after the search criteria. 

You can keep the Stock Photos search window open whilst working on your 
website. If you want to bring the Stock Photos search window to the front, just 
use the Window-> Image Search option. 

When you quit EverWeb, the Image Search window also closes. When you 
enter EverWeb the next time, you will need to reopen the Stock Photos Image 
Search window again to use it. 
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10The Widgets Tab

Widgets are like mini-apps that allow you to easily add 
extra features and functionality to your website without 
having to code.

The Widgets Tab

Widget Organization

EverWeb’s Default Widgets
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The Widgets Tab 
EverWeb includes a number of built in ‘widgets’. A 
widget is like a mini app that allows you to easily add 
extra features you may want to your website (see 
Figure 10.1). For example, use the Navigation Menu 
widget to create a simple, dropdown or responsive 
menu system for your website. You can use the 
PayPal widget for E-Commerce, the Image Slider and 
Image Gallery widgets to display images in a number 
of different ways and so on. 

Adding a widget to your web page is easy: 

1. Select the page on which you want to add the 
widget. 

2. Next select the Widgets tab in the Inspector 
Window on the right hand side. 

3. Find the widget you want to use and drag and 
drop it on to the Editor Window. 

4. Size and position the widget as required. 

5. Use the Widget Settings in the Inspector 
Window to customize the widget, or setup 
widget specific defaults, as you want. 

Accessing a Widget’s Widget Settings 
Once you have added a widget to your page, or 
whenever the widget is selected, you will see its 
settings and features displayed in the Widget Settings tab in the Inspector 
Window.  

Alternatively, you can access the widget’s settings and features by clicking on 
the Settings Cog located in the top left hand corner of the widget itself.  
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Widget Organization 
EverWeb includes a number of built in widgets. Additional widgets are 
available, either free or to purchase, from third party widget providers. You can 
easily add widgets to the Widgets tab as described below. 

If you have added third party widgets into EverWeb, you may want to organize 
the Widgets Tab so that they are easily accessible. 

Widget Category Settings and Search Box 
Directly beneath the Widgets Tab, are the Widget Category Settings (Figure 
10.2) which includes the Category List drop down menu, the Remove Category 
button, the Category Settings button and the Add Category button. These 
features allow you to organize and manage your widgets. Beneath the Widget 
Category Settings is the Search bar which you use if you want to quickly search 
for a specific widget. 
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Widget Category List 

The Widget Category List dropdown (Figure 10.3) contains two predefined 
widget categories that cannot be deleted. The Widget Category List includes 
any categories you have created under the predefined categories.  

Click on the Category List dropdown to select the category you want displayed. 

• The ‘All’ Category 
The ‘All’ category displays all of the widgets that have been installed on 
your computer. You can add, move and delete third party widgets in to 
this category. You cannot remove EverWeb’s set of default widgets. 

• The ‘Default’ Category 
The ‘Default’ category lists only EverWeb’s preinstalled widgets. You 
cannot add, move or delete these widgets from this category. If you 
have no third party widgets installed on your computer, the ‘All’ and 
‘Default’ categories will look the same. 

• User Created Categories 
If you have created your own categories, these are listed below the ‘All; 
and ‘Default’ categories. You can rename a user created category, add 
third party widgets into the category, remove widgets from the 
category and delete the category itself using the controls immediately 
beneath the Widgets tab (see Figure 10.2). 
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Adding Widgets to the Widgets Tab 
To add third party widgets to the Widgets tab, just drag and drop the widget(s) 
you have downloaded on to the Widgets tab.  

If the widgets you want to add are in a folder, you can drag and drop the folder 
itself on to the widget list. When you do this, EverWeb will create a new 
category with the same name as the folder. All of the widgets in the folder will 
be placed within the newly created category. 

Creating a New Widget Category 

To create a new Widget Category: 

1. Click on the Add Category ‘+’ button in the Widget Category Settings 

2. A dropdown will appear asking you to enter the name of the Widget 
Category you want to create (Figure 10.4).  

3. Enter the name you want then click the ‘OK’ button to finish. 

4. If you try to create a category that already exists, EverWeb will ask you 
to enter a unique category name. 
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Once you have created a new category, it is added to the Category List. If you 
click on the category you have just created you will see that it contains no 
widgets. 

Renaming a Widget Category 

To rename a Widget Category: 

1. Select the category you want to rename from the Widget Category List 

2. Next, click on the Category Settings Cog/Button. 

3. A drop down will appear (see Figure 10.5) where you enter the new 
name for the Widget category.  

4. Click the ‘OK’ button when finished.  
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Adding Widgets in to a Category 
There are a number of ways to add widgets to a Category: 

1. Move the widget from one category to another.  

1. Secondary click on the widget you want to move.  

2. The ‘Move To’ submenu will appear. Mouse over the ‘Move To’ menu 
option so that the Category List appears.  

3. Click on the Category you want to move the widget to.. The Widget will 
be moved to the category you have selected.  

4. Note that if you are performing this operation from the ‘All’ Category, 
the widget will still appear in the List as well as in the Category you 
have moved the widget to. Remember that widgets cannot be moved 
from the Default Category List. 

2. Drag and drop third party widgets directly in to the Widgets tab. 

1. First select the category that you want the widget to be included in. 

2. Drag and drop the widget into the Category. Remember that any 
widgets added  will always appear in the ‘All’ Category List. 

3. Drag and drop third party widgets in a folder directly in to the Widgets tab. 

1. The Folder name is used to create a new Widget Category, therefore, 
name the folder as the name of the Category that you want to create. 

2. Drag and drop the folder containing the widgets into the Widgets 
List..A new category will automatically be created that contains the 
widgets in the folder. 
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Deleting Widgets 
To delete a widget from a category, secondary click on the widget and select 
‘Delete’ from the menu. When you do this, you will be asked to confirm the 
deletion. The dialog box also states that when you delete a widget it will be 
placed in the Trashcan. 

If you delete a widget by mistake, go to the Trashcan and drag and drop the 
widget back on to the Widgets list. 

Only third party widgets can be deleted. It is recommended that you back up 
any widgets free or purchased third party widgets in case you need to restore 
them for any reason at a later date. 

Deleting a Widget Category 

To delete a Widget Category,  

1. Click on the Remove Category ‘-‘ button. 

2. A dropdown will appear asking you to confirm your actions (Figure 
10.6). There are three choices: 

• Select ‘Delete Widgets’ to delete the Widget category and the 
widgets in the category from EverWeb. If you delete the widgets 
by mistake, open the Trashcan on your computer and drag and 
drop the widgets back in to the Widgets list. 

• Select Cancel to stop the category deletion 
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• Select ‘Keep Widgets’ to move the widgets from the category that 
is being deleted to another category. 
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EverWeb’s Default Widgets 
EverWeb includes built in ‘default’ widgets. Each widget is described below in 
detail in the order in which it appears in. the Widgets tab. 

Some of the widgets listed are categorized to help you identify when the 
widget can be used in Fixed Width, Responsive or both page layout styles. 

[Full Width Capable] 

Most widgets, such as the YouTube Video and Google Maps widgets, can be 
used as Full Width objects in Fixed Width and Responsive page layouts. Use 
the Full Width checkbox in the Metrics Inspector to toggle Full Width 
capability on or off as required.  

Full Width capable widgets can be used as Section objects in their own right in 
a responsive page layout when ‘Full Width’. If the widget is not to be used at 
Full Width in a responsive page layout, it must be embedded in to a 
Responsive Row widget in order to work correctly. 

[Responsive] 

Some EverWeb’s Widgets, such as the Responsive Row and FlexBox widgets, 
are designed specifically for use only in a Responsive Page Layout. Whilst these 
‘Responsive’ widgets can, in theory, be used in a Fixed Width page layout, it is 
not recommended or supported. 

Uncategorized Widgets 

Where a widget has not been categorized as either ‘Full Width Capable’ or 
‘ResponsiveOnly’, the widget is not Full Width capable e.g. the PayPal widget.  

In this instance the widget can be drag and dropped anywhere on your page 
when using a Fixed Width Page Layout. 

When using a Responsive Page Layout, the widget must be embedded in a 
Responsive Row widget in order to work correctly. 
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Navigation Menu Widget [Full Width Capable] 
EverWeb’s built-in navigation menu makes it easy to add a navigation menu 
that links to some, or all, of the pages of your website. Simply drag and drop 
the Navigation Menu widget onto the Editor Window. A menu with links to 
some, or all of the pages on your site will appear. 

Navigation menus can either be simple, dropdown or responsive. 

You can modify your navigation menu settings using the Widget Settings tab 
in the Inspector. On this tab, you can change the navigation menu’s 
alignment, padding, spacing, and minimum width.  

If you have created a dropdown navigation menu you can change the 
background color and the mouse over color for the submenu. 

If you have set the navigation menu to be responsive, you can set when the 
navigation changes from a menubar to a hamburger style icon and the styling 
of the hamburger icon. 

To change the font type and font size of the text, click on the Fonts button in 
the Toolbar and make your changes. If you are using a responsive navigation 
menu, use the options in the Hamburger Button section of the Widget 
Settings instead. 

To change the text color of the navigation menu, and the Rollover and Visited 
colors, use the Hyperlinks tab. In the Hyperlink Formatting section click on the 
color swatch next to the option you want to change (e.g. ‘Rollover’) and select 
the color you want to use. You can also select if link to be underlined. 

Tip: If you do not want a page included in the navigation menu, go to the Inspector Window. 
Click on Page Settings tab. In the Page Details section, uncheck the ‘Include in navigation 
menu’ option. 

RSS Feed Widget 
The RSS Feed widget allows you to place a third-party website’s RSS feed on 
your website. This allows you to provide your website visitors with updated 
content, without having to do anything.  

To use the RSS Feed widget, simply drag and drop the widget onto the editor. 
On the Widget Settings tab, paste or type in the URL for the feed you want 
displayed on your website. 
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You can adjust the widget on your site so that it is bigger, smaller, wider, or 
more narrow. You can also play around with the rest of the settings on the 
Widget Settings tab until you are satisfied with the way the RSS feed is 
displayed on your website. 

Image Gallery Widget 
Instantly create image galleries to show off your photography, art, family or 
more. EverWeb automatically creates professional image galleries for your 
website with the Image Gallery widget. 

Responsive Row Widget [Responsive] 
The Responsive Row Widget is only used in a Responsive Page Layout. The 
widget acts as a container that allows you to add text, shapes, images, media 
and widgets to a responsive web page.  

The Responsive Row Widget is useful for adding any number of elements that 
should be adjusted vertically as the browser window is resized to a smaller 
width. Objects will align horizontally or vertically so they can fit within the 
browser size dimensions without requiring the website visitor to scroll 
horizontally. 

The goal of the Responsive Row Widget is to allow any object - text, images, 
widgets etc… - to be added to a responsive website without having to actually 
be responsive themselves. As well, to allow multiple objects to appear 
horizontally on your webpage if the browser can it them. Otherwise they are 
displayed vertically. 

For more information please refer to the ‘Responsive Websites in EverWeb' 
chapter. 
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Audio Widget [Full Width Capable] 
The Audio widget supports the HTML5 Audio Player so you can add MP3 files 
to your web page. You can set the default playback volume, and there are also 
options for looping, autoplay on page load and muting the audio. 

Contact Form Widget [Full Width Capable] 
To add a contact form to your website, drag and drop the Contact Form widget 
onto the Editor Window. In the Widget Settings, enter your email address in 
the ‘Email Address’ field. This is very important as this is the email address that 
will receive any of the messages submitted using this contact form. You can 
edit the fields on the Contact Form to add different fields other than the ones 
on your form. For example, if you wanted users to submit their full names, you 
could change the ‘Name’ field from “Name:” to “Full Name:” This will display 
Full Name and users using your form will know to enter their full names. 

Contact Form Advanced Widget [Full Width Capable] 
Contact Form Advanced lets you create highly customized forms. You can add 
drop down menus lists, tick box lists, radio buttons and much more to your 
form. The widget lets you add extra fields e.g. you could create a ‘Special 
Greetings’ field and pre-fill it with default text e.g. ‘Add your special greeting 
here!’ to help your visitors complete the form. Contact Form Advanced is 
perfect for sales orders, customer surveys or any time when you need a flexible, 
highly customisable form solution. 

Contact Forms Enhanced Addon is the perfect addon to Contact Form 
Advanced widget for managing and reporting your contact form submissions. 
See the Contact Forms Enhanced Addon chapter for more details. 

FaceBook Like Widget 
If you have a Facebook page, you can place a Facebook Like button on your 
website. Just drag and drop the Facebook Like widget onto the Editor. On the 
Widget Settings tab, enter your Facebook Page URL. 

Please note that for some visitors, this widget may not be visible due to GDPR 
rules being applied in the visitor’s country, 
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FaceBook Page Timeline Widget 
If you have a Facebook page, you can display it on your web page using this 
widget. Drag and drop the widget onto the Editor and enter your Facebook 
Page web address. Use the Widget Settings tab to customize the look of the 
widget. 

Please note that for some visitors, this widget may not be visible due to GDPR 
rules being applied in the visitor’s country, 

FlexBox Widget [Responsive] 
The FlexBox widget allows you to combine styled text, images, video and 
buttons in the combinations of your choice for a responsive layout that adjusts 
its layout depending on the screen size.  

The widget is highly customisable including mouse overlay effects and object 
wrapping options for incredible design flexibility. 

The FlexBox widget is extremely useful in a Responsive website as it adjusts its 
contents to the size of the browser window. 

Google Maps Widget [Full Width Capable] 
To add a map to your website, drag and drop the Google Maps widget onto the 
editor. On the Widget Settings tab, enter the address for the location you want 
the map to display. When you are done, click the Apply button. You can 
increase, or decrease, the size of the map to suit your needs. 

Heading Tags Widget [Full Width Capable] 
Easily add HTML Heading Tags to your EverWeb pages using the Heading Tags 
Widget. You can style the Heading Tag to match your web page by just using 
the Fonts Panel and the Color Picker. 
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HTML Snippet Widget [Full Width Capable] 
The HTML Snippet is possibly the most powerful widget as it allows you to add 
almost anything to your website. Anytime you want to embed, or add an item 
to your website, if you are given an HTML script for that item, you can just paste 
it in to the HTML Snippet widget. 

Tip: The HTML Snippet widget lets you add any type of code to your website which makes it 
powerful and a potential cause of publishing problems if your enter incorrect HTML Code. 
Make sure you know what the code is doing when using the HTML Widget! 

Image Slider Widget [Full Width Capable] 
The Image Slider widget creates a slideshow of images that can be set to 
transition from one image to the next. Drag the image slider onto your 
webpage and then add images using the ‘Choose…' button. 

Live Photo Widget 
Add Live Photos from your iPhone to your website. From the Photos app select 
the Live Photo you want, then go to File-> Export Unmodified Original Photo. 
Add the resulting .JPG and .MOV files to the Live Photo widget!  

PayPal e-Commerce Widget 
The PayPal e-commerce widget lets you add either PayPalPayPal Buy Now 
buttons or a fully featured Shopping Cart. You can even add a ‘Donate’ button. 
The PayPal widget is highly customizable so that you can add your own 
product descriptions, images and customized pay buttons. 

PayPal Modern e-Commerce Widget 
The PayPal Modern e-commerce widget uses your PayPal Client ID. You can 
use the widget for purchases or subscriptions. The PayPal Modern widget 
allows you to choose a number of different payment sources and the widget is 
highly customizable so you can add your own product description and image. 

. 
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Pinterest Pin It Widget 
Use this widget to add a Pin It button to your page. To pin something on your 
page, click the Pin It button and then select the image you want. 

Responsive Image Gallery [Responsive] 
Six different layout styles let you create dynamic Image Galleries for your 
responsive website with this highly customizable widget.  

Search Field Widget [Responsive] 

Use this widget to enter and format website search criteria. Search results can 
be displayed in a drop down menu format, in a popup window or on a different 
page by setting the ‘Search Results’ field to ‘One of My Pages’ and using the 
Search Results widget in the page you choose to display the results upon. 

Search Results Widget [Responsive] 

Use this widget to display search results found using the Search Field widget 
on a separate page in your website. This widget can only be used in 
conjunction with the Search Field widget when the Search Field widget’s 
Search Results field is set to ‘One of My Pages'. 

Stripe Payment Widget [Responsive] 
The Stripe Payment widget is an e-commerce widget lets you add products 
(purchase or subscription) that you have added in Stripe itself to your page. 
The fully featured widget includes a customizable Buy Now button. 
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Text Section Widget [Responsive] 
Combine text, images and buttons together to create flexible responsive layout 
designs. The widget has an incredible range of styling options including an 
option to include multiple buttons. 

X (formerly Twitter) Follow Me Widget 
This widget allows you to add an X (formerly Twitter) Follow Me button to your 
page. Simply drag and drop the widget on the editor, and on the Widget 
Settings tab, enter your Twitter handle.  

Video Widget [Full Width Capable] 
If you want to add in MP4 Video, WebM or OGG video content to your website, 
this is the widget you need! 

Vimeo Widget [Full Width Capable] 
The Vimeo Video widget lets you easily embed Vimeo Video content to your 
website. 

YouTube Video [Full Width Capable] 
To embed a YouTube video on your website, you can drag and drop the 
YouTube Video widget onto the editor. On the Widget Settings tab, type in or 
paste the link for the YouTube video you want to embed. When you are 
finished, click the Apply button. You can modify the size of the video to suit 
your needs. 
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11Blogging

EverWeb includes a powerful, fully integrated and 
feature rich blogging environment so you can create 
the blog that you’ve always wanted.

Creating a Blog

The Blog Main and Archive Pages

The Blog Posts Window

Importing Blog Posts In To EverWeb

The Blog Editor Window

The Blog Preview Window

Adding Commenting to your Blog

RSS Features and Blogging
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Blogging 

EverWeb lets you easily create your own online journal with its powerful, easy 
to use, blogging environment (see Figure 11.1). Your journal, known as a ‘blog’, 
can include one or more articles, known as ‘posts’. Posts are great for writing 
longer, in depth articles that you want to keep separate from your regular web 
pages. Posts can also be short articles too, e.g. news items or announcements.  

You can format your blog posts in a number of different ways to suit your style. 
Blog posts are listed in an ‘Index’ page which shows your latest posts. Older 
posts can be accessed from a built in ‘Archive’ page. 

This chapter describes EverWeb’s blogging environment when using a Fixed 
Width page layout. If you want to design a responsive blog, or want to convert 
an existing Fixed Width layout blog to a responsive design, please refer to 
Responsive Blogging in the Responsive Websites in EverWeb chapter for more 
information. 
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Blogging Basics 
Creating a Blog 

Click on the ‘blog’ page from the template pages on the right hand side then 
click the ‘Select’ button.  

Your blog will be created in the Web Page List on the left hand side of the 
EverWeb User Interface. 

The blog has three pages (see Figure 11.2): 

• The Blog Main page is a directory page that acts as the blog’s ‘Index’ 
page. The Blog Main page lists the most recent blogs that have been 
created. The Blog Main page contains the ‘Posts’ page and the ‘Archive’ 
page. 

• The Posts page is where you create, edit, 
format and manage your blog posts and 
is the page you will probably use the 
most. 

• The Archive page is where older posts are 
listed. 
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Figure 11.2: EverWeb’s Blog 
Structure in the Web Page List

To create a new blog, click on the ‘Add Page’ button in the 
Toolbar. In the Template Chooser, select a Theme from the left 
hand column that has a ‘blog’ page or select the ‘Blank’ Theme 
Template to design your own blog theme.  
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Renaming a Blog 
To rename your blog, just double click on the word ‘blog’ in the Web Page List 
and overtype it with a new name. Press enter to finish. Alternatively, use the 
File-> Rename menu option. 

You can only change the name of the Blog Main page. The ‘posts’ and ‘archive’ 
pages cannot be renamed. 

Deleting a Blog 
Deleting a blog works in the same way as deleting any other pages in 
EverWeb. Click on the Blog Main page in the Web Page List, then press the 
backspace key on your keyboard. 

Warning! Deleting the Blog Main page will delete the whole blog structure. The Blog Main 
Page, the archive page and ALL of the blog posts will be deleted! 

If you delete the Blog by accident, immediately press Cmd+Z to undelete it. 
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The Blog Main & Archive Pages 

The Blog Main and Archive pages use a special type of’ widget’ to display the 
list of blog posts that have been created. Blog posts are displayed in date order. 
The latest blog post is at the top of the list and the oldest at the bottom (See 
Figure 11.3). Each blog post displayed shows the blog post’s Title. You can 
optionally show the date the post was published under the Title and some of 
the blog post’s text if you want. 

The widget has selection handles on each side so that you can change the 
width of the widget as you want. The height of the widget adjusts 
automatically as you change the Widget Settings, add new blog posts, or other 
formatting such as font size. 
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Figure 11.3: The Blog Main page showing a list of blog posts. The whole list is contained in the Blog 
Main ‘widget’ that has a selection handle on each side. The Widget Settings are shown on the right.
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Customizing The Blog Main & Archive 
Pages 

The Blog Main and Archive pages are customized in the same way as each 
other. In this example, to customize the Blog Main page, first click on the ‘blog’ 
page in the Web Page List. 

If you do not see the selection handles on either side of the widget, click once 
inside the widget to display them. Next select the Widget Settings tab (see 
Figure 11.4) in the Inspector Window. You now have a number of options 
available to customize the look of the widget e.g. to display only the first 100 
characters of your blog post’s text change the Article Length setting from 150 
to 100. If you want to include pagination buttons check the ‘Show Pagination 
Buttons’ box and so on. 

You can easily change the text formatting options of the widget. First click on 
the Fonts button in the Toolbar. With the Fonts Panel on screen, double click 
on either a blog post title, a blog post date (if you have it displayed), the text of 
a blog post, or the full archive link or pagination. buttons if you have added 
these to the page. All of the same items will be highlighted e.g. all of the blog 
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highlighted so you can apply formatting to them all at the same time.
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post titles (see Figure 11.4). Select the fonts you want to use for the selected 
item from the Fonts Panel. 

Formatting Blog Post Titles 
Blog post titles are actually hyperlinks to the blog posts themselves.  

That’s why they’re displayed in the default hyperlink styling of blue, underlined 
text. To alter the hyperlink colors and underlining, first select the Titles as 
described above.  

Next go to the Hyperlinks tab in the Inspector Window. In the Hyperlinks tab 
you can set the color and underline for normal, hover and visited states.  

For more information please see the section on the Hyperlinks tab. To change 
the font styling of the Titles use the Fonts Panel as described above. 

Formatting Blog Post Dates & Content 
Summaries 
Just as with blog post Titles, double click on any post date or content summary 
to change its formatting. Once selected, click on the Fonts button in the 
Toolbar to open the Fonts Panel to make your changes. 

www.everwebapp.com	 ￼  of ￼169 322

http://www.everwebapp.com


EverWeb User Manual	 Blogging

The Blog Posts Window 

The Blog Posts window is the heart of your blogging experience in EverWeb. It 
has four sections (Figure 11.5): 

1. The Blog Posts List at the top lists all of the blog posts you have created 
(see Figure 11.5 - Section A). Click on the post you want to be able to 
edit it. This section also allows you to add new blog posts, delete posts, 
edit the post’s keywords and short summaries and import blog posts 
from iWeb and WordPress. 

2. The Blog Editor Window in the middle is where you add the blog post’s 
text. You can also add images, hyperlinks and lists as well as text 
formatting for your post (see Figure 11.5 - Section B). 

3. The Blog Preview Window at the bottom is where you see the 
formatted blog post including the blog post title, date, pagination and 
comments section if you have included these (see Figure 11.5 - Section 
C). 
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Blog Preview window. and the Blog Post Widget Settings 
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4. The Widgets Settings tab is where you can change the styling settings 
for individual blog posts or all your blog posts (see Figure 11.5 Section 
D). 
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The Blog Posts List 
The Blog Posts List is where all the blog posts you have created are listed and 
managed. 

Creating a Blog Post 
Once you have created a blog, click on the Posts page in the Web Page List to 
add posts to your blog. The first blog post has been automatically created for 
you. To add more posts, click the ‘New Post’ button and enter the blog post 
title. Press enter to finish creating the new post. 

Adding Short Summaries to a Blog Post 
To access a blog post’s Short Summary text, click on the Settings Cog then 
select ‘Post Options…’ from the menu. The Short Summary lets you create a 
summary of the blog post without having to display the contents of the post 
itself.  

The Short Summary, when used, replaces the summary in the blog main or 
archive page. 

Adding Keywords to a Blog Post 
To access a blog post’s Keywords, click on the Settings Cog then select ‘Post 
Options…’ from the menu. Adding Keywords to your blog post is useful for SEO 
purposes. Using good Keywords can help boost your SEO results page 
rankings. See the chapter on SEO for EverWeb for more details about using 
SEO techniques in your website for better search engine ranking results. 

Drafting a Blog Post 
When you create a blog post, you may not want it published when you publish 
your website as it may be finished yet! If this is the case, tick the checkbox in 
the ‘Draft’ column for the post that you do not want to publish yet. When you 
are finished writing the post and want it published, just uncheck the Draft 
checkbox. 
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Duplicating a Blog Post 
To duplicate a blog post, secondary click on the blog post you want to 
duplicate, then select ‘Duplicate’ from the menu.  

Deleting a Blog Post 
To delete a blog post, click on the post you want to remove in the Blog Posts 
List then click the ‘Delete Post’ button. 

Renaming a Blog Post 
To rename a blog post, double click on the blog post’s name in the Blog Posts 
List and type over the name that’s there already. Press enter to finish. 
Alternatively, highlight the blog post and use the File-> Rename menu 
command if you prefer. 

Changing the Blog Post Date and/or Time 
To change the date and/or time the post was created, double click on the blog 
post date in the ‘Date’ column and enter the new date and/or time. Click 
outside of the calendar window to finish. 

The post date/time can also be synchronised to the date and time that the 
website is published by ticking the ‘Use Website Publish Date’ field. 

Changing the Blog Posts List Sort Order 
To sort the Blog Posts List in ascending or descending alphanumeric order, 
click on the words ‘Blog Posts’ to toggle the sort order. Click on‘Date’ to sort 
the blog posts from newest to oldest or oldest to newest. 

Resizing the Blog Posts List 
The Blog Posts List can be resized to display more, or less, blog posts. Move 
your mouse pointer to the line between the bottom post in the list and the row 
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of buttons. The cursor will change to a splitter line. Click and drag up or down 
the splitter line up and down as required then release the mouse button when 
you are done. 
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Importing Blog Posts Into EverWeb 
EverWeb can easily import blog posts from other sources such as iWeb or 
WordPress using the ‘Import’ menu option from the Settings Cog/Button in 
the Blog Posts List (see Figure 11.5 - Section A). If you are using EverWeb 3.9 or 
higher, you can also use the File-> Import menu option. 

You should already have created a blog within EverWeb so that you can then 
import your existing blog posts from iWeb or WordPress. 

Importing Blog Posts from iWeb 
1. Before importing your iWeb blog entries into EverWeb, first use iWeb 

to publish your iWeb website to a folder on your local hard disk. 

2. After publishing your iWeb website to a folder, click on the Settings 
Cog/Button in EverWeb’s Blog Posts List Window, then select ‘Import…’ 
from the menu. 

3. Alternately, you can use the File-> Import-> iWeb Blog Posts menu 
option, Once you have chosen this option, skip to step 5 below. 

4. Select ‘iWeb’ from the drop down menu and click on the ‘Import’ 
button.  

5. Navigate to where you published the iWeb website on your local hard 
disk and select ‘Open’.  

6. EverWeb will list the blogs that it has found e.g. ‘blog’. Select the entry 
you want from the list and select ‘Import’.  

7. Your iWeb blog entries will be processed and listed as blog posts in the 
Blog Posts List. 
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Importing Blog Posts from WordPress 
1. Before importing your WordPress blog posts into EverWeb, you will 

need to export your WordPress blog. 

2. First login to WordPress and go to the Tools->Export menu.  

3. Click on ‘Posts’ and select the settings you want to use.  

4. Next, press Export.  

5. When the export is complete, you can import the file In EverWeb. 

6. From the Blog Posts List in EverWeb, click on the Settings Cog/Button, 
then select the ‘Import…’ menu option. Select ‘WordPress’ and choose 
the .xml file that you exported from WordPress.  

7. Alternatively, you can also use the File-> Import-> WordPress Blog 
Posts option. 

8. The file will be processed and your WordPress blog posts listed in the 
Blog Posts List. 
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Importing Images in to your Blog Posts 
Images can be imported in to your blog posts. Simply drag and drop the 
image from its source location to either:  

1. The Blog Posts Editor window if you want the image to only appear on 
the currently selected blog post 

2. The Preview Window if you want the image to appear on all of your 
blog posts. 

Importing iWeb Photo Galleries 
EverWeb allows you to import iWeb Photo Galleries in to your website using 
the File-> Import-> iWeb Photo Gallery from File… and File-> Import-> iWeb 
Photo Gallery from URL… menu options. 

Importing Sandvox Photo Galleries 
EverWeb allows you to import Sandvox Photo Galleries in to your website using 
the File-> Import-> Sandvox Photo Gallery from URL… menu option. 
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The Blog Editor Window 

Editing a Blog Post 
The Blog Editor Window is where you enter the text of your blog. Once you 
have created a new blog post, select the placeholder text ‘This is a sample blog 
post’ and start typing. You can also paste in text that you have copied to the 
clipboard in to your blog post. 

At the top of the Editor Window is the Editing Toolbar where you can quickly 
apply text formatting to your blog post (see Figure 11.6). The Toolbar works in 
much the same way as in word processing applications.  

You can resize the Editor Window height by hovering the mouse on the border 
line between the Editor and Preview Windows. The mouse pointer will change 
to a splitter symbol. Click and drag the splitter up or down until you have the 
Editor Window the size you want it, then release the mouse button. 

Using The Blog Editor’s Dark Editor 
If you are using a light color for the text of your blog posts, you can toggle the 
background of the Blog Editor from white to black so you can more easily see 
your text. Just click on the Settings Cog and choose ‘Dark Editor’ from the 
menu. When unchecked, the Blog Editor background will again be white. 

Formatting Text in the Blog Editor 
As well as the formatting options in the Blog Editor Toolbar, there are other 
ways to achieve the look that you want for your blog text.  

www.everwebapp.com	 ￼  of ￼178 322

Figure 11.6: The Blog Editor Toolbar contains frequently used editing features for quick access.

http://www.everwebapp.com


EverWeb User Manual	 Blogging

The Text Inspector can be used to change blog text character spacing, line 
height, spacing before and after a paragraph and even insert a margin in the 
blog post widget itself.  

To use these options, just highlight the text in the Blog Editor Window then 
click on the Text Inspector tab and use the options listed. 

The Blog Post Editor Toolbar 
As mentioned earlier, the Blog Post Editor has its own fully featured toolbar. 
These features include: 

• Paragraph Format: This button is used to define the SEO level you want 
to use for the selected text or paragraph. 

• Paragraph Style: This option to apply predefined Paragraph Styles to 
your text. 

• Bold: Sets Emboldens the selected text. 

• Italic: Sets Italicizes the selected text. 

• Underline: Underlines the selected text 

• Font Family: Quickly access a selection of fonts to style your text. 
Alternatively, select the More… option at the bottom of the list of fonts 
for more fonts or use the Fonts button in the Toolbar. 

• Font Size: You can quickly set the font size of your selected text using 
this dropdown. Alternatively set the font size using the Fonts button in 
the Toolbar. 

• Colors: When clicked upon, you can select the foreground or 
background color of your text from the color swatches. You can also 
enter the colours Hex code. For more colors, use the Color Picker from 
the Colors button in the Toolbar. 

• Align: You can align your post’s text as left aligned, centered, right 
aligned or justified. 
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• Ordered List: You can create an ordered list for your selected text in one 
of six different numbering styles. 

• Unordered List: You can create an unordered list using either default, 
Circle, Disc, or Square bullet points. 

• Insert Link: Create a hyperlink for the selected tex using this option. 

• Quote: You can increase or decrease quote levels for your text in your 
post using the quote button. 

• Insert Video: Use this button to add a video or MP3 audio file to your 
blog post. 

• Clear Formatting: Select the text in the post that you want to clear the 
formatting of, then click on the Clear Formatting button. 
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Hyperlinking Blog Posts 
Linking a blog post to a page in your website is 
easy to do. Simply select the object on the page 
you want to link the blog post to e.g. a piece of 
text.  

Click on the Hyperlinks tab in the Inspector 
window (see Figure 11.7). Check the box “Enable as 
Hyperlink”.  

To link a blog post select “One of My Pages” from 
the Link To options. Next choose the blog post 
you want to link to from the drop down menu in 
the “Pages” option.  

The link is all set up so when someone clicks on 
the linked text they will go to the blog post. 
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Images in the Blog Editor Window 

Images can be drag and dropped directly in to the Blog Editor Window. Once 
you have dropped the image in from its source, or from the Assets List, click on 
the image to select it. The selected image has a blue border with square 
selection handles in each corner that you can drag to resize the image.  

A Blog Image Toolbar is displayed either above or below the selected image 
(see Figure 11.8). You can align the image to the left or right or not at all. You 
can also have the image display inline with the text or ‘breaking’ so that the 
text only displays above and below the image. There’s also an option to add 
Alternative Text to the image that is used by search engines to add keywords 
or context to your image that they can understand. 

If you have dropped the image on to the Blog Preview Window, the above 
options are not available. The next section tells you more about using images 
and objects in the Preview Window. 
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Adding Video and Audio in The Blog 
Editor Window 
Adding a video or an audio clip to your blog post just takes a few easy of steps: 

1. Start by adding the video, or audio, files that you want to use in your 
blog in to the Assets List. First click on the Assets tab in the Inspector 
Window.  

2. You can now drag and drop the video or audio files that you want to 
use from their source in to the Assets List. The files will be added to 
your EverWeb project as External files. 

3. After adding the video or audio files, right, or secondary click on the file 
in the Assets List that you want to insert in to your blog post.  

4. Select ‘Copy Relative File Path’ to copy the relative file path of the file to 
the Clipboard. 

5. Next click on the Posts page in the Web Page List then click on the 
post that you want to add the video or audio file to so that it is selected. 

6. In the Blog Post Editor Window, click on the position in the post where 
you want to insert the video or audio file.  

7. It is recommended to select a space or cursor position. If you select any 
letters, words or images, they will be replaced by the inserted video or 
audio file. 

8. Click on the Video camera icon in the Blog Post Editor Toolbar. You can 
use this icon for either video or audio files. 

9. Paste in the Relative File Path from the Clipboard, and then press 
Insert.  

10. The video or audio file will be inserted in to the post. Use the inline 
tools to style the inserted video or audio files within the post. 
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The Blog Preview Window 

The Blog Preview Window is where you see how your blog post will look when 
published. It is similar to a Master Page as when you add, edit or delete objects, 
or change any formatting, these changes are applied to all your blog posts e.g. 
if you add social media buttons in the Blog Preview Window of one of your 
posts, the buttons will appear in all posts (see Figure 11.9). 

The text entered in the Blog Editor Window appears in the Blog Post Widget in 
the Preview Window as does the blog’s Title at the top. You can apply 
additional display and formatting options using the Blog Post Widget Settings. 
As such, what you see in the Blog Editor Window may appear differently in the 
Blog Preview Window due to the formatting that you may have applied. 

For example, the text may wrap at a different point if the blog widget is smaller 
than the blog entry field. 
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Blog Post Widget Settings 
You can format all of your blog posts to have the 
same look using the Blog Post Widget Settings 
tab. For example, if you change the font of the 
Blog Post Title in the Header Options, the change 
will be applied to all of your blog posts. 

There are many different options to choose from 
such as including the date of the blog post and 
Navigation Links that make it easy for your visitors 
to move through your blog posts of return to the 
Index (Blog Main) page. 

Use the Post Cover Image Options to add an 
image to the blog post. Set the Maximum Image 
Height and Width options for Fixed Width and 
Responsive pages to limit the size of the cover 
image. You can also pad out the distance between 
the image and text. 

Formatting The Blog Post 
Preview Page 
The Blog Post Options change the formatting of 
the blog posts themselves. If you want to change 
other aspects of the Blog Preview Window, use 
the Inspector Window. For example if you want to 
change the background color of the blog posts, 
use the Page Settings tab and set the Page and 
Background color to how you want it. 

Adding Objects in to the 
Blog Posts Preview Window 
You can add in other objects, such as images and buttons, in to the Blog Posts 
Preview Window. When you do this, the object will display in all of your posts. 
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This is very useful if you want to add, for example, social media buttons, or a 
company logo, to your blog posts (See Figure 11.9). The Preview Window is in 
many ways similar to the way in which EverWeb’s Master Pages work (see the 
following section for more information). 

Tip: To add an object just to one blog post, add the object in to the Editor Window. 
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Navigation Links 
You can include navigation links at the bottom of your blog so that visitors can 
easily go the next or previous blog. or back to the Index page. You can 
customize the text of the Previous Post and Next Post links if you want.  

By default, EverWeb displays navigation links. If you do not want navigation 
links displayed, deselect the ‘include navigation links’ and/or ‘include index 
page link’ settings in the Blog Posts Widget Settings. 

The navigation links can be customized. By default, the previous and next blog 
post titles are displayed as the links to the previous and next blog posts. You 
can change the link text if you want using the ‘Previous Post Link Text’ and 
‘Next Post Link Text’ options. When these fields are blank, the default blog post 
title links are used. 

To change the font of your navigation links, use the Navigation Links ‘Fonts’ 
button. To change the color of the links, use the Link Normal, Mouse Over and 
Visited options as the navigation links are hyperlinks to other pages in your 
website. 
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Adding Commenting To Your Blog 
You can let your visitors discuss and leave their own comments about your 
blog posts by using a ‘Comment Engine’. EverWeb has the option for you to 
use either Disqus’ or Facebook’s comment engine. You will need to set up an 
account in the comment engine of your choice before using it in EverWeb 

Choosing Your Comment Engine 
You can choose to use either Disqus or Facebook Comments (see Figure 11.10). 
Both offer similar features to each other although you may want to consider 
that… 

Disqus is better if you want real time conversations and an easy to use 
interface whilst 

Facebook Comments is better if you have a large number of website visitors 
using Facebook and for visitors who want their comments published in their 
Public Facebook profile. 
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Obtaining a User ID for Disqus or 
Facebook Comments 
Creating a User ID in either Disqus or Facebook Comments can seem 
complicated at first as each offers many different setup options. However, 
these options are not usually needed. All you need is the User ID itself to get 
started in EverWeb. 

The steps below will help guide you in setting up Disqus or Facebook 
Comments. As there are a number of different user situations, you may find 
that you need to complete only some of the steps shown, or you may need to 
complete more steps than are shown below. 
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Using Disqus as your Comment Engine 
 

1. First sign up for an account at the Disqus website if you don’t already 
have an account.  

2. You can use your Facebook, X (formerly Twitter) or Google accounts to 
sign up, or use your email address if you prefer. (See Figure 11.11) 

www.everwebapp.com	 ￼  of ￼190 322

Figure 11.11: Disqus Signup screen

http://www.everwebapp.com
http://www.disqus.com


EverWeb User Manual	 Blogging

 

3. When you sign up, click on the‘Get Started’ button on the ‘#1 way to 
build your audience’ screen (See Figure 11.12). 

4. Next you will see the‘Create a new site’ screen (See Figure 11.13). The 
‘Site Owner’ will be the name you used as your sign up name. 
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5. When you enter your ‘Website Name’ (highlighted in the red box in 
Figure 11.13) you will see that Disqus automatically creates a 
‘shortname’ which will be the User ID. 

6. Make a note of your ’Shortname’ as you will use this later in EverWeb! 

7. Complete the details and click on ‘Create Site’. Your Disqus ID will be 
created and you will now be offered a number of customization 
choices. 

8. Click on the button ‘Yes, I understand Disqus is both comments and 
native Apps’ on the next screen. 

9. You will next see a screen with options to install Disqus on different 
platforms (See Figure 11.14).  

10. Click on the ‘Universal Code’ button at the bottom of the screen. 
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11. Scroll to the bottom of the next screen and click the button. Continue 
to do this until you see the ‘Setup Complete’ screen (See Figure 11.15). 

You have now finished the setup process and have a Shortname that can be 
used in EverWeb.  
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Using Facebook as your Comment 
Engine 
To use Facebook as your comment engine: 

1. Sign up to Facebook at www.facebook.com if you do not have an 
account already. 

2. Once you have a Facebook account you will need a Facebook App ID. 
To do this you need to be a Facebook Developer (See Figure 11.16) 
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3. If you have not done so already, convert your Facebook account to a 
Facebook Developer account by selecting the ‘Docs’ menu.  

4. Click on ‘App Development’ in the ‘Product Docs’ or ‘Guides’ section, 
Next select ‘Creating an App ID’ from the ‘App Development’ list. 

5. Scroll down to ‘Developer Account’ and ‘click on ‘Create Developer 
Account’ (See Figure 11.17). 
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6. Once you have completed the registration you can add Facebook in to 
your app or website. 

7. Facebook will ask you which application platform you are using. If you 
have already registered, use the ‘My Apps’ button and select ‘Add a 
New App’ from the menu. 

8. Click on ‘WWW” for your website (See Figure 11.18). 
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9. In the ‘Quick Start for Website’ window, type in the name you want to 
call your app e.g. the name of your website and then click on ‘Create 
New Facebook App ID’. Remember to select a ‘Category’ as you cannot 
proceed if you don’t (See Figure 11.19). 

10. Once the App has been created, you will see the ‘Setup Facebook SDK 
for JavaScript’ screen. Enter your website URL at the bottom of the 
screen and click ‘Next’. 

11. Scroll down until you see the section ‘Next Steps’. ’ 

12. Click on ‘Skip to Developer Dashboard’. 
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13. At the top of the Dashboard is your App ID number which you can now 
use in EverWeb (See Figure 11.20). 
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Enabling Comments in EverWeb 
Now that you have your Disqus Shortname or Facebook App ID, go to the 
Comment Options section in the Widget Settings of your Blog Posts in 
EverWeb (see Figure 11.10 above). 

In the Comment Engine section, select either Disqus or Facebook then enter 
your Disqus Shortname or Facebook Comments App ID in the box below. 

Your comment section is now setup! The Blog Preview widget will update 
showing the comment engine is enabled at the bottom of the widget. 

When your website is published to the Internet, visitors to your blog posts can 
add their own comments. A visitor will need to login to Disqus (or sign up 
which can be done via the login section in the Disqus Comments) or Facebook 
Comments (using their Facebook login) to be able to comment. 
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Managing Comments on Your Blog 
You are responsible for monitoring the comments that are placed on your blog 
by your visitors. As a ‘moderator’ you can approve comments for public display 
on your blog, delete comments from your blog (e.g. if they are offensive) and 
tackle instances where your blog may be subject to spam. 

If you are using Disqus commenting please go to their moderator guidelines 
for more information. 

If you are using Facebook commenting please go to their online help resource 
center. 
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RSS Features and Blogging 
Your website visitors can always stay up to date with the blogs that you create 
in EverWeb through RSS.  

There are a couple of easy ways to use RSS to take advantage of your blogs. 

• The RSS Feed Widget 

• The RSS Subscribe Button 

These features are described below. 
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The RSS Feed Widget 

You can use EverWeb’s RSS Feed Widget to show a blog summary on your 
web pages (See Figure 11.21) To do this, first go to the page where you want to 
add the blog summary. Next go to the Widgets Tab in the Inspector Window 
and drag and drop the RSS Feed Widget on to the page. 

In the Widget Settings you will now need to add in the location of your Feed 
URL. This location contains an rss.xml file that enables the blog entries to be 
displayed. the rss.xml file is located at 

	 http://<your website address>/blog/rss.xml 
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For example, Josh’s real estate business that we met earlier in the manual has 
created a blog for his website. His Feed URL may look like this 

	    http://www.joshsrealestate.com/blog/rss.xml 

Once you have added the Feed URL choose which other options you want to 
use in the RSS Feed Widget Settings. then publish your website to see the 
results displayed. 
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The RSS Subscribe Button 
 

You can add an RSS Subscribe button to your website so that your visitors can 
easily keep up to date with your blogging. 

To add an RSS button just use the Insert-> Button-> RSS Subscribe menu.  

Select from the menu to either subscribe to the website project’s blog using 
‘Select Blog’ or from another location using the ‘Enter URL’ option (see Figure 
11.22). 

Your button will be placed on the web page so that your visitors can subscribe 
to your blog using RSS. 
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12EverWeb & Search 
Engine Optimization

This chapter will help you optimize your EverWeb 
made website for use with search engines. 

Introduction to SEO

What Is SEO?

Keyword Research

Optimizing Page Names

Website Navigation Optimization

Title Tags

Web Page Descriptions

The Importance of Page Content

Anchor Text

Optimizing Images

Meta Keywords

Alt Text for Images

Heading Tags

EverWeb Site Shield

EverWeb SEO Power Up
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Search Engine Optimization 
This chapter will help you optimize your EverWeb made website for use with 
search engines.  

Introduction to SEO 
Use this chapter if a high page ranking in Internet search results is important 
to your business, or organization’s, website. 

Before starting to optimize your website, though, it is important to understand 
what Search Engine Optimization is, and how it can be applied in EverWeb to 
your website.

What Is a Search Engine? 
A Search Engine is the tool you use to find what you want on the Internet, e.g. 
Google, Yahoo, Bing and Duck Duck Go are all examples of a search engine.

What is Search Engine Optimization? 
Search Engine Optimization, also known as SEO, is… 

“The process of increasing the quality and quantity of website traffic by 
increasing the visibility of a website, or a web page, to users of a web search 
engine”*

* [Source: https://en.wikipedia.org/wiki/Search_engine_optimization#cite_note-1] 

As SEO is a process, there is no magic formula that will put your website at the 
top of a search engine’s page rankings.  
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This means there is no guarantee that your website will achieve success in 
achieving a high search page ranking. However, you can make changes to your 
website that will give you the best possible chance of a higher ranking. 

This chapter will explain what the most important optimizations are that you 
need for your website and how to implement them. 

Important 
Remember that SEO is a process that you must undertake if you want to 
achieve a higher search engine results page ranking.  

SEO is actually a form of marketing, so optimizing your website using SEO 
should not be considered as a just a one off task..If you want to continue to 
improve your chances of success and growing your business you should re-
evaluate and update your website’s SEO on a regular basis. 
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Keyword Research 
To properly optimize your website, the most important task you need to 
complete first is your Keyword Research. This will help you find out which key 
words you are going to target on your website.

What are Keywords? 
Keywords are words, or phrases, that are related to the products or services on 
your website. 

Choosing the right keywords could make the difference between your website 
ranking first on a search results page or not ranking at all. But what are the 
right keywords to use? To answer this question let’s look at an example of what 
is a wrong keyword. 

This example uses Google’s search engine to search for a very popular keyword 
- “computers”.In the search results, shown in Figure 12,1 beneath the sponsored 
advertisements, there are a lot of results for this keyword, in fact more than 
several hundred million.  

In Figure 12.2 you can also see the websites that rank in the top 10 for this 
keyword. These sites belong to some of the world’s largest and most well 
known companies.  

Therefore, targeting a keyword such as 'computers' is not a good idea for two 
important reasons: 
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1. The search term is way too broad 

2. It will be virtually impossible to compete with these website giants.
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Finding The Keywords You Should Target
One of the easiest ways to find the key words that are most relevant for your 
website is by using Google Ads Keyword Planner. It is not necessary to create a 
Google Ads marketing campaign to use Keyword Planner. The goal here is to 
find the best keywords or terms for your website. 

Using Google Ads Keyword Planner 
The following are the steps required to use Google Ads Keyword Planner:

1. In your web browser type ‘Google Ads Keyword Planner’ in the search 
box, then press Enter. 

2. The first result, after the paid for advertisements, should be ‘Google Ads 
Keyword Planner’ from ads.google.com. Click on this link. 

3. To use Google Ads, sign In to your Google account if you have not done so 
already. If you do not have a Google account, click on the ‘Create account’ 
link then follow the instructions to sign up. 

4. Once you have signed in click on ‘Go to Keyword Planner’. 

5. You will be asked to choose your main advertising goal. In this example 
choose ‘Get more website sales or sign-ups’. 

6. You should now be at ‘Step 1: Your Business & Audience’ screen, on the 
‘New Campaign’ page. This is where you set up the business that you 
would want to advertise using a Google Ads campaign. 

7. If you already have a business linked to your Google account, this will be 
listed. Click on your business name. If you do not have a business listed, 
choose New Business. Enter the name of the business and its website’s 
URL then click ‘Next’ to continue. 

8. On the next screen tell Google Ads where your customers are located 
then click on ‘Next’ to continue. 

9. The ‘Define your product or service’ page will be displayed. This is the 
page where you will find your keywords or phrases for your website. 
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10. The potential audience size for your business is shown on the right hand 
side of the screen. This estimate is based on the information you have 
already entered. 

11. Select the language that you would want to advertise in, then enter your 
business category. Notice that Google Ads may suggest a business 
category based on an analysis of the website URL of your business. 

12. In my example I am going to choose ‘Golf Shop’. When you enter your 
business category, notice that the potential audience size will change. 

13. Keyword Planner will also suggest keywords that you can use. Click on 
the keywords that you think are best for targeting. Again, notice how the 
potential audience size changes as you click on suggested keywords to 
use. Try to find two keywords or phrases that give the best possible 
potential audience size. 

14. In addition to the suggestions from Keyword Planner, you can also add 
your own keywords to target so. For the Golf Shop business, for example, I 
could target ‘left handed golf clubs’.  

15. Add and remove keywords from the ‘What specific products and services 
do you want to promote in this ad?’ Section until you have the two 
keywords or phrases that give you the maximum audience possible. 

16. You can now close Google Ads Keyword Planner. The campaign will be 
saved at this place, which can be useful when you want to find keywords 
for other pages in your site. 

Testing Your Keywords 
When you have located the key-words or phrases that you think are a good fit 
for your website, it is a good idea to do a Google search on them.  

Look at the results. How many results do you see? Is there a really high number 
of results? What about the number of ads. Are there a lot of Google Ads for this 
search that are all competing for business? What about the search results? Are 
the websites ranking in the top 10 high authority websites that most likely will 
not be outranked by a new comer such as yourself?  

These are things to keep in mind when selecting which keywords to target. We 
recommend choosing two keywords per page for targeting purposes. One 
key-term will be your primary key-term and the other will be your secondary 
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key-term. This is only a suggested method, which will be demonstrated and 
applied  throughout this chapter.  

For example, if you have a one page website, you should not attempt to target 
5, or 10, or even 50 keywords. Targeting two keywords per page will help you 
focus on each page. It will also give search engines a much better idea of what 
each page is about. 

This also means that if you are targeting a key-term on a page, you don’t 
necessarily need to target that same key-term on another page. This would 
only result in you competing against yourself. Instead, find other keywords, and 
different variations of keywords, that you can target.  

Remember, not everyone looking for ‘left handed golf clubs’ will search for that 
exact phrase.  

There will be many different ways to perform that search, so make sure to 
focus your keywords for each page you apply SEO to in your website. This will 
also broaden your chances of ranking by using different keywords and 
different variations. 
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Checking Your Page’s SEO with Check 
Page 
EverWeb includes a one click way to check how SEO friendly your website’s 
pages are. The ‘Check Page’ button in the Toolbar scans the current page then  
suggest SEO related actions if needed. Each suggestion will also direct you to 
where you need to input SEO relevant information for that suggestion within 
your EverWeb Project file. 

The Check Pages functionality is part of EverWeb SEO Power Up Addon.  

Using Check Page 
To use Check Page, first select the page you want to check. It is recommended 
to only check the pages in your website that you want to apply SEO to. Pages 
such as Contact and About Us type pages will probably not require SEO, so 
they do not need to be checked. Checking pages such as the Home page of 
your site, though, is a good idea.  

Click on the Check Page button in the Toolbar to scan the page. A window 
containing Web Page Suggestions will appear when the scan is complete. Also 
note that you will be returned to the Page Settings tab in the Inspector 
Window if you are currently on a different Inspector window. 

The Web Page Suggestions will list all SEO relevant suggestions. You may have 
already successfully completed some of the suggestions on the list. For the 
items that still need completion, click on a suggestion that requires attention.  

A second dialog box will appear at the place on the page where you should 
enter SEO applicable information. The second dialog box contains helpful 
information to guide you in completing the field successfully.  

In addition, you can go to the Previous or Next suggestion directly or just Close 
the information dialog box. 

You can re-run the scan at any time to see updated results as you enter your 
SEO information. 

Please note that you may have some suggestions that you do not want to, or 
have to, complete e.g. entering a business location. Remember, that Check 
Page lists recommended suggestions for you to improve your SEO. It is not 
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mandatory to follow any suggestions if it is not appropriate for your situation to 
do so. 
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Optimizing Page Names  

When you look at a web address, which is also known as a URL, the page name 
you see is in fact the file name that follows after the domain name.  

For example, the domain name for the website of Paul’s Golf Shop in Figure 
12.3 is…  

	 paulsgolfshop.com 

and the page we are currently looking at is… 

	 left-handed-golf-clubs.html.  

The left handed golf clubs part of this URL is the file name. 

In this example,  

	 paulsgolfshop.com/sales/left-handed-golf-clubs.html. 

www.everwebapp.com	 ￼  of ￼215 322

Figure 12.3: The Left Handed Golf Clubs page’s URL is displayed in the search box 

http://paulsgolfshop.com
http://www.everwebapp.com


EverWeb User Manual	 Search Engine Optimization

there is a subdirectory - ‘sales’ after the domain name, so the page name will 
follow after the subdirectory.  

The page name is a great place to insert a keyword for this particular page. If 
you use generic names for your pages such as ‘Page 1’ or ‘Home Page’, you will 
be wasting an opportunity to improve your website’s SEO. 

It is recommended that you use your primary keyword for your page name.  

To change the name of your page in EverWeb: 

1. First highlight the page you want in the Web Page List. 

2. Next select the Inspector Window, then click on the Page Settings tab if it 
is not already selected. 

3. In the ‘File Name’ field, type in your desired page name. In the above 
example the file name will be ‘Left Handed Golf Clubs’.  

4. Publish your website, EverWeb will replace any spaces between words 
with hyphens. You do not need to do this yourself.

5. Repeat this process for every page in your website that you are trying to 
optimize for search engines.  

There may be some pages in your website that you do not want, or do not 
need, to optimize. For example, the ‘Contact Us’ page might be a page that. 
you are not trying to get to rank high in search engines. In this case, you do not 
need to apply any SEO work on that particular page. 

Note that you do not need to apply Page Name optimization to the home 
page of your website, as the home page’s file name will always be index.html. 
This is a typical way that websites work, but we can still optimize the home 
page using the other methods that we will discuss later on. 
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Website Navigation Optimization 
An important part of SEO is having a properly structured website that can be 
easily navigated by your visitors. It should never be difficult for your visitors to 
go from one page in your site to any other page in your site. The best way to 
make your site easy to browse is by using a navigation menu.  

A navigation menu is easy to create as EverWeb includes a built in 
navigation menu widget. Drag and drop the widget on to your 
page from the Widgets tab on to the Editor Window. When you 
add the widget, it creates linkable text to all of the pages on your 
website. 

The importance of page names was discussed in the previous section and 
these same principles can be applied to the Navigation Menu Display Name 
which is found in the Page Details section of the Page Settings tab of the 
Inspector Window.  

The navigation menu can be a good place for keyword rich navigation links. 
For example, if the keyword being targeted on this page is ‘left handed golf 
clubs’, then it might be a good term to use as the Navigation Menu Display 
Name. 

Note that there can be exceptions to this rule. Not every page in your site 
needs to have keyword-text in the Navigation Menu Display Name. For 
example, a ‘Contact Us’ page usually does not require optimizing for search 
engines, so the Navigation Menu Display Name does not need optimization 
either. 

In some cases, you might be targeting a very long key-term. This would make 
the navigation menu look awkward if the term was used in the Navigation 
Menu Display Name field. In this case, do not make the optimization.  

Important 
Remember that if the optimization provides a poor user experience, do not 
apply that optimization. The user experience is always the number one priority 
for your website. 
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Title Tags 

The Title Tag is the string of text that is displayed at the top of the web browser 
(see Figure 12.4 below).  

It is also the text you see as the clickable link for a page when you perform a 
search (see Figure 12.5 below).  

The Title Tag can play an important role in Search Engine Optimization. In 
many instances web pages have generic Title Tags such as ‘Home’, ‘Products’, 
or a company’s name. This is a huge missed opportunity if Search Engine 
Optimization is important to you.  

Using Title Tags is probably the most important search engine optimization 
and changing a page’s Title Tag in EverWeb is simple to do: 

1. First select the page you want.  

2. Next go to the Page Settings tab in the Inspector Window. 
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3. In the Page Details section, is the ‘Web Page Title field’. This is where you 
insert your page’s title.

As an example of how you could display your Title Tag, you could use your 
primary key-term for the page, followed by the secondary key-term.  

The key-terms could be separated or not, as desired.  

Whilst not obligatory, it is good practice, when using Title Tags, to add your 
company name at the end of the title. You can separate your company name 
using a vertical bar symbol ( | ) which can be found on your keyboard, e.g.

Left Handed Golf Clubs | Pauls Golf Shop 
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Figure 12.5: The Title Tag is also displayed in the website’s clickable link.
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Web Page Description 
The Web Page Description does not 
necessarily assist in the ranking of a 
website, but it often appears as the 
block of text right beneath the clickable 
link in the search results.  

The Web Page Description can play an 
important role in whether the visitor 
clicks on the link to be taken to the 
website.  

Search engines are able to determine 
how often a link appears in the results 
and how often a visitor clicks, so it is 
important to not only appear in the 
search result, but to also get visitors to 
click on your site. 

In EverWeb, you can add a description 
to each page using the Web Page 
Description field in the Search Engine 
Optimization section of Page Settings 
tab in the Inspector Window (see 
Figure 12.6). The important thing to 
remember for the description is to 
make it inciting enough for the visitor 
to want to read it and to subsequently 
click on the result to go to your site.  

Including your primary and secondary key terms is not mandatory, however, if 
adding one, or both, key terms to the description makes it more inciting to the 
visitor, then you should include one or both of them.  

A good reason for including the key-terms in the description is that when 
someone searches on certain words, if those words appear in the description, 
then they will appear in bold, which might catch the visitor’s attention. 

The page description can be changed on the Page Settings tab, in the Web 
Page Description field. It is good practice to ensure that each page has a 
unique description. The Web Page Description should be between 150 and 160 
characters. Be as descriptive as you can, but avoid making this just a place to 

www.everwebapp.com	 ￼  of ￼220 322

Figure 12.6: Use the Web Page Description field for 
a description of your page.

http://www.everwebapp.com


EverWeb User Manual	 Search Engine Optimization

put keywords. Remember, the goal is to have the visitor read the short 
description then to click to be taken to your page. 
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The Importance of Web Page Content 
The content of your site will have a large impact on your search engine 
rankings, as well as your ability to obtain incoming links. Each page on your 
website should contain content in the form of text. Ideally, you should have 
about 250 to 500 words on each page.  

In your text content, make sure to include the key-terms that relate to that 
specific page. Do not overload the text with those key-terms too many times, 
but use them when it is appropriate to do so.

Important 
When writing your content, keep in mind that you should always avoid having 
duplicate content on your site. As such, it is recommended that… 

1. You do not copy and paste articles from other websites and 

2. You do not take your past articles and simply re-wording them.  

Remember to write content for your visitors, and not for search engines.  

Spelling and Grammar 
Finally, make sure you double check your spelling and grammar. This is very 
important because this could influence webmasters decisions to link to your 
site. 
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Anchor Text 
When adding links on your page the ‘anchor’ text, or phrase, that you can click 
on that takes you to the destination page, plays a far greater role than most 
people imagine. For example, Google search for the term ‘click here’. You will 
notice that the first result is for Adobe Reader. 

Nowhere on the Adobe site does “click here” appear (see Figure 12.7), yet it 
ranks number one for the term. The reason for this, is because many other 
websites, including very high authority sites, such as educational institutions, 
link to this exact page, and the anchor that they use is ‘click here’.

As you build your website, keep this SEO tip in mind. When you link to other 
pages on your website, avoid using common phrases like ‘click here’ or 
anything similar to it. Instead, use some of the keywords and phrases that you 
have written down. 
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In the example shown in Figure 12.8, the text on the page mentions ‘left 
handed golf clubs’. This is one of the two keyword phrases used on the page so 
is a good phrase to link to the page on left handed golf clubs. To add a link: 

1. Highlight the string of text ‘left handed golf clubs’. 

2. Click on the Hyperlinks tab in the Inspector Window and check ‘Enable 
as Hyperlink’ to activate the settings. 

3. The Link To dropdown is set as ‘One of My Pages’ as the page being 
targeted is within the website project. 

4. Choose the page on the site that is targeting left handed golf clubs using 
the ‘Page’ field. 

5. Format the hyperlinking colors as required in the ‘Hyperlink Formatting’ 
section. 

6. The hyperlink is set up.
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Optimizing Images 
The images on your website can also help you gain traffic to your website. 
Many search engines, including Google, contain an image search. Images 
found in an image search can direct visitors to your website, so it is important 
to optimize the images in your website to take advantage of image searches. 

Optimizing your images is easy. All you need to do is give your image a 
keyword rich file name. For example, instead of naming your image something 
vague and generic such as ‘IMG0003’, a more descriptive and keyword rich file 
name would be ‘Left-handed-golf-clubs’. Separating each word with hyphens 
will help search engines to distinguish between each word. 

It is recommended that images are renamed before you add them to your 
EverWeb Assets List. 

If the image is already in the Assets List, you can rename it. , however, the 
recommended method is to remove it from the assets, list, add the image with 
the optimized name, and then correct the image on the site so that it has the 
optimized image selected. Again, this is only the recommended method. If you 
don’t have enough time to do it this way, you can just rename the image right 
from within the assets list. 

Meta Keywords 
The meta keywords attribute was important for SEO until the early 2000's but 
many web masters began to take advantage of this feature. As a result search 
engines devalued meta keywords and barely rely on them. Google has even 
stated that they do not take meta keywords into consideration at all. 

Nonetheless many web masters still feel the need to add them to their sites. 
EverWeb does not contain a meta keywords section, but it is still very easy to 
add to your their pages if you want to. 

To add meta keywords, click inside the head code section in the Page Settings 
tab. In this box, type in the necessary code such as in the example below: 

<meta name="keywords" content="left handed golf clubs,junior golf club sets"> 
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In the ‘content=‘ area, type in your keywords or-key terms. Separate each key-
term with a comma. You will notice that only 2 key-terms are included in the 
example. The first term is ‘left handed golf clubs’, and the second term is ‘junior 
golf club sets’. This is in line with the original recommendation of having one 
primary, and one secondary, key-term to target on each page.

You can repeat this process on the other pages of your website. Double check 
that your code is typed out exactly like the codeine the example above. The 
only difference will be that you will use your own key-terms in between the 
opening and closing quotation marks. 

 

Alt Text for Images 

Alternative text, or Alt-Text, is the text given to a particular image that provides 
information about that image. The main purpose of this attribute is to still 
provide the user with information on the image, should the image not appear, 
or if the web browser the user is using is a screen reader as opposed to a 
traditional web browser. 
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Alt Text can also provide search engines with information about an image, 
which can help with rankings in image searches. 

In EverWeb, you can add Alt Text by first selecting the image you want. Next, 
click on the Shape Options tab in the Inspector Window, and type your Alt text 
into the Alt text field. 

For example, for the image in Figure 12.9, the Alt Text could be ‘A set of left 
handed golf clubs in a red and black golf bag’. 

Some EverWeb widgets, such as the FlexBox widget, also allow you to enter Alt 
Text for images used within the widget. 

When using Alt Text, you should describe the image as best as possible. Try to 
include the keywords or phrases that you have been using throughout your 
site while also keeping the text short, to the point, and relevant to the actual 
image. 

Add Alt Text to all of the images on your site that you want. 
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Heading Tags 
Heading Tags, also known as Header or HTML Tags, can be compared to 
headlines that you see in a newspaper or magazine article. On the web, search 
engines use headings to help categorize websites for search purposes. 

In the example shown in Figure 12.10, the page shows an article with a heading 
right above it. 

Rather than making this heading a TextBox, as it is now, it would be better in 
Search Engine Optimization (SEO) terms, to add the heading text as a Heading 
Tag instead.

There are two ways to indicate to search engines the text that you want to be 
used as a Heading Tag in EverWeb: 

• If you are using a version of EverWeb earlier than version 3,9, drag the 
Heading Tags widget onto the page. In the Heading Text field, type in the 
required heading. If possible, and appropriate, try to include your primary 
key-term in the heading. 

• If you are using EverWeb version 3.9 or later, you can either use a Heading 
Tags widget, or you can simply highlight the text you want to use as a 
Heading Tag, then go to the Text Inspector and choose the Heading Tag 
you want using the HTML Tag drop down menu option. 

The Heading Level allows you to indicate to search engines the importance of 
your header. For example, returning to the primary and secondary key-term 
practice, your primary key-term should be a part of an h1 header, since h1 is the 
highest, and your secondary key-term would be part of an h2 header. 

The rule of thumb is to only place one h1 heading per page. 

As for placing multiple headings, it is recommended to only do this if it makes 
sense to do so. You should not add multiple headings of various levels to your 
page just to have keywords everywhere. Search engines are smarter than this, 
and there are many other factors that go into results page rankings, so 
cramming your pages with Heading Tags will not be advantageous.
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Recommended Heading Tags Usage 
It is recommended to use one h1 per page which, if possible, includes your 
primary key-term. If it makes sense to have another heading on your page, you 
can use an h2, h3, or whatever tag you would like, and place your secondary 
key-term in it. 

It is possible, and acceptable, to place secondary key-term into the h1 heading 
if it makes sense to do so. 

The Heading Tags widget can be styled in the same way as you would for a 
TextBox. Click on the Fonts button, and changes to the Heading Tag’s style as 
desired. 
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EverWeb Site Shield Addon 
As well as being ideal for helping secure online data transmissions, EverWeb 
Site Shield is also great for your SEO rankings as Google gives data encrypted 
websites a ranking boost over non-secure websites. 

To find out more about EverWeb Site Shield Addon, please see the section on 
EverWeb’s Site Shield Addon. 

EverWeb SEO Power Up 
EverWeb SEO PowerUp addon automatically optimizes your website for search 
engines and submits it Google, Yahoo, Bing and Alexa search engines. 
EverWeb SEO Power Up Addon has the following features; 

• One click ‘Check Page’ feature checks your page’s SEO settings and 
suggest how you can improve it. 

• Optimizes your website for search engines 

• Creates the XML Sitemap file 

• Allows you to assign priority and frequency according to the sitemap 
protocol 

• Creates the robots.txt file 

• Automatically adds Open Graph tags to your website 

• Submits your site to Google, Yahoo, Bing and Alexa notifying them of the 
updated site each time you publish something new. 

• GZip Compression is enabled server side for EverWeb+Hosting Customers 
so that you get faster loading websites 

• EverWeb SEO Power Up is available to all customers and is free for those 
with an EverWeb+Hosting 10GB or Higher plan. 

More detailed information on EverWeb SEO Power Up can be found in the 
dedicated chapter ‘EverWeb SEO Power Up’. 
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13Previewing & 
Publishing Your 
Website

Whilst building your website it’s a good idea to preview 
your web pages to see how they will look before going 
live.

When your website is complete, you can then Publish it 
to the Internet!

Previewing Your Website

Preview Server

Publishing Your Website

EverWeb+Hosting Accounts
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Previewing & Publishing Your 
Website 
Using Preview 
Whilst building your website, and before you publish your website to the 
Internet, it’s a good idea to preview your web pages to see how they will look 
before going live. 

It’s also a good time to test out some of the features of your website such as 
the navigation and hyperlinks.  

Preview takes advantage of the browsers installed on your computer. On a 
mac, Safari is installed but it is recommended that you install other browsers, 
such as Google Chrome, Opera, Firefox etc, in your mac’s Application folder so 
that you can test your website in as many different browsers as possible before 
publishing. 

EverWeb will first process your website files, then will preview the results in 
your browser. If you have Preview Server set up using the EverWeb-> Settings...-
> General-> Preview-> Use Preview Server option, EverWeb will preview the 
page without any processing delay. 

You can test out most features of your website in Preview.  

Please note that some widgets such as the Contact Form Advanced and 
FaceBook Like widgets, may not Preview correctly as they may require a 
publish to the Internet in order to display their features properly. 
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Preview Server 
EverWeb uses a Preview Server so that you 
can preview your website on any device that 
is attached to your local network. 

Preview Server also enables almost 
instantaneous previews of your site when 
you click on the Preview button in the 
Toolbar.  

To use the Preview Server functionality, go 
the the EverWeb-> Settings…-> General tab.  

Make a note of the HTTP address in the 
‘Remote URL’s’ section. 

Preview your website on your computer 
using the Preview button in the Toolbar. 

Next, go to another device on your local 
network e.g. a wifi connected iPad. Open 
your browser and enter the Remote URL’s address that you noted earlier.  

You will see an Index page. Select the second item in the list which has the 
same name as the page you previewed on your computer. You will see the 
same preview on your iPad as you on your computer. 

Caution 
Some web browsers, such as Google Chrome, do not fully support this 
functionality. If you use Google Chrome as your default browser it is 
recommended that you turn off EverWeb’s Preview Server. You can do this in 
the EverWeb-> Settings...-> General tab (See Figure 13.1). 

www.everwebapp.com	 ￼  of ￼234 322

Figure 13.1: EverWeb’s General Settings 
showing Preview Server.
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Publishing Your Website 

When you are ready to publish your website, click on the Publish button in the 
Toolbar.  

If this is your first time publishing in EverWeb, you will see a popup window 
appear. Sign in to your EverWeb account in order to publish your website.  

If you do not have an EverWeb account and want to create one, click on the 
‘Create Account’ button to register an account. 

If you have an EverWeb account, you can click on the Sign In button, which will 
bring up the Settings window.  

In this window, you will be able to enter your EverWeb email login and 
password. When you are done, click on the Sign In button. 

Once you are signed in to your EverWeb account, you will not need to enter 
login information again unless you Sign Out. 
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Figure 13.2: Log in to your EverWeb account in order to publish 
your website.
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Once logged in, click on your website name to view the Publishing Settings. 
Under the Publishing heading, you can choose to publish to an EverWeb 
Hosting account, to a local folder or to a third party FTP server. 

If you are publishing to EverWeb, you will see the ‘EverWeb Location’ settings 
as shown in Figure 13.3. 

Under the Accounts drop down menu, you can choose which EverWeb 
hosting account you wish to publish to. You will most likely only have one 
account so you can leave this as is.  

If you have more than one domain on the account, you will see a Domains 
drop down, which will allow you to choose which domain to publish to. If you 
only have one domain, you will not see this menu. 

The Subdirectory field (see Figure 13.4) allows you to publish your website to a 
different location on your server. 

www.everwebapp.com	 ￼  of ￼236 322

Figure 13.3: Users publishing to their EverWeb Hosting account can select from their multiple 
accounts, and multiple domains, as applicable. 

Figure 13.4: The Subdirectory field allows you to publish your website to a different directory on the server. 
This is useful as you can publish to a temporary location for testing purposes without overwriting an 

existing website.
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The’Subdirectory’ location can be used for testing purposes before your 
website goes live. 

For example, entering the word 'temporary' would publish the site to 

http://www.everwebtutorials.com/temporary 

rather than at  

http://www.everwebtutorials.com.  

The current website published at http://www.everwebtutorials.com would not 
be overwritten. 

If you want to publish your site without the Subdirectory, leave the 
Subdirectory field blank. 

When you are ready, click on the Publish button in the Toolbar, and EverWeb 
will publish your website. 

Use HTTPS Secure URL’s 
Check this box if you are using EverWeb’s Site Shield Addon. For more 
information please click on the link to find out more about securing your 
website. 

Optimize and Submit Website to Search Engines 
If you have purchased EverWeb SEO PowerUp Add-On, check this box so that 
when published, search engines will be notified. For more information, about 
improving your SEO with EverWeb, please click on the link above. 
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Remove File Extensions 
You can publish your website without using file extensions by checking this 
box. Unless you have a specific reason to do this, we recommend leaving this 
box unchecked. 

Export Optimized Images 
You can export your images when publishing to WebP format, by checking the 
‘Export Optimized Images’ box. The WebP format improves the speed at which 
your images load in the browser without sacrificing image quality due to the 
use of a superior compression format. 
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Head and Footer Code 
You will notice that there is a field for Head and Footer code. This is an 
advanced feature that lets you add custom code that gets place within the 
Head section of your website or right at the bottom of your website. 

This is useful for adding Google Analytics, Statcounter.com or custom 
Javascript code. 

Adding Google Analytics 
The Footer field can be used to add your Google Analytics code. Just copy and 
paste your Google Analytics code to this field. 
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EverWeb + Hosting Accounts 
If you do not have an EverWeb account you can create one here.  

EverWeb+Hosting account pricing starts at $99.95 USD/year and provides web 
space and personal email addresses. It also provides free updates and support 
while your account is active. 

When you create an account you will be asked to make a password. This 
password, with your email address, is all you need to publish your website. 

Once your account is created enter your Email address in the ‘Email’ field and 
your password in the ‘Password’ field and click ‘Sign In’.  

Under the ‘EverWeb Location’ heading you will see your website address (also 
known as your domain name) in the ‘Accounts’ drop down menu. It should be 
automatically selected for you. 

If you want to secure your website using end to end data encryption and 
receive a rankings boost from Google and other search engine providers, tick 
the ‘Use HTTPS Secure URL’s’ box. For more information about this, please refer 
to the ‘EverWebSite Shield Addon’ section of this manual. 

The ‘Subdirectory’ field should only be used if you have multiple websites 
under one account. It lets you have a unique website address for each website 
and will prevent any websites from being overwritten. 

Tip: If you want to have multiple websites you don’t have to worry about your website being 
overwritten. Just enter a unique subdirectory for your second website. EverWeb will warn you 
if you are overwriting an existing website previously published through EverWeb. 
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Setting Up Personalized Email Addresses 
EverWeb makes it very easy to create and manage personalized email 
addresses. These emails addresses will use your domain name in them. 

 

To setup an email address to be associated with your domain name: 

1. Scroll down the Publishing Settings Screen to the Email Addresses 
section. 

2. In the Email Addresses section (see Figure 13.5), click on the Add 
button. 

3. In the popup window, type in your desired email name and select the 
domain you want to associate it with from the drop down menu. If you 
only have one domain, you will not need to select the domain. 

4. Type in your desired password and then retype it to confirm. When you 
are done, click on the Create button. 

5. You should now see your email address in the list. 
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Figure 13.5: Setup personal email addresses in EverWeb.
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Using Email Addresses in Apple Mail or 
Other Email Apps 
If you want to configure your email address in Apple's Mail application or in 
another email app, use the links that are provided below the email addresses 
to guide you through the process. 
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404 Not Found Page 
A ‘404 Not Found Page’ lets you assign a page in your website to display if a 
visitor tries to access a page that doesn’t exist.  

This usually happens if: 

• There is an an outdated link on your website. 

• If the user mistypes the web page name in the browser’s search box 
when looking for a page on your site. 

• If you have updated your site and removed an existing page. 

Adding a page to your website to capture such instances makes your website 
more professional. It also help keep your visitors in your website. 

Create a ‘404 Error Page’ in your website to redirect the user to another page 
in your website.  

Remember to also create a page for your mobile website as well as your 
desktop website. 

Block AI Bots 
EverWeb automatically defends your site against AI Bots. The Block AI Bots 
option is checked by default.  

For advanced EverWeb users, you can also enter your own custom code in to 
the robots.txt and .htaccess files using the Advanced Options button.  
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FTP Publishing 
EverWeb lets you publish your website to any web hosting provider by the FTP 
Server Publishing option. EverWeb supports: 

• FTP 

• FTP with SSL/TLS Protocol  

• FTP with SSH Protocol.  

To publish to your FTP Server,  

1. First access the Site Publishing Settings of your website Project using 
the File-> Edit Publishing Settings, or by clicking on the name of your 
website Project in the Web Page List. 

2. The Editor Window will now display your Site Publishing Settings 
(Figure 13.6). 
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Figure 13.6: FTP Settings in Site Publishing Settings
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3. Set the ‘Publish To” location to ‘FTP Server’. 

4. Complete the FTP Server Details section. If you are unsure of your FTP 
publishing settings, please contact your web hosting provider who 
should provide these details. 

Username and Password Fields 
Remember to pay special attention to the username and password field in the 
FTP Server Details section. Your Hosting Provider may have set up a user 
account username/password for you and also a separate FTP login username/
password.  

Your Hosting user account lets you login to your Hosting Provider’s website to 
access billing and account details. 

In contrast, your FTP login details are used in EverWeb’s Site Publishing 
Settings. So remember to check that you are using the right login as using the 
wrong login can result in authentication errors when trying to publish. 

The other field to pay attention to is the Directory/Path field. This is the 
directory path to the location where your web page files are stored. The 
Directory/Path location can differ between web hosting providers. 

If you are not sure of what to enter in this field, check with your Hosting 
Provider. An incorrect file path can cause your website to be published to the 
wrong location and not accessible via your web browser. 

Once you have entered in your FTP Server Details, you can use the ‘Test 
Connection’ button to check if the connection to your Hosting Provider’s server 
is working correctly. 
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Publishing Settings 
To improve the speed of publishing your website, you can take advantage of 
multiple connections from your computer to your Hosting Server.  

Use the ‘Maximum Connections’ drop down in the Publishing tab of the 
EverWeb-> Settings... menu to change the number of connections you want to 
use when publishing (see Figure 13.7). 

The more connections that are in use, the faster 
the publishing of your website. However, with 
more connection in use, publishing may become 
less reliable. 

The fewer connections will result in slower but 
more reliable publishing. 

Some hosting providers limit the number of 
connections that can be used, usually to around 5 
connections. 
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Figure 13.7: EverWeb’s Publishing Settings... options, 
showing the ‘Maximum Connections’ dropdown.
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14Responsive Websites

This chapter introduces you to Responsive Web Design, 
how it works in EverWeb and how to create your first 
responsive website. 

EverWeb’s Responsive Web Design features are only 
available in EverWeb version 2.8 or higher.

Introduction

What Is Responsive Website Design?

Responsive or Traditional Design?

EverWeb’s Responsive Web Design Features

Creating a Responsive Website

Creating a Responsive Page

Responsive Page Structure

The Responsive Row Widget

Widgets & Responsive Pages

The Responsive Row Widget

Testing Your Responsive Page

Responsive Blogging
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Responsive Websites in EverWeb 
Introduction 
This chapter introduces you to Responsive Website Design (RWD) in EverWeb 
and shows you how to create your first responsive website.  

If you are new to creating responsive websites in EverWeb you will need to 
learn about responsive design concepts and how they work within EverWeb. 

Before starting your first responsive website, it is advantageous to have an 
understanding of EverWeb itself. The previous chapters describe EverWeb’s 
features and functions in detail and how to build a ‘traditional’ website. Most of 
these features and functions can also be applied to a responsive website 
design. It is recommended that you review the previous chapters before 
starting your first responsive website if you are not familiar with EverWeb. 

What is Responsive Website Design? 
Responsive Web Design is an approach whereby web pages automatically 
scale to suit the device on which they being viewed upon using one only page 
design.  

This approach differs from ‘Traditional’ website design which is where you 
develop separate desktop and mobile web pages, then link them together 
with a built in redirect. Your visitor will be ‘directed' to the appropriate page, 
desktop or mobile, depending on which device the website is being viewed 
upon.  

Content First 
In Responsive Web Design your page content is of primary importance. 
Content can be text, or an image, shape or media such as audio and video and 
so on.  

Content automatically rescales to suit the device it is being viewed on from 
wide desktop computers down to mobile phones and everything in between. 
As such, your content will need to be consistent across devices and EverWeb 
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makes this easy and flexible to do. However, it is always important to test your 
design across different types of device to make sure it always displays correctly. 

Responsive or Traditional Design? 
Responsive Website Design was created to make development of fully 
scaleable websites quick and easy. However, there may be times when a 
responsive website may not be the best approach. 

If you are unfamiliar with responsive design it is recommended that you build 
a test website first. Investing some time and effort in experimenting with 
responsive design will help you learn about how it works in EverWeb. 

If you want to redevelop an existing 'traditional' style website in to a responsive 
website design, this will probably require some design compromise in the 
process. Do not expect your responsive design to look and/or function in 
exactly the same way as your traditional website design. Responsive website 
design is more structured than traditional website design which is more free 
form in approach. 

The following lists some of the advantages, and disadvantages, of responsive 
website design compared to traditional website design:  

Advantages of Responsive Web Design 
• Your website design is automatically scaleable on any device. 

• Google likes responsive websites and ranks Responsive websites higher 
in Search Engine Results Page rankings pages. 

• Responsive design promotes website design unity across devices 

• Requires only one website that caters for all devices 

• May reduce development and maintenance time, cost and effort 
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Disadvantages of Responsive Web Design 
• Responsive website design is conceptually difficult and difficult to 

learn. 

• Constrained design approach. Typically, responsive website design is 
not a good for creating free form websites. 

• May increase development and maintenance time, cost and effort 

• Page loading times can be slower than for ‘Traditional’ websites. 
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EverWeb’s Responsive Web Design 
Features 
Before you start building your first responsive website, it is important to get to 
know EverWeb’s Responsive design features. This will save you time, effort 
and potential frustration and will make your website planning, design and 
building tasks easier. 

1. EverWeb 
To build responsive websites in EverWeb you will need version 2.8 or higher 
installed on your computer. We recommend using the latest version of 
EverWeb to get the best out of responsive design. ` 

2. Responsive Themes & Pages 
When adding a responsive page to your EverWeb project, you can choose to 
see only Responsive Theme Templates by selecting ‘Responsive’ from the 
dropdown menu in the top right hand corner of the Theme Template Chooser. 

Next, click on the Responsive Theme that you want to use from the left column 
and then the page style you want from the right side of the Theme Template 
Chooser. 

To create your own design from scratch, use a blank responsive page. In the 
Theme Template Chooser you can select the ‘Home’ page of the Blank 
Responsive Theme Template or use the ‘Responsive’ page style in the Blank 
Theme Template. 

3. Responsive Page Layout 
Responsive web pages in EverWeb use a ‘Responsive’ page layout as indicated 
in the Page Layout section of the Page Settings tab of the Inspector Window. 

When using the Responsive page layout, objects on the page scale 
appropriately on any device on which they are displayed.  
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When using a Responsive Page Layout, only the following options are available 
in the Page Layout section of the Page Settings tab: 

• Top Margin  

• Minimum Content Height 

• Minimum Footer Height 

4. Responsive Widgets 
EverWeb includes a number of widgets specifically designed to take 
advantage of responsive page design: 

• Responsive Row Widget 

• Responsive Image Gallery Widget 

• Text Section Widget 

• FlexBox Widget 

5. The Responsive Row Widget 
The Responsive Row widget is one of the cornerstones of responsive design in 
EverWeb. The widget acts as a ‘container’ that you can drag and drop 
TextBoxes, shapes, images and other widgets into. The Responsive Row 
Widget is discussed in more detail in the next section. 
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layout and advise you how to proceed.
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6. Responsive Ready Widgets 
Most of EverWeb widgets are Full Width capable such as the Navigation Menu 
and Image Slider widgets.  

Other widgets, such as the PayPal and Facebook Like widgets are not full 
width capable so need to be placed inside a Responsive Row widget to 
function properly. If you try to add a widget that is not Full Width capable to a 
Responsive page you will see a warning message (Figure 14.1). 

The following widgets need to be placed in to a Responsive Row Widget to 
work properly: 

• RSS Feed Widget 

• Image Gallery Widget (Use the Responsive Image Gallery Widget 
Instead) 

• Facebook Like Widget 

• Facebook Page Timeline Widget 

• Live Photo Widget 

• PayPal Widget 

• Pinterest Widget 

• X (formerly Twitter) Follow Me Widget 

7. The Navigation Menu Widget 
EverWeb's Navigation Menu Widget includes a Responsive Options section so 
that the navigation can automatically adjust to the screen width. 

8. Pick Layer 
To select a full width object on a page, e.g. a Responsive Row widget, you only 
need to click on the full width object itself.  
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When using a Responsive page layout, you will not see any grab handles on 
the left and right vertical sides of full width objects, as full width objects always 
scale to fill the available page width. 

Some full width widgets have grab handles in the center of their top and 
bottom edges so that you can adjust their height. When used at full width, 
objects such as the Navigation Menu widget, Responsive Row widget, 
TextBoxes, shapes and images can be height adjusted. 

Some full width widgets cannot be height adjusted due to the functionality of 
the widget itself e.g. the FlexBox widget, and the Responsive Image Gallery 
widget. In this case, no grab handles appear even when the full width object is 
selected. Note that you can add top and bottom margins in some widgets, 
such as the FlexBox widget, using the widget’s Widget Settings. 

In such instances where you need to specifically select a full width object, use 
Pick Layer. This feature ensures that you have the right object selected. To use 
Pick Layer: 

1. Secondary click on the object you want to select 

2. Mouse down to the ‘Pick Layer’ option in the popup menu. 

3. A sub menu will be displayed showing the ‘layers’ that can be selected. 
Click on the layer that you want to select e.g. Responsive Row’. 

9. Embed In & Remove From Responsive Row 
Pick Layer lets you specifically select an object. The ‘Embed In’ option lets you 
place a selected object within a Responsive Row widget. For example, if you a 
responsive row widget to your page, you may want to add a TextBox inside it. If 
however, the responsive row widget is not selected when you add a TextBox 
from the Toolbar to the page, the TextBox will be placed below the Responsive 
Row widget and not inside it. The TextBox will also, in this instance, be a full 
width rather than a non-full width object that it would have been if it was 
correctly placed inside the Responsive Row widget. 

To move the TextBox into the Responsive Row widget: 

1. Select the Full Width TextBox 

2. Secondary click on the TextBox. A menu of options will appear 
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3. Click on the ‘Embed In’ option. A list of the Responsive Row widgets 
that are used on the page appears. 

4. Select the Responsive Row that you want to place the TextBox in. 

5. The TextBox is placed within the Responsive Row widget as a full width 
object. 

6. To make the TextBox a non-full width object, go to the Metrics 
Inspector and deselect the ‘Full Width’ checkbox. You will now be able 
to adjust all of the TextBox’s dimensions. 

EverWeb also includes a ‘Remove From Responsive Row’ option so that you 
can easily take objects out of the Responsive Row if you need to. 

 

10. Show On Device 
The Metrics Inspector includes a 
‘Responsive’ section (See Figure 14.2). You 
can use the ‘Show on…’ Device checkboxes 
to control on which devices an object will 
be displayed upon. The four device types 
are mobile, tablet, desktop and wide 
desktop.  

When an object is hidden you can reveal it by either secondary clicking on the 
page, selecting Hidden Objects then choosing the object you want to show, or 
by using the Window-> Show Hidden Objects menu option. 

The Show on Device option can be used for objects on either Responsive or 
Fixed Width page layouts. 

Note: Full Width Section objects on a responsive page cannot be hidden per device. However, 
objects within a Responsive Row can be hidden, allowing you to add objects that only appear 
on your page on specific devices. 
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11. Breakpoints 
Use breakpoints to set the point at 
which a responsive page will respond 
to a change in device. Using 
breakpoints ensures that a responsive 
page will always format and display 
objects correctly on each device type.  

Click on the ‘Breakpoints’ button in 
the Inspector or go to the Insert menu 
-> ‘Breakpoints…’ to set the page width 
for mobile, tablet and desktop devices 
(See Figure 14.3). To reset the values 
back to their original setting click on 
the ‘Set Default’ button. In the 

Breakpoints dialog box. 

The Breakpoints dialog lets you set the maximum width for each device. 
Anything larger than Desktop will be considered ‘Wide Desktop’. 

Breakpoints are displayed as dashed vertical lines in the Editor Window. To 
toggle this display on and off, use the Window-> Hide/Show Breakpoints menu 
option. 

12. Margins & Maximum Content Width 
When using a Full Width object in your page design, you may find that its 
content is goes right to the edges of the page. Use the Margins option in the 
Metrics Inspector to add left and right margins so that the content is better 
placed on the page. 

You can also limit the maximum width of a full width objects on the page. This 
is useful as it can help the object’s content appear not to be too spread out on 
large desktop screens. You can find Maximum (Content) Width fields either in 
the Widget Settings of a widget, or in the Metrics Inspector. The default value 
is set to zero which equates to filling the complete width of the page. 

You may also want to add more space at the top and bottom of the full width 
object. This can be achieved in a number of different ways e.g. using the top 
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and bottom Padding options in the Responsive Row widget, the top and 
bottom margin options in the FlexBox widget, full width shapes above or 
below the current full width object, using margins options in the Text 
Inspector etc. Choose the option that is most appropriate to your page design.  
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Creating a Responsive Website 
Introduction 
This section of the chapter takes you through creating a responsive page and a 
responsive blog page.  

Creating a Responsive Page 

The following instructions can be used to create a Responsive page or a 
Responsive Master Page. The general process is the same. 

1. If you are creating a new project, click on the ‘Create a new website’ 
button on the Projects Window. The Theme Template Chooser will 
appear (See Figure 14.4). To quickly find Responsive Theme Templates, 
click on the filter drop down menu in the top left hand corner of the 
Theme Template Chooser. Select Responsive from the drop down. The 
list of Theme Templates in the left hand column will now display only 
Responsive Theme Templates. 
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Figure 14.4: The Theme Template Chooser displaying the Filter menu in the top left corner of the screen. 

http://www.everwebapp.com


EverWeb User Manual	 Responsive Websites

2. Select the Responsive Theme Template you want to use in the left 
hand column then select the page style you want from the right hand 
side. 

3. To create a blank responsive page select the ‘Blank Responsive’ Theme 
Template in the left hand column, then select the ‘Home’ page style 
from the right hand side. Click the Select button to finish,  

4. To add a responsive page to an existing project, use the ‘Add Page’ 
button in the Toolbar. To quickly find Responsive Theme Templates, 
click on the filter drop down menu in the top left of the Theme 
Template Chooser and select ‘Responsive’. The list in the left column 
will now display only EverWeb’s Responsive Theme Templates. Select 
the Responsive Theme Template you want to use and then the page 
style from the right hand side. To create a blank responsive page select 
the ‘Blank Responsive’ Theme Template in the left column and then 
the ‘Home’ page style from the right.. Click ‘Select’ to finish,  

5. You have now created a responsive page in your website project. 

6. Rename the page by double clicking on the page name in the Web 
Page List and name it as required. Press Enter to finish. 

Creating a Responsive Master Page 
1. Creating a responsive Master Page is the same as creating a regular 

responsive page, except that you use the ‘New Master Page’ button in 
the Master Page area of the Web Page List to create the Master Page.  

2. If you want to use a Responsive Theme Template for your Master Page, 
click on the filter drop down menu in the top left of the Theme 
Template Chooser (See Figure 13.2). Select ‘Responsive’.  

3. The list in the left hand column will now display only Responsive 
Theme Templates. From the Theme Template Chooser select the 
Responsive Theme Template you want to use, then select the page 
style from the right hand side.  

4. To create a blank responsive Master Page select the ‘Blank Responsive’ 
Theme Template in the left column then the ‘Home’ page style from 
the right hand side. Click ‘Select’ to finish. 
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5. When you create a responsive Master Page, the ‘Page Layout’ in the 
Page Settings tab of the Inspector Window will be ‘Responsive’. The 
'Content Width’ and ‘Minimum Header Height’ fields will not be 
available as they are not used in responsive design.  

6. If you have content in the body or footer area of the Master Page that 
extends past the Minimum Content and Footer Height values set in 
the Page Settings tab of the Inspector Window, the section will 
automatically expand to accommodate the objects within the section.  

 

Changing The Page Layout 
EverWeb uses three page layout styles: Left 
Aligned, Centered and Responsive. You can 
change the Page Layout of your page to a 
different layout type if you want. However, when 
doing so, the design of the page may be radically 
altered. Therefore, you will not be able to undo 
this action. EverWeb will warn you if you decide to 
change the Page Layout style (see Figure 14.5). 
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Figure 14.5: If you change the Page 
Layout from one type to another, 

EverWeb will warn you first as making a 
change to the page layout cannot be 

undone afterwards.
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Responsive Page Structure 
Responsive website design uses ‘containers’, known as ‘Sections’, that keep 
objects in a formal structure. Sections have the following features: 

• Sections are always horizontal across the page. 

• Sections always take up the full width of the page no matter on what 
type of device the page is being displayed upon. 

• An object can be a section in its own right if it is Full Width capable e.g. 
the Navigation Menu widget, a TextBox or a shape can all be full width 
objects. 

• Objects that are not full width capable need to be placed in the 
Responsive Row widget which is a special section that can also contain 
full width objects if required. 

• Objects within a section always remain inside the section no matter on 
what device they are displayed upon. 

Responsive Pages on Different Devices 
When designing your website you may not necessarily want all objects on the 
page to be displayed on all devices. Alternatively, you may want to replace one 
object with a different object depending on the device which the page is 
being viewed upon. 

To enable this, use the ‘Show on Device’ options in the Responsive section of 
the Metrics Inspector.  

Breakpoints 
EverWeb also lets you customize the point at which a device is regarded as one 
type or another. Breakpoints set the page width at which a device display will 
change from one type to another. Click on the ‘Breakpoints’ button in the 
Responsive section of the Metrics Inspector to set the breakpoints for mobile, 
tablet and desktop devices. Use the ‘Set Default’ button in the Breakpoints 
dialog box to reset the values back to their initial defaults. 
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The Editor Window displays breakpoints as dashed vertical lines. You can 
toggle the view of the breakpoints on and off using the Window-> Hide/Show 
Breakpoints menu option. 

Hidden Objects 
To locate a hidden object, secondary click on the responsive page. In the 
menu, scroll to the ‘Hidden Objects’ section and choose the object that you 
want to work with. The object will be displayed showing the objects contents. 
The selected box will be displayed with a grey background and a ‘X’ cross 
through it. The object will disappear when you click elsewhere on the canvas 
unless you have Window-> Show Hidden Objects set. In this instance, the 
contents of the selected hidden object will disappear leaving the grey box with 
the ‘X’ cross through it left in tact. 

Use the Window-> Show Hidden Objects menu option to display the location 
of all hidden objects on the page. 
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Sections Create the Structure of Responsive Pages 
In the example in Figure 14.6, the web page on the left has been broken down 
in to its component parts as shown on the right. The objects within each 
horizontal section are represented in diagram on the right. 

Some objects can be a section in their own right e.g. the TextBox shown in the 
fourth section down from the top in Figure 14.6 above.  

Objects can also be placed within a section e.g. in the second section down 
from the top of Figure 14.6, the large logo on the left, text in the middle and 
button on the right have been placed within a Responsive Row widget. 

As a page can be viewed on different devices such as a mobile phone or 
desktop, sections automatically scale to display properly on each device. 
Objects inside the section also adjust their relative positions within the section 
in order to display correctly. 

For example, the objects within the green/blue rectangle section of Figure 14.6 
are displayed as if being viewed on a desktop device. 

On a mobile device the objects may look like how the appear on the left in 
Figure 14.7. On the right is the diagrammatic representation of the objects in 
the section. The section and the three objects it contains are the same as they 
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were on the desktop, but their height and widths have scaled automatically to 
fit the mobile device the page is being displayed upon. 

 
Adding Objects to a Responsive Page 
When you drag and drop an object on to a responsive page layout, if the object 
is Full Width ‘capable’ it will be added as a Full Width object and will become a 
sectioning its own right 

Full Width objects may also be placed in the Responsive Row widget as 
required e.g. if you want to add top and bottom padding to the Full Width 
object. 
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Objects that are not Full Width capable, such as the PayPal widget, should 
always placed in a Responsive Row Widget so that they work properly. 

Adding New Sections To The Page 
You can add a new section object to the page just by dragging and dropping it 
the location where you want it placed. 

Moving Sections On The Page 
You can easily reorder sections on your page. Just drag and drop the section 
you want to move to its new location. Alternatively, use the Up and Down 
Arrows in the top left hand corner  

Deleting A Section From The Page 
To remove a section from the page select the section (you may need to use 
Pick Layer to make sure you have selected the right section) then press the 
backspace key on your keyboard. Alternatively, use the Trashcan icon in the top 
left hand corner of the Responsive Row section object. When you delete a 
section all of the objects inside the section will also be deleted. 
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Setting Section Margins 
Section objects can have their left and right 
margins set. This can be useful as otherwise a 
section object may be too close to the page 
margins. To set a section margin: 

1. Select the section object that you want 
to apply a left and/or right margins to.  

2. Go to the Metrics Inspector (see Figure 
14.8). 

3. Set the left and right margins as 
required. 
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Widgets & Responsive Pages 
Widgets play an important role in responsive design in EverWeb. Widgets can 
either be Responsive Only, Responsive Ready or require embedding in the 
Responsive Row widget in order to work properly in responsive pages. 

Responsive Only Widgets 
EverWeb includes some widgets specifically designed to be used only in a 
responsive page layout e.g. the Responsive Row, FlexBox, Text Section and 
Responsive Image Gallery widgets. These widgets offer special layouts, features 
and effects that are scaleable for any device from mobile phone to wide 
desktop. 

Whilst these widgets be used in other page layouts, this is not recommended 
or supported as the widgets may be have unpredictably. 

The Responsive Row widget is a special EverWeb widget that is used 
extensively in responsive web page design as it includes special features to 
help you more easily create your responsive website. 

The Responsive Row Widget 
The Responsive Row widget is the cornerstone of your Responsive website 
design. You can embed objects such as TextBoxes, images, shapes and other 
widgets within it. 

Adding a Responsive Row Widget to the Page 
To add a Responsive Row Widget to the page go to the Widgets tab and drag 
and drop it on to your page. You can add as many Responsive Row widgets as 
you want to the page. 

When you add the widget to the page, it is added as a full width object (See 
Figure 14.9). 
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In Situ Responsive Row Toolbar 
When you add a Responsive Row Widget to the page, you will see at the top of 
the widget a blue Responsive Row Toolbar displayed across the width of the 
widget. The blue bar itself is only displayed when the widget has been 
selected. You can, however, click on the any of the Toolbar’s icons in the top left 
hand corner of the widget at any time to access their features. Alternatively, 
the Toolbar’s features can be accessed through the Widget Settings tab in the 
Inspector Window. The Responsive Row Widget’s features are discussed below. 

Naming a Responsive Row Widget 
If you have more than one Responsive Row widget on your page, it is usually a 
good idea to give each Responsive Row its own unique name. To do this, you 
can use the ‘Responsive Row Name’ field in the Widget Settings. For example, 
you could name a Responsive Row in the Footer section of the page as ‘Footer 
Row’. The name of the Responsive Row appears in the center at the top of the 
widget. 

Alternatively, click on the Settings Cog in the Responsive Row Toolbar and 
select ‘Responsive Row Name…’ 

Also use this feature if you need to rename your Responsive Row at any time. 
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it. A Toolbar allows you easily move the widget up or down, change its settings or delete the widget.
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Selecting a Responsive Row Widget 
To select an empty Responsive Row widget, just click on it. The Responsive 
Row Toolbar will turn blue at the top of the widget. 

If there are objects already embedded in the Responsive Row widget, click on 
an area of the widget where there are no objects. When the widget is selected, 
the Responsive Row Toolbar will turn blue at the top of the widget and you will 
see grab handles positioned at the top center, and bottom center, of the 
widget. You can also see that the widget has been selected as its Widget 
Settings should be now available in the Inspector Window. 

Moving A Responsive Row Widget 
To reposition the Responsive Row widget on your page, you can do so in a 
number of ways: 

1. You can click and hold the mouse button down inside the Responsive 
Row widget then drag and drop the widget to its new location. 

2. You can directly click on the Up/Down icons in the Responsive Row’s 
Toolbar to move the widget up and down the page. 

3. You can click on the Responsive Row widget. The Toolbar will turn blue. 
Use the Up/Down icons to move the widget. 

4. You can click on the Responsive Row widget so that the Toolbar turns 
blue. Click and drag the blue Toolbar to where you want it located.  

5. You can click on the Responsive Row widget so that the Toolbar Tuens 
blue. Use the repositioning icon to the right of the Toolbar to drag and 
drop the widget to its new location. . 
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Adding Objects to a Responsive Row Widget 
To embed objects in to a Responsive Row widget, drag and drop objects you 
want in to the widget. These objects can be either Full Width e.g. a Navigation 
Menu Widget, or a fixed width object such as the PayPal Widget, a TextBox, 
image, shape and so on. 

When adding objects in to the Responsive Row Widget, make sure that the 
Responsive Row Widget has already been selected. If the widget has not been 
selected, it is possible that when you add objects, they may fall outside of the 
Responsive Row widget. Refer to the next paragraph if this Is the case. 

Moving Objects in to a Responsive Row Widget 
If, for example, the Responsive Row widget is not selected and you try to add a 
new TextBox into the widget, the TextBox will be positioned at the bottom of 
the page as a Full Width object instead.  

To move the TextBox into the Responsive Row widget, first select the TextBox, 
then secondary click in it. Go to the ‘Embed In’ option and select the 
Responsive Row you want to place the TextBox inside of. The TextBox will be 
placed inside the Responsive Row widget. If the TextBox is not to be full width, 
uncheck the Full Width box in the Metrics Inspector.  

You can also select multiple objects at one time and move them in to the 
Responsive Row widget using the same method as described above. 

Moving Objects Within a Responsive Row Widget 
When you add objects to the Responsive Row Widget, you may want to 
change the order in which they are displayed. To do this, simply drag the 
object you want to move either to the left or right, and/or up and down if 
necessary, within the Responsive Row. Drop the object into its new position.  

When moving objects within a Responsive Row Widget, you will see blue 
vertical guide lines that show you where the vertical border of the objects are. 
These guides help you position the object you are moving more easily. You can 
also select multiple objects at one time in the Responsive Row and move all 
the selected objects at once. 
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Moving Objects Out of a Responsive Row Widget 
To move an object out of a Responsive Row, secondary mouse click on the 
object in the Responsive Row, then select the ‘Remove from Responsive Row 
menu option.  

Moving Objects From One Responsive Row Widget to 
Another 
To move an object embedded in a Responsive Row in to another Responsive 
Row, just drag and drop the object from one to the other. 

Deleting Objects From Inside a Responsive Row Widget 
To delete an object that is embedded in a Responsive Row Widget, select the 
object then press the backspace key on your keyboard. 

Deleting a Responsive Row Widget 
To delete a Responsive Row widget, click on the widget to select it. You should 
see the widget’s Toolbar turn blue to show that it has been selected. Press 
backspace to delete the widget, or click on the Trashcan icon in the Responsive 
Row Toolbar. 

When you delete the Responsive Row widget, any object that it contains will 
also be deleted.  

If you delete the widget by mistake, use Cmd+Z to undo the action. 

Responsive Row Widget Settings 
The Responsive Row Widget Settings in the Inspector Window are used to 
adjust various aspects of the objects that are embedded within it (see Figure 
14.10).  

Alternatively, you can access the following settings using the Settings Cog in 
the Responsive Row’s Toolbar within the widget itself. 
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Responsive Row Name 
By default, each Responsive Row is named 
‘Responsive Row’. When you use the ‘Embed In’ 
option, you will see all of the Responsive Row 
widgets on the page listed as e.g. ‘Responsive 
Row 1’, ‘Responsive Row 2’ and so on.  

If you have a large number of  Responsive Row 
widgets on your page it can become confusing 
when trying to embed an object in to the right 
Responsive Row.  

Giving your Responsive Rows widgets a 
descriptive name will therefore, help make it 
easier to embed an object in to the correct 
Responsive Row widget. 

Alignment 
Behavior 
Objects within the Responsive Row usually ‘wrap’ 
from left to right. As you decrease the width of the 
Editor Window or browser (when you preview or 
publish your website) the objects inside the 
Responsive Row widget will eventually be 
wrapped from top to bottom instead of left to 
right. If you set ‘Behavior’ to ‘Reverse Wrap’, 
objects will be wrapped from right to left and 
bottom to top as you decrease the width of the 
browser. 

•

Vertical Alignment 

Objects can be aligned to the Top, Bottom or Middle of the Responsive Row 
Widget. 

Horizontal Alignment 
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Objects can be horizontally aligned in a variety of ways, for example, Left, 
Center or Right aligned within the widget. Objects can also be evenly spaced 
out in the widget using the Justify option, or evenly spaced from the center 
point of the widget using the Justify-Center option. Furthermore, you can use 
Overlap to if you want to overlap two objects within the Responsive Row. 

Padding 
Use ‘Padding’ to add space at the ‘Top’ and ‘Bottom’ of the widget.  

Embedded Object Settings 
Insert Margin 
Use the ‘Insert Margin’ option to add vertical and horizontal padding between 
the objects inside of the Responsive Row widget. This option is similar to the 
‘Insert Margin’ option in the Text Inspector as it enhances the display layout of 
the objects within a Responsive Row. 

Content Maximum Width 
Use this option to limit the display width of the Responsive Row itself. This is 
useful when you are displaying objects within the Responsive Row on a 
desktop and do not want them to be too widely spaced out. The default value 
of zero equates to the full width of the page.  

Overlap 
The Overlap setting allows you to overlap two objects in a Responsive Row. To 
use this setting, first set ‘Overlap’ as the Horizontal Alignment. Once you have 
selected this alignment, the Overlap setting will become available. Set the 
overlap of the two objects as you desire. 

Formatting The Responsive Row Widget 
You can easily format the background of the Responsive Row widget by using 
the formatting settings in the Shape Options tab. Once you have selected the 
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Responsive Row widget, use the Fill section to add a background color, color 
gradient, image, slide show, video or map, to the Responsive Row.  

Whilst most Fill options are straightforward to use with the widget, the Slide 
Show and Video Fill options can be used to take advantage of the Responsive 
Row as explored below: 

Using Fill: Slide Show with a Responsive Row Widget 

The Responsive Row widget can include a background slide show. You can also 
add a slide show to objects such as TextBoxes, Images and rectangle shapes 
that are embedded within the Responsive Row. 

Adding a Background Slide Show to the Responsive Row Widget 

To add a background slide show to a Responsive Row widget: 

1. First add a Responsive Row widget to the page, or select one that is 
already on your page.  

2. Add the objects that you want to include in to the Responsive Row if 
you have not done so already. 

3. To add a background slideshow to the Responsive Row, make sure that 
the Responsive Row is selected.  

4. Next, go to the Shape Options tab and select the ‘Slide Show’ option 
from the Fill dropdown menu. 

5. Add the images you want to use for the background slides and adjust 
the Transition and Navigation Options as desired. 

Adding Objects to the Responsive Row Slide Show 

You can add objects to any slide in the Responsive Row.  

1. Use the navigation arrows (see Figure 8.8) to select the slide that you 
want to add an object to. 
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2. Once the background slide is visible, click on the Responsive Row to 
select it. 

3. Add the objects that you want to the currently visible Responsive Row 
slide e.g. TextBoxes, images, shapes, other widgets and so on. 

4. If you have added an object to the wrong Responsive Row slide, you 
can easily move it to another slide. First select the object you want to 
move then secondary click. Select the submenu option ‘Embed In’ 
then choose the slide in the Responsive Row that you want to move 
the object in to. 

Using Video Fill: Example Use in a Responsive Row Widget 

You can easily set up your own simple Video Gallery using Video Filled objects 
within a Responsive Row widget 

1. Start by adding a Responsive Row widget to your page. 

2. With the Responsive Row widget still selected add a rectangle shape, 
using the Shape button in the Toolbar, to the Responsive Row. 

3. Select the rectangle shape, then go to the Shape Options tab and set 
the Fill  to ‘Video’. 

4. In the dropdown menu below the Fill dropdown menu, select the video 
source: External Video URL, Local Video File, YouTube Video or Vimeo 
Video. 

5. Enter the location of the Video source in the Video Location field below 
the Video Source dropdown. If you are using a Local Video File, click on 
the Choose… button and select the video file that you want from the 
Assets List. 

6. Once you have selected your video, set the other Video Fill options as 
desired. 

7. When you have finished, you can duplicate the video object as many 
times as you like to create your video gallery Use the Edit-> Duplicate 
menu option, or the Cmd+D shortcut key to duplicate the video object.  

Using Map Fill 
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You can add a map to your page, either using the Google Maps widget or by 
using the Map Fill option in the Shape Options tab. Using the Google Maps 
widget will give you the same map type as using Map Fill’s Simple 
(Deprecated) option.  

The Map Fill option offers you more flexibility than using the Google Maps 
widget, for example, you can add a map as the background of a Responsive 
Row widget. Map Fill includes three options: 

• Simple Map (Deprecated) 

• Basic Map (Free) 

• Advanced Map  

The Simple Map (Deprecated) offers the same features as you would find if you 
were using the Google Maps widget. 

The Basic (Free) and Advanced Map Fill options give you expanded map 
options including: 

• Roadmap or Satellite view 

• Ability to Zoom 

• Show Terrain and 

• Show Labels 

In addition, if you are using the Advanced Map option you can also use the 
following features: 

• Show Controls 

• Ignore Mouse Gestures 

• Always Show Label on Marker 

• Ability to add your own Label 

About Google Maps Platform 
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In order to use the features found in the Basic (Free) and Map Advanced Map, 
you will need to use a Google Maps API Key. EverWeb will help you to generate 
the necessary Key.  

Once you have generated the necessary Key you will then enter it in to the 
Map Fill ‘Google Maps API Key’ field. 

Generating the Google Maps API Key is easy because when you select the 
Basic or Advanced Map option, EverWeb will display a dialog box with an 
option to ‘Get Google Maps API Key’.  

When you click on this option, you will be taken in to Google Cloud Platform 
which will then step you through generating a Maps API Key that you can use 
in EverWeb. 

In order to generate a Google Maps API Key, you will required to complete the 
following steps: 

• Create a Google account if you do not already have one, then add 
Google Cloud Platform to your account. 

• If you already have a Google account, you may be asked to log in. Once 
logged in you may be asked to add Google Cloud Platform to your 
account. 

• You may be asked to supply billing details to Google. If you are using 
the Basic (Free) option in EverWeb, you will not be billed. If you are 
using the Advanced Maps option, you will be charged by Google for 
using the Advanced Map features. 

• You will need to create a Google Could Platform Project, if you have not 
already created one. 

• You will need to make sure that you enable Google Maps Platform APIs 
and SDKs for your Google Cloud Platform project. 

Once you have completed the steps required by Google to generate a Google 
Maps API Key, copy the API Key to the Clipboard and paste it in to the Google 
Maps API Key field in the Map Fill section in EverWeb.  

www.everwebapp.com	 ￼  of ￼277 322

http://www.everwebapp.com


EverWeb User Manual	 Responsive Websites

Using Dividers for Styling a Responsive Row 

Dividers are useful to indicate to visitors the end of one section of a page and 
the beginning of another, or to provide some styling to your page. See Dividers 
in the Shape Options section of the manual for more details. 
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Testing Your Responsive Page 
Testing your responsive page should always be carried out as you will need to 
see if the page displays correctly on desktop, tablet and mobile devices. Often 
you can use EverWeb’s Preview feature to test how the page will look. 

Alternatively you can use responsive features within browsers such as Apple’s 
Safari web browser which includes responsive preview in its developer menu. 
There is also Apple’s Simulator which is part of Xcode that will simulate 
different Apple devices. This is available free from the Apple Developer website. 
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Responsive Blogging 
EverWeb includes a Responsive Blog that is available from the Blank 
Responsive Theme Template. To add the Responsive Blog to your website: 

1. Click on the Add Page button. 

2. The Theme Template Chooser will appear. In the left hand column, 
select the 'Blank Responsive’ Theme Theme template which is the 
second Theme Template in the list. 

3. Once you have selected the Theme Template, click on the ‘blog’ page 
style on the right hand side and then click ‘Select’. 

4. The Responsive blog has been added to your website project. 

Converting an Existing Blog to a Responsive Blog 
If you have an existing Fixed Width layout blog, you can convert it to a 
responsive blog. Before converting your blog it is recommended that you 
backup your website project file in case you want to revert back to the original 
fixed width blog later. 

To convert a blog, change the format of the Page Layout from the current 
layout to ‘Responsive’ for the blog main, archive and posts pages. 
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15Contact Forms 
Enhanced Addon

This chapter introduces you to EverWeb’s Contact Forms 
Enhanced Addon which is for use with the Contact Form 
Advanced widget. 

You will learn how to purchase and use the Contact Forms 
Enhanced Addon so you can manage and generate 
reporting from your Contact Form Submissions.

What is Contact Forms Enhanced Addon

Purchasing and Installing Contact Forms Enhanced Addon

How To Use CFE Addon in the Contact Form Advanced 
Widget

Adding File Upload Capability To Your Contact Form

Managing and Reporting Form Submissions

Selecting a Form to View Form Submissions & Selecting 
Form Submissions 

Sorting & Searching Form Submission Data

Displaying The Number of Form Submissions Per Page

Downloading Uploaded Files

Creating Mass Mailings with Contact Forms Enhanced
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Contact Forms Enhanced Addon 
EverWeb’s Contact Forms Enhanced Addon (CFE) allows you to manage a 
database of contact information created from the contact forms visitors to 
your website have submitted via the Contact Form Advanced widget.  

The data in the contact form that the user sends you is known as a Form 
Submission. Visitor data is stored securely in your EverWeb Client Area where 
it is easily accessible and can be downloaded to a CSV file. 

You can use Contact Forms Enhanced Addon to store email addresses 
gathered from your contact forms to help you create mail shots to existing and 
potential new customers, newsletter email lists, surveys, promotions and so on. 
You can also target specific groups or market segments based on questions 
you ask in your contact form. There are countless possibilities! 

Each contact form can have its own unique Contact Form Name so, for 
example, you could name a form for a survey, promotion, newsletter 
subscription and so on. 

Other Contact Forms Enhanced Addon features include: 

• Calendaring features can be added to your Contact Form using the 
‘Calendar’ control. When using the control, a full calendar popup 
window appears. You can modify the calendar’s date formats, block 
out specific days and more. The calendar is fully responsive and so is 
perfect for mobile phones, tablets and desktop computers. 

• The ‘Select Time’ control lets displays a popup window to select 
specific times. The time format is fully customizable as are the time 
selection intervals and the earliest and latest available time slots. 

• Visitors can upload files to the EverWeb servers that you can download 
the files safely at a later time from your EverWeb Client Area. 

• Contact forms can send a confirmation email to the visitor who 
submitted the form. You can customize the message and use any form 
control variables based on what the visitor entered in the form. The 
‘Confirmation Email’ input box includes an example.. This feature 
requires that both Contact Forms Enhanced Addon and reCaptcha 
SPAM protection are enabled. 
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• The Contact Form Advanced widget allows you to remove the links 
that ask you to upgrade or login to your account to download file 
uploads from the form submission email. 
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Purchasing & Installing Contact Forms 
Enhanced Addon 
To purchase and use Contact Forms Enhanced Addon, follow the steps below:  

1. Visit our Secure Online Store to 
purchase the Contact Forms 
Enhanced package you need. You can 
upgrade/downgrade at any time for 
more/less submissions or file upload 
space. 

2. Once you have completed your 
purchase and your account is 
activated, you will receive an email 
with the Subject 'Contact Forms 
Enhanced Setup Instructions' 

3. Now, simply select your existing 
Contact Forms, or add a new one to 
any page. From the Inspector go to to 
the Widget Settings tab and select the 
'Contact Forms Enhanced Add-ons' field from the top of the Inspector 
(See Figure 15.1).  
 
Note: If you do not see any options listed, quit and relaunch EverWeb and make sure 
you are signed in from the EverWeb Settings... window. 

If you are an EverWeb+Hosting account user, once you have addedContact 
Forms Enhanced to your contact form, you can log in using the ‘EverWeb’ 
dropdown menu option in the ‘Mail Sending' section. When using this option, 
you do not need to use the ‘SMTP Settings’ section of the widget. 
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How To Use Contact Forms Enhanced 
Addon in Your Contact Form 
With Contact Forms Enhanced Addon enabled, go to the 'Contact Form 
Name' field and name the form appropriately. If you have more than one 
website, you may want to include the project file’s name in this field as well. 
This will make identifying forms easier when managing and reporting form 
submissions (See Figure 15.1). 

This name is used within your Client Area in order to separate and easily 
identify each contact form you have created. 

Adding ‘Calendar’ and ‘Select Time’ Controls 
If you want to add calendaring and time 
selection capabilities to your form, add a new 
Form Control to the contact form by clicking 
on the 'Add' button in the Form Controls 
section of the Widget Settings tab. 

Name the Form Control and set the 'Control 
Type’ option to either ‘Calendar' or ‘Select 
Time’. Customize the Control's settings using 
the Options List. 

Adding 'File Upload' Capability To 
Your Contact Form 
If you want your website visitors to be able to 
upload files to you, add a new Form Control to 
the contact form by clicking on the 'Add' 
button in the Form Controls section of the 
Widget Settings tab (See Figure 15.2).  

Name the Form Control and set the 'Control 
Type’ option to 'File Upload'. The contact form 
will update to display a 'Choose File' button. 
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You can 

download files that your visitors have sent you from the Contact Forms 
Enhanced page in your EverWeb Client Area (see below). 

Managing and Reporting Form Submissions 
Once you have set up the contact form, publish the website. When a visitor 
submits a form, you will receive an it in the email box that you setup in the 
'Email Address to Send Form to' field of the contact form. 

To go to the Custom Form Enhanced page, either click on the link in the email 
to go to your EverWeb Client Area, or log in directly to your EverWeb Client 
Area (See Figure 15.4).  

On the home screen of your EverWeb Client Area is the 'Contact Form 
Submissions' section on the left hand size. Click on 'View Form Submissions' to 
go to your form submission data. 
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The 'Contact Forms Enhanced' page will be displayed with a summary at the 
top showing you the number of forms that have had form submissions, the 
total number of form submissions and the server space used by file uploads 
from your form responders.  

Selecting a Form to View Form Submissions 
To view your form submissions, click on the 'Please select your form to access 
its submissions' dropdown menu. A list of your forms will be displayed. 
Highlight the form you want then click on the 'Select' button. 

Selecting Form Submissions 
If you want to select all the form submissions tick the box at the top of the left 
most column heading. Check the box again to deselect all form submissions.  

To select or deselect form submissions, check or uncheck the selection box on 
the left hand side of each individual form submission. 

Exporting Form Submission Data 
Once you have selected the form you want, you will see the form submissions  
that have been submitted displayed. To export all of the form submission data 
of the form, click on the 'Export' button. 

To select a custom list of form submissions to export, check or uncheck the box 
next to each form submission that you want. Use the checkbox on the left 
hand side of the column headings to toggle select all forms on or off. Once you 
have the form submissions that you want to export selected, click on the ‘With 
Selected’ button at the bottom of the list and select ‘Export’. 

Deleting Form Submission Data 
If you want to delete the form and all of its form submissions, click on the 
‘Delete Entire Form’ button. You will be asked to confirm the deletion.  

To select a custom list of form submissions to delete, check or uncheck the box 
next to each form submission that you want. Use the checkbox on the left 
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hand side of the column headings to toggle select all form submissions on or 
off.  

Once you have selected the form submissions that you want to delete, click on 
the ‘With Selected’ button at the bottom of the list and select ‘Delete’. You will 
be asked to confirm the deletion. 

To delete form submissions individually, click on the Trashcan icon on the right 
hand side of the form submission that you want to delete. The trashcan icon is 
in the second last column of the form submission table so you may have to 
scroll the table horizontally to see it. 

You will be asked to confirm the deletion. 

Sorting Form Submission Data 
Use the Up/Down arrows next to any of the column headings to order your 
form submissions based on that column in ascending or descending order. An 
arrow icon together with an ascending/descending graph icon indicates which 
column the data is sorted upon and whether it is in ascending or descending 
order. 

Searching Form Submission Data 
To search within your form submission data just enter the criteria you want in 
the search box then press Enter e.g. you could select '2019-07' to select all 
forms submitted in July 2019. 

Displaying The Number of Form Submissions Per Page 
At the bottom of the Contact Forms Enhanced page is where you can select 
how many form submissions per page you want to see. The default is 10, but 
you can also choose either 25, 50 or 'All'. 

Downloading File Uploads Submitted By Your Visitors 
Files that have been uploaded will be displayed in the ‘Attachments’ column. A 
down arrow within a circle icon indicates that a file has been uploaded. To 

www.everwebapp.com	 ￼  of ￼288 322

http://www.everwebapp.com


EverWeb User Manual	 Contact Forms Enhanced

download the file to your computer, just click on the icon. The file will be 
downloaded to your Downloads folder. 

You can also select multiple files for download. Click on each contact form that 
has an attachment that you want to download. Next click on the ‘With 
Selected’ button and choose the ‘Download Attachments’ option.  

If you do not see the Attachments column, scroll the table horizontally to the 
left so that the columns on the right hand side of the form submissions table 
come in to view. 
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Mass Mailings with Contact Forms 
Enhanced 
Contact Forms Enhanced can also be used for mass mailings to your form 
submitters.  

Creating a Mass Mailing 
To create a mass mailing using Contact Forms Enhanced Addon: 

1. Login to your EverWeb Client Area if you have not already done so. 

2. In the left hand column of your Client Area, click on ‘View Form 
Submissions’ in the ‘Contact Form Submissions’ section. 

3. From the ‘Please select your form to access its submissions’ dropdown 
menu choose the form that you want to create the mass mailing for. 

4. Once you have selected the form you want, click on the ‘Select’ button. 

5. You will now see all of your form submissions for the form you have 
chosen. Select the form submissions that you want to use for the mass 
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mailing. You can select all of the form submissions by checking the box 
on the left hand side of the form submission headings. This is a toggle, so 
just click on the box again to deselect all of the form submissions. 

6. When you select one or more form submissions, the ‘Mailing' button to 
the right of the ‘Export' button will turn blue in color indicating that it can 
now be used. Click on the button to create a mass mailing. 

7. You will now see the mass mailing email form (Figure 15.5). There are four 
sections: Subject, Tags, Content and Members. 

• Use the Subject field to enter the subject of the mass mailing; 

• Click on the Tags that you want to include in the content of your 
email. Note that you will only see Tags for fields that contain form 
submission data. If there is no data to display, you will not see a Tag 
for that particular field. 

• You can optionally set default values for your tags in the ‘Default 
Values for Mail Tag’ section.  

• Write your email in the Content section, using the Tags you have 
inserted to create personalized content; 

• The Members section lists the form submissions that you have 
selected for this mass mailing. 

8. Once you have completed your mass mailing email form, click on the 
Submit button to send the mass mailing. 
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16EverWeb SEO Power 
Up 

This chapter introduces you to EverWeb SEO Power Up 
Addon and explains all of its features in detail so that you 
can maximize your website’s SEO potential.

About EverWeb SEO Power Up

The XML Sitemap File

Setting Priority Values

Setting Change Frequency

Publishing Your Website

The robots.txt file

XML Sitemap Submission

Open Graph Tags

GZip Compression

Additional SEO Tips & Tricks
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EverWeb SEO Power Up 
EverWeb SEO PowerUp addon automatically 
optimizes your website for search engines 
and submits it to Google, Yahoo, Bing and 
Alexa search engines. 

Use EverWeb SEO Power Up on the pages in 
your website that you think are important to 
optimize in terms of their SEO, for example, 
your Home page.  

Use the ‘Priority’ and ‘Change Frequency’ 
options, described below, to tell search 
engines which pages in your site you 
consider important and which are not. 

Adding SEO PowerUp 
Addon  
You can purchase the EverWeb SEO PowerUp 
Addon from your client area by going to the 
Services menu, then selecting Available Add-
ons. 

Once you have purchased the Addon, quit and re-launch EverWeb. 

Checking Your Page’s SEO 
Use EverWeb’s one-click ‘Check Pages’ button in the Toolbar to check how 
search engine friendly your website’s pages are. You do not need to scan all of 
the pages in your website, only those where SEO is important e.g. your Home 
Page. You do not need to scan pages such as About Us or Contact Us. 

When clicked upon, ‘Check Page’ will scan the currently selected page. When 
the scan is complete you will see a list of results appear in the Web Page 
Suggestions dialog box.  
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The Web Page Suggestions Dialog Box 
The Web Page Suggestions dialog box shows you various SEO related items, 
These items are identified using the following symbols displayed to the left of 
each item: 

• Check Mark: The item listed has good SEO compliance. No action 
required. 

• Warning Triangle: You should take action to remedy the issue. Action is 
recommended. 

• Warning Octagonal: It is recommended that you correct the issue but 
not essential. Action is desirable but not necessary. 

• Information Icon: Optional items that can be actioned if desired 

Note that the Search Engine Suggestions dialog box suggests items that may 
require attention to better your page’s SEO. You are not obligated to follow the 
guidance, and there may be times where ignoring one or more suggestions is 
better for your page. 

If you click on any of the suggestions in the Web Page Suggestions list, a 
second dialog box will open. This dialog box will appear next to where you 
would take action to implement the suggestion e.g. if you a clicked upon the 
suggestion that you should ‘Add a Web Page Description’, when you click on 
that item, the second help dialog box will appear next to the Web Page 
Description field in the Page Settings tab of the Inspector Window. 

You can use the guidance in the help dialog box to complete the field 
correctly. 

When you have finished implementing your suggestions, you can click on the 
Check Page button again to check your work.  

Using EverWeb SEO Power Up 
Start your SEO optimization by going to the Page Settings tab in the Inspector 
Window.  
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Open the Search Engine Optimization section (See Figure 16.1), if it is not 
already open, then check the ‘Include page in search engines’ check box if it is 
not already checked. 

You can specifically add the SEO keywords, or phrases, that you want to use on 
the page. These will usually be the primary and secondary keywords, or 
phrases, that you have found in your SEO Keyword Research. 

You can edit your Keyword entry by double clicking on it and editing the field. 

To delete the entry, just highlight the entry in the list then press the delete key 
on your keyboard. 

The XML Sitemap File 
EverWeb SEO Power Up will automatically create an XML Sitemap file when 
you publish your website.  

An XML Sitemap tells Google, and other search engines, which pages and files 
you think are important in your site, and also provides information useful to 
SEO about such files or pages. For example, when the page was last updated, 
how often the page is changed and any alternate language versions of a page. 

You can assign a priority and change frequency to the important pages in your 
site, according to sitemap protocols, directly from the Page Settings tab. 

First, check the ‘Include in XML Sitemap’ checkbox if it has not already been 
checked. This will make the ‘Priority’ and ‘Change Frequency’ fields available to 
you.  

If you have not purchased EverWeb SEO Power Up you will be notified of this, 
once in a while, when using the Priority and Change Frequency fields. 

Setting Priority Values 
Priority sets a number from zero and one with zero being not important, 0.5 
being neutral and 1.0 being very important. 

Here are some examples of how to set the Priority value for your pages: 
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• Use priority values between 0.8-1.0 for pages such as your Home page 
and product information, major features and major category pages. 

• A priority value between 0.4-0.7 is often used for articles, blog posts, 
minor category pages and FAQs. 

• Priority values of 0.0-0.3 are used for old news pages and for those 
pages where the information is no longer relevant. 

Using Change Frequency 
The Change Frequency field tells search engines approximately how often 
each page is updated. An update refers to actual changes to the HTML code or 
text of the page. Select the Change Frequency that is appropriate to the page. 
For example: 

• NEVER: Used for pages that contain out of date news stories, old press 
releases and so on… 

• YEARLY: Used for Contact, “About Us”, login, registration pages 

• MONTHLY: For FAQs, instructions and infrequently updated articles 

• WEEKLY: Should be used for pages such as Product information page 
and website directories 

• DAILY: Used for page types that include Blog entry index pages, 
classified advertisements and small message board 

• HOURLY: This category is used for major news update sites, weather 
information and forums 

• ALWAYS: For pages relating to items such as Stock market data and 
social bookmarking categories 

Applying SEO Settings 
Remember that EverWeb’s SEO Settings should only be applied to the pages 
in your website that are important to you in terms of SEO. If you have pages 
that are not important e.g. an About Us type page, then this page does not 
need SEO Settings applied to it. 
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For more information about other ways of improving your SEO, check out the  
SEO for EverWeb Video course online. 
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Publishing Your Website 
Before publishing your website, check your website’s Site Publishing Settings. 
You can access these settings by either using the File-> Edit Publishing 
Settings menu option, or by clicking once on the name of your website in the 
Web Page List. 

Check the box ‘Optimize & Submit Website to Search Engines’ if it is not 
already checked (See Figure 16.2). If you have not already purchased SEO 
Power Up, a dialog box will appear with options to purchase or ‘remind me’ 
later. If you have an EverWeb+Hosting 10GB or higher account, EverWeb SEO 
Power Up is free for you. 

In addition to your Sitemap, when you publish your site EverWeb SEO Power 
Up creates your website’s robots.txt file 

Robots.txt 
The robots.txt file tells search engine crawlers which pages or files the crawler 
can or can't request from your site 

XML Sitemap Submission 
Your website’s XML Sitemap will be submitted to Google, Yahoo, Bing and 
Alexa notifying them of the updated site each time you publish something 
new. 
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Open Graph Tags 
EverWeb automatically adds Open Graph tags to your website. Open Graph 
tags are used to improve the look of content shared on social media by 
creating rich previews through the use of Open Graph tags. This makes your 
content more clickable, shareable and noticeable. Web page content links that 
are shared on platforms such as Facebook and X (formerly Twitter) will, 
therefore, be better prepared to take advantage of these platforms, helping to 
improve your click through rate. 

About GZip Compression 
EverWeb SEO Power Up enables GZip compression on the server side for 
EverWeb + Hosting customers only so that your websites load faster.  

Website loading time is a major factor in search engine rankings. The faster a 
website loads, the higher a website will rank in search engines. 

GZip compresses and decompresses files intelligently between EverWeb’s 
servers and the local browser, reducing the size of your website’s HTML, CSS 
and JavaScript files. 

Combined with the intelligent script optimization in EverWeb 3.3 and later, 
your websites will load much faster with this feature. 

Additional SEO Tips & Tricks 
The number one factor for search engines is having enough text content on 
your site. You need to have text that search engines can find and index in their 
database. 

Other factors that will help your search engine rankings include: 

1. Use HTTPS Secure URLs since secure websites will rank above non-
secure websites. If you have purchased EverWeb Site Shield Addon for 
your EverWeb + Hosting account, EverWeb will handle all the technical 
set up for you. 

2. Add a mobile version of your website. 
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3. Use image ALT tags. You can add these tags using the ALT Text field in 
the Inspector-> Shape Options tab. ALT tags are used to properly index 
your images 

4. Review our free SEO for EverWeb Video Course. 
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17EverWeb  
Membership Sites

This chapter introduces you to EverWeb Membership Sites 
and explains all of its features in detail so you can easily 
create and administer your website’s own membership or 
subscription site.

EverWeb Membership Sites

Purchasing Membership Sites

Membership Sites Overview

Membership Sites Configuration

Creating Your Membership Site in EverWeb

Creating Your Membership Site’s Pages

Linking Membership Site Pages to Membership Levels
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EverWeb Membership Sites 
EverWeb Membership Sites lets you easily create and administer your own 
membership site. The frontend of your membership site is created in EverWeb 
itself. Your members will be able to easily sign up, log in and enjoy their 
membership benefits once you have finished building your membership site. 
You can tailor your site to suite your needs, for example, you can set different 
levels of memberships for the membership pages of your site. 

EverWeb Membership Sites comes with a collection of specially designed 
widgets for use in your membership site. Once you have added the widgets to 
your Project File, you will be able to fully design your membership site. 

The backend functionality required to administer membership accounts, such 
as managing payments and defining membership levels, is managed through 
the Membership Sites section of your EverWeb Client Area. 

Purchasing EverWeb Membership Sites 
You can purchase the EverWeb Membership Sites from your EverWeb Client 
Area. Click on the Services menu option, then select Available Add-ons. 

Choose which Membership Sites package you want to purchase. These are as 
follows: 

• Membership Starter 

• Membership Plus 

• Membership Deluxe 

Select the plan that suits your needs then click ‘Next’. Once finished, proceed 
to the Checkout. 

Once you have purchased EverWeb Membership Sites, quit and re-launch 
EverWeb. 

You can purchase additional Membership Sites if you have more than one site 
that you want to build a membership site for. 
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Starter Plus Deluxe

Easy Setup Yes Yes Yes

Instant Activation Yes Yes Yes

Number of Paid Members Up to 10000 Up to 10000 Unlimited

Number of Membership 
Levels

Unlimited Unlimited Unlimited

Accept all Major Credit 
and Debit Cards

Yes Yes Yes

Restrict Access to Certain 
Pages in Site

Yes Yes Yes

Transaction Fee 10% 4.9% 2.9%

Allow ‘Free’ Members No Yes Yes

Allow Free Membership 
Trials

No Yes Yes

Allow Mass Email to 
Members

No Yes Yes
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Changing Your Membership Sites Plan 
You can upgrade or downgrade your EverWeb Membership Sites plan at any 
time if your requirements change. To change your plan: 

1. Go to your EverWeb Client Area.  

2. Once logged in, select Services-> My Services.  

3. From the list of services displayed, go to your Membership Sites service. 

4. Click on the down arrow to the right of the Spanner icon. 

5. Choose the ‘Manage Product’ menu option.  

6. Next choose the ‘Upgrade/Downgrade’ option from the ‘Action' section 
on the left hand side of the screen, 

7. Change your plan as desired. 

Downloading Membership Sites Widgets 
When you purchase EverWeb Membership Sites, you will be able to download 
and use the widgets that have been specially designed for use in building your 
membership site.  
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EverWeb Membership Sites Overview 
There are two main components of EverWeb Membership Sites: 

The Membership Sites frontend is where you create the pages of your site for 
your membership site in EverWeb. When you purchase the Membership Sites 
you will receive a set of specially designed widgets to use to develop your 
website’s membership site pages. The widgets are easy to use and help guide 
you to develop all the pages that you need to create a successful membership 
site in EverWeb.  

The backend of the Membership Sites is where you perform the setup, 
management and maintenance tasks of your Membership Sites. The backend 
is located in your EverWeb Client Area. 
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Membership Sites Configuration 
All of your Membership Site’s administration tasks will be performed in the 
Membership Sites section of your EverWeb Client Area. Here you will setup, 
configure and manage all of your membership sites and their memberships.  

Setting Up & Managing Your Membership 
Site  
One you have purchased your Membership Sites license, you can set up the 
backend features of your Membership Site. Use the following steps to access 
your Membership Sites backend: 

1. Start by logging in to your EverWeb Client Area if you are not already 
logged in. 

2. To access your Membership Sites services, click on Services-> My 
Services. To the right of your Membership Sites license is a spanner icon. 
Click on the down arrow to the right of the spanner icon and select the 
Membership Sites feature you want to directly access. 

3. Alternatively, go to the Membership Sites section in the left hand 
column of your Client Area overview page. 

4. Click on the ‘Manage All’ link to access your Membership Site’s backend 
features. 

5. From the dropdown select the Membership Site that you want to 
manage then click on the ‘Edit Membership Page’ button to access all 
of your membership site’s backend features.  

The following is a summary of each of the features that are available once you 
have accessed your Membership Site’s backend features: 
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Setup 
Click on the Setup link on the left hand side of the page under the 
Membership Sites heading to display the Membership Site Setup screen 
(Figure 17.2).  

The Setup screen is where you enter your Membership Site’s details e.g. your 
first and last name (as Membership Site Administrator), the name of the 
Membership Site and the domain it is linked to. You can also set the Time 
Zone, date and time format. 

Set the default currency that you want to use for payments in the Currency 
field.  

Important Note: Once you have set the currency and saved your settings, you 
will not be able to change the currency.  
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Use the Language field to specify the language that any error messages will be 
displayed in. You can choose from English, Dutch, French, German, Italian, 
Norwegian, Portuguese, Spanish and Swedish. 

As Membership Site Administrator, you may want to keep track of events that 
occur in your Membership Site. EverWeb can alert you to: 

• Receive Sign Up Notifications 

• Receive Payment Failed Notifications 

• Receive Payment Success Notifications and  

• Receive Cancelled Membership Notifications 

You can select to receive notifications to the email address that you enter in to 
the ‘CC system emails here’ field. Once you have entered the email address you 
want to use, check the box(es) to the left of the notification(s) that you want to 
receive. Click the ‘Save’ button when finished.  

The Setup screen is also where you set up your Payments Provider. Make sure 
you have a Stripe account before setting up your Membership Site so you can 
immediately link your Membership Site to your Payments Provider. 

www.everwebapp.com	 ￼  of ￼308 322

Figure 17.3: EverWeb Membership Sites Membership Levels Screen

http://www.everwebapp.com


EverWeb User Manual	 Membership Sites

Membership Levels 
Use the Membership Levels screen (Figure 17.3) to add, manage and delete the 
Membership Levels of your Membership Site. All EverWeb Membership Sites 
Plans allow you to create paid for Membership Levels.  

If you have an EverWeb Membership Sites Plus, or Membership Deluxe, Plan 
you can also create free and trial membership levels.  

The Payment Schedule for Membership Levels can be either free, one time, 
weekly, monthly, quarterly or yearly. Again, this may vary depending on your 
Membership Sites Plan level. 

Members 
Use the Members screen to create and manage your membership. When new 
members join your Membership Site, or if you manually add members to your 
Membership Site, each new member will be required to verify the email 
address they entered for their membership account. 
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Adding Members to Your Membership Site 
You can easily add members yourself to your Membership Site by clicking on 
the ‘Add New’ button. Enter the details of the new member (see Figure 17.4), 
their membership level, payment and address details.  

In addition you can also add Payment System, Coupons and VAT numbers to 
the new member. 

Click on the ‘Save’ button when finished or click on the ‘Back’ button to discard 
your changes.  

Exporting Membership Lists 
You can directly export out your membership list by clicking on the ‘Export’ 
button. This will export your list of members out in a .CSV file format.  

Importing Membership Lists 
You can import membership lists from a CSV file in to your Membership Site. 
Click on the ‘Import’ button then follow the prompts to complete the import. 

Mailing 
The Mailing feature is available if you have an EverWeb Membership Sites Plus, 
or Deluxe, plan. 

To use the mass mailing feature, you can either mail your whole membership 
or filter the members you want to email using the Search boxes below your 
membership statistics.  

Once you have the list of members you want to email, click on the Checkbox 
button to the left of the ‘Members’ column. This will select all of the members 
you want to email and will activate the ‘Mailing’ button. To continue with the 
mailing, click on the Mailing button and follow the instructions to complete 
your membership mailing.  

Filtering Your Membership Data 
You can filter your membership using the Search boxes listed below your 
membership statistics.. Click in the ‘Filters to Show’ dropdown menu box to 
select which filters you would like displayed.  
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Use the ‘Search’ button to filter your membership based on your search criteria 
and use the ‘Reset Search’ button to clear any filters used. 

Finally, you can use this page to suspend or enable members. 

Editing Member Details 
To edit the details of a member, click on the ‘Edit’ button to the right of the 
member’s name. In addition to being able to edit the members data, you can 
also suspend the member, set the member to pending, cancel the member’s 
account or delete their account. 

www.everwebapp.com	 ￼  of ￼311 322

http://www.everwebapp.com


EverWeb User Manual	 Membership Sites

E-MailTemplates 
E-Mail Templates allow you to create standard email responses to your 
members. Each Membership Site comes with the following standard 
responses: 

• WELCOME: Welcome to your membership site email. 

• VALIDATION: New members must validate the email they used when 
applying for membership. 

• PAYMENT_FAILED: Your membership payment was not approved.  

• PAYMENT_APPROVED: Your membership payment was approved.  

• FORGOT_PASSWORD: Use this email to help members recover their 
forgotten Membership password.  

• RENEWAL_REMINDER: Your account is about to be renewed. 

• AUTH_CONFIRMATION: Your login attempt must be verified. 

• CANCEL_CONFIRMATION: The membership has been cancelled. 

Each E-Mail Template can be customized to suit your needs. Just click on the 
‘Edit’ button to the right of the email template to open the email editor. You 
can add a variety of different fields to your customized response email. 

All the membership tags are also available which will help you personalize 
these emails to each subscriber. For example, you can use the FIRST NAME tag 
and the member's first name will be used in these emails. 
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Coupons 
You can offer your members coupons that can be applied as discounts in your 
Membership Site, for example, for a membership purchase, The coupon can be 
applied at checkout time.  

Use the ‘Create New Coupon’ button to add a new coupon that can be applied 
to your Membership Site. Click in the Membership Levels dropdown box to 
select one, or more, membership levels that the coupon applies to. Click 
outside the dropdown menu to exit the Membership Levels. 

Remember to add a Coupon Note explaining the purpose of the coupon 
otherwise you will not be able to save the Coupon.  

Once created, a coupon can be edited, duplicated disabled or suspended from 
the Coupons screen. 
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Mail Configuration 
Use this option to define the mechanism through which emails to your 
membership will be sent. There are three options to choose from: 

• API 

• Amazon 

• SMTP  

Cancellations 
You can view your membership cancellations directly from the Cancellations 
page. 

Logs 
The Logs screen shows you all the activity of your Membership Sites so you 
have an audit trail of any sign ins, sign outs, payments, profile changes errors 
etc... Above the log are Search boxes for you to filter the logs to more easily find 
the information you are looking for. 

Mailing History 
The mailing history shows you a list of the mass emailings that you have sent 
out an some statistics such as how many times the email was opened. 
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Creating Your Membership Site in 
EverWeb 
After setting up your configuration details in the Membership Sites area of your 
EverWeb Client Area, you can begin to build out your membership site in 
EverWeb itself.  

When creating your membership site’s pages in EverWeb, it is recommended 
that you first create a directory page within which you will create your 
membership site pages. This approach will make it easier for you to build and 
maintain your membership site’s pages as well as making it easier to manage 
your EverWeb Project as a whole. We will use this approach in this manual. 

Alternatively, you may want to create a completely new EverWeb Project that is 
dedicated just to your membership site and link it back to the main site. 

Installing Membership Sites Widgets 
When you purchase EverWeb Membership Sites you will receive an email with 
links to download Membership Sites widgets. You will use these widgets to 
create your membership site.  

Once you have downloaded the Membership Sites widgets pack, drag and 
drop the folder containing the widgets on top of the widgets in the Widgets 
tab in EverWeb. A new folder containing the Membership Sites widgets will be 
created. 

You can also double click the Install file to automatically install the full list of 
Widgets. 

In addition to helping you build your membership site, the Membership Sites 
widgets also link back to your Membership Client Area backend. 

EverWeb Membership Sites Widgets 
Membership Sites widgets help you create the features that your membership 
site will need, As with all of EverWeb’s widgets, to use a Membership Sites 
widget simply drag and drop the widget you want to use on to the page. 
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When you add a Membership Sites widget to a page, some instructions may 
also appear in the Editor Window on how to use the widget. 

Common Widget Features 
Most Membership Sites widgets share the following common features: 

Membership Site: Use the dropdown menu to add your Membership 
Sites license to the widget. If you have more than one membership site 
licence, you can choose the appropriate license to use for the website 
you are working on. 

Membership Site Settings…: Most of the Membership Sites widgets 
include the ‘Membership Site Settings’ button. Click on the button to 
assign pages in your membership site to specific functions.  

When you click on the Membership Sites Settings… button a dialog box 
will appear. Assign the appropriate membership site pages to their 
corresponding functions. 

You can assign the following pages to the your membership site: 

• Login Page  

• Sign Up Page 

• Payment Page 

• Default Logged In Page and  

• Change Password Page 

• Email Validation Page 

Optionally, you can also assign the following pages to your membership site:  

• Account Suspended 

• Access Denied 

• Account Cancelled 
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If you choose not to add any optional pages EverWeb will use pre-defined 
messages instead. 

When finished press ‘OK’ to save your settings. The changes will then be 
applied to all of the widgets that use the Membership Site Settings… button in 
their Widget Settings. 

Below is a description of all of the EverWeb Membership Sites widgets: 

Membership Change Password Widget 
The Membership Change Password widget allows you to adjust the text and 
fonts used in the widget. There is also an option that takes the member to a 
success page once the password has been successfully changed. If the 
member enters an invalid password, this will be flagged for correction 
automatically when they press the Submit button.  

Membership Login Form Widget 
The Membership Login Form widget allows your members to login to your 
Membership Site. Use the Login Success dropdown menu to choose a page 
informing your member that login has been successful. The widget also offers 
reCAPTCHA verification to help stop bots from trying to access the 
membership site. There are also options to include ‘Sign Up’ link and ‘Forgot 
Password’ links. The links used for these two options can be found by clicking 
on the ‘Membership Site Settings…’ button. 

Membership Payment Form Widget 
The Membership Payment Form widget is used for the customer’s payment 
details. You can choose to have automatic payments activated. When the 
payment has been made, you can redirect your customer to a payment 
‘Success Page’. 
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Membership Email Verification Widget 
This widget adds a simple, customizable button to your page that when 
clicked upon sends an email to the member to validate their email address. 
The widget includes options for styling the button’s appearance. 

Membership Profile Form Widget 
The Membership Profile Form widget is where a new member will add in their 
details including Membership Level, Account Status and Payment Details. 
When a member updates their details successfully you can redirect them to a 
profile update Success Page.  

Membership Sign Up Form Widget 
This widget provides a contact form in which potential members sign up for 
your membership site. The form includes all the basic fields needed for 
someone to sign up. Optionally, you can require First and/or Last Name and 
you can also include a coupon field. 

Membership Sign Out Button Widget 
Use this widget to add a ‘Sign Out’ button to pages in your Membership Site. 
The button has a Sign Out Link field which can be used to take the member to 
another page in your site. 
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Creating Your Membership Sites Pages 
Before you start to create the pages of your membership site in EverWeb, we 
recommend creating a directory page in which to add your membership site’s 
pages.  

We also recommend that you build your pages in the order listed below.  

Membership Site Pages List 
When building out your Membership Site you will need to create a minimum 
number of membership site pages in your website. This is necessary so that 
your membership site can function properly.  

Below Is a list of the essential pages that you will need to include in your 
membership site. Note that the page names used are not obligatory for you to 
use. 

Optional pages that you can include in your membership site are listed with an 
asterisk (*) after their page name.  

• Sign Up Page (Uses the Membership Signup Form widget)  

• Sign Up Successful Page* (Linked to from the Membership Signup 
Form widget) 

• Email Validation Page* (Uses Membership Email Verification widget) 

• Membership Payment Page (Uses the Membership Payment Form 
widget) 

• Membership Payment Successful Page* (Linked to from the 
Membership Payment Form widget) 

• Login Page (Uses the Membership Login Form widget) 

• Login Successful Page* (Linked to from the Membership Login Form 
widget) 
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• Profile Page (Uses the Membership Profile Form widget) 

• Profile Change Success Page* (Linked to from the Membership Profile 
Form widget) 

• Terms of Service Page* (Linked to from the Membership Signup Form 
widget) 

• Change Password Page (Uses the Membership Change Password 
widget) 

• Change Password Successful Page* (Linked to from the Membership 
Change Password widget) 

• Account Suspended Page* (Linked to in the Membership Site Settings… 
button 

• Account Canceled Page* (Linked to in the Membership Site Settings… 
button 

• Access Denied Page* (Linked to in the Membership Site Settings… 
button 

• Contact Us Page* (Optional if you do not want to use your website’s 
general Contact Us page) 

• Content Pages* (For each Membership Level) 
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Linking Membership Site Pages to 
Membership Levels 
After creating your membership site’s 
membership levels in the EverWeb Client Area, 
you can apply them to your membership site’s 
pages in EverWeb itself. 

In this way your members will only be able to 
access the pages that their membership level 
entitles them to.  

You can easily define the level of access to your 
membership site’s pages in the Password 
Protection section of the Page Settings tab in the 
Inspector Window (see Figure 17.6). 

Start by selecting the page that you want to apply 
one, or more, Membership Levels to e.g. a 
membership site page that has free content that 
is available for all members. Click on the Page 
Settings tab in the Inspector Window if it is not 
already selected. 

If the Password Protection section is closed, click on the triangle symbol to the 
left of the section to open the section. There are two buttons available: 
‘Memberships’ and ‘Simple Password’. By default, the ‘Memberships’ button is 
selected. If ‘Simple Password’ is currently selected, simply click on the 
‘Memberships’ button. 

Below the Memberships button is a dropdown menu that lists your 
Membership Sites licenses. Initially the dropdown displays ‘No Selection’. Click 
in the dropdown menu and select the Membership Sites license that you want 
to use.  

Once you have selected your Membership Sites license, the Membership 
Levels that apply to your Membership Site will be displayed. Checkmark all of 
the levels that you want to apply to the page. For example, in Figure 17.6 you 
can see that all Membership Levels have been checked as the page offers free 
content to all its members. If the page was for Gold level members, only the 
Gold and Premium Membership Levels would be be checked. If the page was 
for Premium level members, only the Premium Membership Level would be 
checked. 
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Additional Features 
Membership Level Details 
If you want more details about what is available for each Membership Level, 
just click on the Membership Level name you are interested in. In the box 
below the Membership Levels you will see the Membership Level’s Setup Price, 
Recurring Price, Tax, and Schedule fields displayed. 

Refresh Button 
To the right of the currently selected Membership Site license is a refresh 
button (two half circular arrows). If you have made changes to your 
Membership Levels in the Client Area, you can use this button to refresh the 
Membership Levels list and Membership Level details. 

Membership Sites Settings… Button 
You can access your Membership Site Settings... using this button which is also 
available in most of the Membership Sites widgets. 

Edit Membership Levels… 
Click on the Edit Membership Levels… button to access your EverWeb Client 
Area where you can modify your Membership Site’s Membership Levels. 

Publishing Your Membership Site 
After you have built your Membership Site, publish to test its features and 
functionality.  
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